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INTRODUCTION

INTRODUCING SOUND FORGE XP
Sound Forge XP is a compact, easy-to-use digital audio editing solution for the
Windows platform. With a Windows-compatible sound card, Sound Forge XP
gives you the ability to record, edit and process professional-quality digital
audio files. Sound Forge XP supports an extensive set of file formats, allowing
you to develop audio for training and business presentations, Web content,
musical recordings, computer games, and digital video productions.

The latest version of Sound Forge XP offers expanded file format support,
including Microsoft Video for Windows (AVI), RealAudio and RealVideo (RA,
RM), and Active Streaming Format (ASF) files using Microsoft NetShow. Its
new features include improved processing speeds, additional effects, and
support for adding regions and markers to sound files.

Sound Forge XP was developed with input from musicians, sound editors,
multimedia and game designers, and studio engineers, among others.Although
Sound Forge XP includes features specific to these applications, they can also
be applied in many other creative ways.

Sound Forge XP is a deep program.There are many features which you may not
discover immediately, and others that may seem overwhelming. Don’t let this
scare you. Remember, there’s always the Undo command! The best advice for
using Sound Forge XP is to jump in and start using it. Pick up the manual now
and then, read through a section to learn a few new tricks, and then go back
and try what you’ve learned.

READING THE MANUAL
In developing Sound Forge XP, one of our primary goals was to make the
interface as easy to use as possible. However, some features may not be
immediately apparent, so we hope you take some time to at least page quickly
through the manual.That way, you won’t miss any of Sound Forge XP’s creative
potential.



This manual is designed to function both as a reference guide and tutorial. It
is divided into six chapters and seven appendices; chapters 2-5 contain step-
by-step instructions on using Sound Forge XP’s functions, chapter 6 contains
reference information. Highlighted throughout the text, you will find Tips
outlining particularly important information to help you quickly find what
you need to get started.

CHAPTER 1 INTRODUCTION
The Introduction briefly describes Sound Forge XP, includes installation,
registration and help information, and provides a general overview of digital
sound for those who have no previous experience producing digital audio.

CHAPTER 2 SOUND FORGE XP BASICS
Chapter 2 is designed to provide you with an introduction to working within
the Sound Forge XP interface using a combination of descriptions and
tutorials.

CHAPTER 3 EDITING AND NAVIGATION
This chapter provides explanations and tutorials covering Sound Forge XP’s
editing functions and how to navigate through sound files.

CHAPTER 4 F I LE FORMATS AND ATTR IBUTES
Chapter 4 describes how to work with file formats, including AVI and Internet
files, and file attributes.

CHAPTER 5 RECORDING AND SOUND PROCESSING
Chapter 5 introduces the recording functions of Sound Forge XP, and explains
how to employ processes and effects.

CHAPTER 6 SOUND FORGE XP REFERENCE
The Reference chapter details all Sound Forge XP menus and dialogs.
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APPENDICES A-G
The Appendices are designed to provide in-depth technical and reference
information.They include:

Appendix A Optimizing Sound Forge XP 

Appendix B Troubleshooting 

Appendix C Shortcuts 

Appendix D Sound Formats 

Appendix F Object Linking and Embedding (OLE)

Appendix G Using CSOUND, MTU, IRCAM, BICSF and EBICSF Files

GETTING STARTED

The first thing you should do is register Sound Forge XP by filling out
the enclosed registration card and returning it to Sonic Foundry within
30 days of purchase.Alternately, you will be given the option to register
via your modem at the end of the installation process.

You must be registered for us to provide you with technical support and
upgrade information.

SYSTEM REQUIREMENTS
In order to use Sound Forge XP, you will need:

• Intel Pentium or Alpha AXP microprocessor 

• Microsoft Windows 9x or Windows NT 4.0 or later 

• Windows-compatible sound card 

• VGA display 

• CD-ROM drive 

• 16 MB RAM 

• 5 MB of hard-disk space for program installation
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INSTALLATION
The install utility SETUP.EXE on the setup CD creates any necessary directories
and copies all files required by Sound Forge XP.

1. After placing the Sound Forge XP CD-ROM in the drive, AutoPlay will bring
an installation menu into focus. Simply follow the instructions.

2. If you have disabled the CD-Rom AutoPlay feature, run Setup from the Start
menu as indicated below. Click OK to continue.

REGISTRATION
If you have an Intel-based system you may register online via your modem and
a toll free number. At the end of Sound Forge XP setup, choose Yes when asked
whether or not to register.

1. Enter user information and survey information.

2. Follow the dialog instructions.

3. Watch your mail for future Sound Forge XP products and upgrades.

ACTIVATION
After you click OK in the initial Welcome menu, you will be asked to enter
your activation code.This code can be found on the inside cover of your Sound
Forge XP manual.You must have this activation code whenever you wish to run
the setup program.

Sound Forge XP comes with only one copy protection requirement: you must
use the activation code whenever you run the setup program. Please allow us
to continue this policy by abiding by the license agreement and giving your
friends our phone number rather than a copy of the software.
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GETTING HELP

ONLINE HELP
A variety of help functions are included in the Sound Forge XP program.There
are three methods for accessing online Help:

• Find information about any program function by selecting Contents under
the Help menu or pressing F1. This will take you straight to the Help table
of contents. From this dialog, you can search by topic or get information
about using online Help.

• Find information about a specific dialog by pressing the Help button in the
dialog or the F1 function key.

• Find information about a specific menu command by pressing the F1
function key while selecting a menu item.

You will find that online Help is extremely useful as a quick reference guide.
Since many topics are cross-linked, it’s easy to navigate through all of the Help
material available on a topic. Once you have become familiar with Sound
Forge XP, you’ll probably never have to refer to this manual to find
information. All you’ll need is the online Help.

TECHNICAL SUPPORT
If you experience problems while using Sound Forge XP, our technical support
department is always ready to help you.
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BEFORE YOU CALL
So that we are able to provide you with the best possible support, please check
the following before calling:

• Make sure you have registered online or sent in your registration card.

• Check to see that the information you need isn’t already covered in the
manual. Appendix B, Troubleshooting, addresses many commonly asked
questions about using Sound Forge XP.

• Verify that you’ve installed your sound card properly in Windows. Refer to
your Windows manual or your sound card’s instructions for information on
correctly installing sound cards.

• Confirm that you have enough editing space available on your hard drive
for the sounds you are editing.

• Have your serial number and type of sound card available to you.

• Use a phone near your computer so that our technicians can walk you
through the answer to your question step-by-step if necessary.

REACHING TECHNICAL SUPPORT
Technical support is free for the 90 days following your first call.After 90 days,
there are a variety of support plans available. For more information on
extended support plans, contact us using any method below.

WEB

www.sonicfoundry.com

Our web page is a valuable resource for program updates, technical
information and support.

INTERNET MAIL

support@sonicfoundry.com

You may also send us email via the Internet.

FAX

(608) 256-7300

You can fax us 24-hours a day.
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PHONE

(608) 256-5555 

Call our technical support line between the hours of 9 AM and 6 PM Central
Standard Time, Monday through Friday.

FAX ON DEMAND

(608) 256-3133

Our Fax on Demand service is available 24 hours a day as an option on the
main Sonic Foundry phone line.

OVERVIEW OF DIGITAL SOUND
If you are new to digital sound editing, it will be well worth your time to
become familiar with some basic concepts. This section covers the most
important fundamentals. However, we strongly recommend that you page
through a book on digital audio and sound recording if you want to get the
most out of Sound Forge XP’s editing and digital signal processing features.

SOUND WAVES
When you hear a sound, you are sensing changes in the air pressure around
your eardrum. You can think of air pressure as the density of air molecules.
When an object vibrates or moves, it displaces air molecules causing a pressure
change. This in turn causes other air molecules to move. We don’t hear air
pressure changes caused by the weather. Instead, we hear air pressure
differences that vary rapidly over time.

These rapid vibrations are picked up by your ears and converted to electrical
signals that your brain interprets as sound. If we were to graph the air pressure
at your eardrum as a function of time while you were listening to a short
sound, it might look like the waveform below.



LOUDNESS AND P ITCH
When the air pressure is constant there is no sound.You perceive constant air
pressure as silence. When something causes a sound, the air pressure around
your eardrum changes above and below the normal atmospheric level. You
perceive the amount of change as the loudness of the sound.The loudness of a
sound, called its amplitude, is usually measured as a fraction of a standard
level, often in decibels (dB).

You perceive the rate of change in the air pressure as the pitch of the sound.
In scientific terms, this term corresponds to the frequency of the wave. The
frequency is usually measured in Hertz (Hz), or cycles per second.

Sounds in nature are not as simple as the above sine wave. In reality, a sound
would look something like the one below. This irregular waveform does not
have a periodic amplitude or frequency.

TIMBRE
Complex waveforms like the one shown above are constructed by combining
a number of simple waveforms (like the one in the first drawing) of different
amplitudes and frequencies. This is why we perceive both high and low
pitched sounds at once when we hear most natural sounds.

The characteristic sound of a waveform (be it produced by a grand piano or a
violin) is called its timbre. Timbre, also referred to as tone color, is said to be
rich or full when there are many different frequencies in a sound. Most people
consider a sound from a sine wave dull since it only has one frequency.
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The different frequencies in a sound, combined with the varying amplitudes
of each frequency, make up the spectral content of a waveform. The spectral
content, which you might say is the more scientific term for timbre, usually
varies over time. Otherwise, the sound remains static and again sounds dull.
The spectral characteristic of a waveform over time is the signature of a tone
that allows you to describe it as string-like or horn-like.

ANALOG RECORDING AND PLAYBACK
Let’s say you’re recording with a microphone. As you hold the microphone up
in the air and talk, the microphone converts the changes in air pressure into
changes in electrical voltage.This is called an analog signal.

If you were to graph the changing voltage inside a microphone cord, it would
look exactly like the graph of the air pressure going up and down. To record
your voice, you would send the signal to a medium, such as magnetic tape, that
can store a replica of the analog signal.

To play back your recording, you need something to create the differences in
air pressure, which our ear interprets as sound, i.e., an audio speaker. Speakers
operate by moving a cone from one position to another in a consistent
manner. In order to move the cone either forward or backward the speaker
must be driven by an electrical current. During playback, a tape or record
player generates a current, which is then fed to an amplifier. When connected
to a speaker, the current moves the speaker in a way that reproduces the
pressure changes sensed by the microphone during recording.

Until recently, sound was always recorded as an analog signal on magnetic tape
or vinyl grooves. One problem with storing a signal in this form is that it is
hard to accurately record the analog signal without adding noise. When you
make copies of your recording you have to convert it to an electrical signal and
then re-record it, adding even more noise. Listen to a third generation cassette
recording and you’ll know what we’re talking about. Also, editing with tape is
a not an easy task, since you must always be fast-forwarding or rewinding to a
section, splicing, etc.Tape-based editing is called linear editing.



DIGITAL RECORDING
With recent advances in computer technology, it has become efficient and
economical to record sound waves using a process called digital sampling. In
digital sampling, the analog signal of the sound wave is divided and stored as
numbers that represent the amplitude of the wave over very small segments
of time.

For a moment, let’s take a look at another process that is very similar to the
way our computer makes sound – the making of movies and television. Given
a scene with a person walking, we can slow down the speed at which the
pictures are shown and see that each movement is captured by a different
picture.As we speed up the rate of the pictures passing by, the motion becomes
more fluid and eventually we stop noticing each individual picture. If we keep
speeding up the movie the person appears to walk faster and faster and
eventually ends up looking quite humorous. The important point is that a
movie is just a collection of individual pictures.

So how do people record a movie? Obviously they pick up a movie camera and
film the action. The movie camera takes a series of pictures at a fast rate and
saves them on the film. The movies we see are simply a collection of pictures
that are played back in rapid succession.

When we record a sound through the sound card in a computer (also called
digitizing or sampling) we do much the same thing as the movie camera. The
computer rapidly checks what position the microphone is in and saves it in the
computer. When done recording, the computer has a collection of individual
positions (normally called samples) which it can use to recreate the sound we
have recorded. Individually, the samples are almost meaningless, much like an
individual picture in a movie, but together they make up the recorded sound.
This method of recording and playing sound is known as digitized sound.
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THE PC SPEAKER
A simple model for a digital system is one where a speaker cone can be in one
of two positions, either in or out, corresponding to the numbers 1 and 0 stored
in a computer. The normal position, in, is when the speaker is sitting at rest
with no current applied.The speaker isn’t moving and we don’t hear anything.
When current is applied the speaker cone moves to the other position, out. As
the speaker moves to the out position it forces the air around it to move and
we hear a small click or pop. If we leave the speaker sitting in the out position
we again hear nothing since the speaker only produces sound when it is
moving, not when it is stationary.

Now if we move back and forth between the in and out positions we will hear
a tone. As we move it faster and faster between the two positions (increasing
the frequency) we will hear the tone increase in pitch.This model of a simple
digital speaker system is exactly how the speaker inside your PC operates.
Programs can put the speaker in either the in or out position to make sounds.
Although there are more complicated methods to allow this type of system to
produce sounds other than tones, they are beyond the scope of this
introductory text.

EXPANDING THE MODEL
Instead of using just the two-position model, let’s suppose we had a system
that allowed us to have 100 positions or even more. If this were the case then
we would be able to make much more complex sounds. We could move the
speaker just a little bit or we could move it all the way out. This would allow
us to have more precise control of the amplitude of the waveform. The more
positions we have, the more flexibility we have in producing sound. For
example, if we were to represent amplitude as a number from one to four, any
values that fell in between positions would be rounded to the closest value.
This rounding error is called quantization noise. When more positions are
available, rounding errors become smaller.



You will often see a sound card referred to as 8-bit or 16-bit. We can directly
relate this to the number of positions in which we can place the speaker.With
an 8-bit card we can place it in 256 different positions and with a 16-bit card
we can place it in any of 65,536 positions. Although you might think that a
16-bit card should have twice as many positions as an 8-bit card, this is not
the case. It actually has 256 times as many positions. Even though 16-bit
samples take up twice as much space as 8-bit samples, it is recommended that
when at all possible you use 16-bit samples to minimize quantization noise.

SAMPLING RATE
The number of times a sound waveform is checked each second is the
sampling rate.The sampling rate is similar to the frame rate in movies. As you
can imagine, with higher sampling rates you store more information about the
sound’s changing amplitude.This gives you more fidelity.

As a matter of fact, it is impossible to accurately record frequencies above one-
half of the sampling rate. This threshold frequency is called the Nyquist
frequency, and should be considered when selecting a sampling rate.
Frequencies higher than the Nyquist frequency show up as noise.

The downside to very high sampling rates is that since each sample takes up
space in memory (1 byte for 8-bit samples, 2 bytes for 16-bit samples), higher
sampling rates will fill up your hard drive faster than lower sampling rates. For
instance, a stereo digitized sound of 44,100 Hz 16-bit data (approximately
what your CD player uses) lasting 10 seconds takes up almost 2 megabytes of
space! This means if you have a 40 megabyte hard drive you couldn’t even store
4 minutes of sound data, and that’s without having any programs or other data
on your system.
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ADVANTAGES OF DIGITAL EDITING
The advantages of digital editing far outweigh the enormous storage
requirements. Once you’ve recorded a sound as a digital sample on your hard
drive, you have the ability to perform edits like copying, cutting, and pasting
without losing any fidelity and, as some people like to brag, with accuracy of
up to 0.000023 seconds (single sample spacing at 44,100 Hz sampling rate).
With a visual editor like Sound Forge XP, you can actually see a representation
of the waveform to navigate through the sound file quickly and accurately.

Another advantage of storing sound digitally is the availability of digital signal
processing (DSP) techniques. Digital signal processing techniques can be used
for filtering, simulating room acoustics, and other special effects to restore or
enhance the original recorded sound.

Finally, with a tool like Sound Forge XP, you can open and save your sound files
to and from a number of different computer platforms and sound cards.

Now get in there and have some fun with Sound Forge XP!
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CHAPTER 2:  
SOUND FORGE XP BASICS
Chapter 2 provides an introduction to working within the Sound Forge XP. Use
of the interface is illustrated using a combination of descriptions and tutorials.
The material is divided into two main sections:

• Main Screen Basics

• Data Window Basics

MAIN SCREEN BASICS
This section will introduce you to the Sound Forge XP screen and cover the
most basic operations, including:

• Using the Mouse

• The Main Screen

• Toolbars

• The Data Window

• ToolTips

Many commonly used functions in Sound Forge XP can be performed in
a number of different ways. Sound Forge XP has been designed to allow
you to choose how you want to work – it doesn’t force you to work in a
certain way. To avoid confusion in the tutorials, every method of
accomplishing a task will not always be described. Refer to chapter 6,
Sound Forge XP Reference and Appendix C, Shortcuts, for more
information on each feature.
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USING THE MOUSE
Although using the mouse in Sound Forge XP is not required, it will make
your editing sessions easier. Once you become familiar with Sound Forge XP
you will probably want to use some of the built-in shortcuts provided by the
mouse and the keyboard. (For a complete listing of shortcuts, see Appendix C.)
The following list of terms will help you when reading the manual.

Pointing Moving the mouse pointer over an item.

Clicking Pointing to an item and quickly pressing and
releasing the left or right mouse button. The
manual will indicate whether to right-click or
left-click on an item to execute a specific
function. When there is no left or right
specification, use the left mouse button. Right-
clicking is often used to reach shortcut menus.

Double-clicking Clicking the mouse button twice in quick
succession. Double-clicking always employs the
left mouse button.

Triple-clicking Clicking the mouse button three times in quick
succession. Triple-clicking also always employs
the left mouse button.

Toggle-clicking Clicking the right mouse button repeatedly
while holding the left mouse button to toggle
through various options. This is a great shortcut
for procedures such as drag and drop and
changing the Magnify Tool mode of operation.
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Shift-clicking Clicking the mouse while holding down the
Shift key on the keyboard. Shift-clicking is used
mainly to skip dialogs so that you can quickly
repeat operations.

Control-clicking Clicking the mouse while holding down the
Control key on the keyboard. Control-clicking is
used to modify the operation of a normal click.

Dragging Holding down the mouse button while you
move the mouse. Dragging is used to quickly
move sections of data between separate
windows and to move trackbars, scrollbars and
faders.

Slow-dragging Holding down both the right and left mouse
buttons while moving the mouse. Using this
with trackbars and faders increases the
resolution of the movement. This is especially
helpful when making fractional adjustments to
parameters in a dialog.

Dropping Releasing the mouse button in another area of
the screen after clicking on and dragging an
object. Dragging and dropping is used to speed
up operations like mixing or cross-fading.
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THE MAIN SCREEN
When you start Sound Forge XP, the main screen, or workspace, opens.This is
where you will do all of your sound editing. The very first time you open
Sound Forge XP, no data windows are open and you will need to either open
an existing sound file or create a new one. There are a variety of ways to do
this, which are all described below.

The important parts of the Sound Forge XP screen are labeled in the above
diagram.The following list briefly describes how each functions.

Program Title Bar Shows the program name and the name of the
currently active data window (if the data
window is maximized within the workspace).

Data Window When a sound file is opened, it is graphically
displayed within its own data window. Data
windows can be arranged, resized, or
minimized.
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Menu Bar Shows the menu headings for the available
functions.When no data windows are open, the
Process, Effects, and Tools menus are not listed;
these contain functions that require an open
data window.

Status Bar On the left, help (see p. 24) and processing
information (see p. 21) are displayed.The fields
on the right show the playback sample rate,
sample size, mono/stereo, total length of the
active data window, and the total free storage
space. These fields can be edited by double-
clicking or right-clicking on them (except for
the free storage space). When no data windows
are open, the fields are blank.

Workspace The background area behind the data windows.
You can drag and drop sections of sound data
here to create new data windows.

TOOLBARS
The first time you open Sound Forge XP, two toolbars appear on the screen:
the Standard and Transport toolbars. The toolbars contain buttons that quickly
execute commands.

Standard Provides quick access to many common Sound
Forge XP functions. These functions are also
available on the File and Edit menus. For a
complete reference to these commands, see
Chapter 6.
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Transport Includes the audio transport buttons: Record,
Play All, Play, Pause, Stop, Go to Start, Rewind,
Forward, and Go to End.

Two more toolbars are also available, but not automatically displayed when
Sound Forge XP is opened.

Status Contains operations to set the display Status. For
a complete reference of these commands, see
Chapter 6.

ACID Sound Forge XP offers tools that are especially
designed to help you create seamless loops
which can be used in Sonic Foundry’s ACID or
any other application that requires perfect loops.
These tools can be accessed from the ACID
Toolbar.These eight buttons will be explained in
this chapter, and they include: the Edit Acid
Properties, the Edit Tempo, the Double Selection,
Halve Selection, Shift Selection Left, Shift
Selection Right, Rotate Selection and Selection
Grid Lines tools.

You can drag and drop a toolbar anywhere on the screen. When you drag a
toolbar to any side of the main window, it docks, or attaches to the side. If you
drag a toolbar away from a side, it becomes a floating toolbar.Toolbars are also
resizable and removable.To hide a floating toolbar, just click on its Close button.
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To select from the list of available toolbars, select Preferences under the Options
menu and look on the Toolbars page (or Toolbars in the View menu). To show a
toolbar, check the box next to the toolbar you wish to use and then select OK.
The number of open toolbars and their position on the screen is entirely up
to you.

THE DATA WINDOW
Data windows contain sound data. These windows contain a number of sub-
windows and controls that you will use in editing and viewing your sound
data. Many parts of the data window lead to shortcut menus, dialogs, and other
operations.

The important components of the data window are labeled in the diagram
above. The following list briefly describes each part and possible mouse
operations:

Title Bar Shows the file name or, if present, the title stored
in the Summary information of WAV files. Double-
click to maximize and restore the window.

Level Ruler Shows the amplitude of the waveform. Right-
click to reach the Level Ruler shortcut menu.When
using the Level Zoom In feature, click and drag the
ruler up or down to shift the view vertically.

title bar time ruler

level
ruler

ruler
tags

edit tool
selector



Time Ruler Shows the current location in the data window
as well as ruler tags. Right-click to reach the Time
Ruler shortcut menu. Drag to scroll the data
window.

Ruler Tags Indicates the position of region end points and
markers. Right-click to reach the Ruler Tag
shortcut menu. Drag to change their locations.
Double-click anywhere in the region to select.

Edit Tool Selector Use this button to toggle between the Edit,
Magnify, and Pencil Tools.

The Pencil Tool requires that the zoom ratio be between 1:1 and 1:16.

Playbar On the left side of the playbar are the following
audio transport buttons: Go to Start, Go to End, Stop,
Play Normal, and Play Looped. To the right are the
playbar’s selection status fields.

Selection Status Fields Shows the beginning, end, and length of a data
selection. If no portion of the waveform has
been selected (highlighted), only the cursor
position (also known as the insertion point) is
displayed. Double-click on the left-most field to
reach the Go To dialog. Double-click on either of
the other two fields to reach the Set Selection
dialog. Right-click to reach the Status Format
shortcut menu.

Waveform Display Shows a graphical representation of the sound
file.The horizontal axis represents time (marked
in the Time Ruler) and the vertical axis represents
amplitude (marked in the Level Ruler). Right-
click anywhere on the waveform display to
reach the Waveform Display shortcut menu.

Position Scroll Bar Use this to scroll the sound file forward and
backward in time to see parts of the file not
currently visible in the waveform display.
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Overview Allows for quick navigation and playback of any
part of the file. Overview also shows the fraction
of the waveform on the waveform, as well as the
selected region. Left-click to move the cursor.
Double-click to center the cursor in the
waveform display. Right-click to start playback
or pause. Left-click and drag to activate the Audio
Event Locator.

Time Zoom (Also called Zoom Ratio) Specifies the number of
samples of data represented by each point on the
screen horizontally.

Resolution This determines the length of time that is shown
in the waveform display.With a small resolution
value (1:1, 1:2, 1:4,...), a shorter length of time
is displayed.

Time Zoom In/Out Use these to change the zoom resolution for the
time axis. Between these buttons is a spinner
that allows you to continuously change the time
zoom resolution.

Level Zoom In/Out Use these to change the zoom resolution for the
level (vertical) axis. Between these buttons is a
spinner that allows you to continuously change
the level zoom resolution.

Maximize Width Pressing this button stretches the width of the
data window to fit within the Sound Forge XP
workspace.

OLE Drag Source Drag from this section of the data window into
another application, such as Microsoft Word, to
link the sound file to other documents.



TOOLTIPS
If you hold the mouse over a toolbar button or status bar field for more than
one second, you will notice a small box appears next to the mouse pointer
containing text. This text is a quick description of the button or field’s
function. Using ToolTips is an easy way to learn your way around the Sound
Forge XP screen. You can disable this function by selecting Toolbars under the
View menu and clearing Show ToolTips.

When you click (on) and hold a button in a toolbar or select a menu item, you
will see a one-line description of the command in the left side of the status
bar.This gives you a little more information about the function of a button. If
you release the mouse button outside of a toolbar or menu item, the toolbar
command will not be performed.

DATA WINDOW BASICS
With Sound Forge XP, you can have multiple sound files open simultaneously
on the screen. Each file has its own data window that shows a graphical
representation of the waveform and other information about the file. This
section covers the following topics:

• Opening an Existing File

• Playing a File

• Playing a Section

• Using the Transport Toolbar vs. the Data Window Playbar

• Creating a New Window
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• Active Windows vs. Inactive Windows

• Copying Data to a New File

• Saving a File

OPENING AN EXISTING SOUND F ILE
To open an existing sound file:

1. Select the Open command from the File menu. Sound Forge XP displays the
Open dialog. Use this dialog to select and open a file.

2. By default, Sound Forge XP plays a file when you select it in the dialog.You
can turn off this feature by clearing the Auto play check box. If the Auto play
feature is disabled, you can preview WAV files by pressing the Play button in
the Open dialog. During playback, the label on the Play button changes to Stop.
Pressing the Stop button stops the playback.

3. Use the Files of type list to select different types of data files. If Sound Forge
XP recognizes the file type when it is highlighted in this list, it will display
its information in the bottom half of the dialog.

4. For this exercise, open the file TUTOR1.WAV. This file is located in the
directory where you installed Sound Forge XP.

You will now see a data window containing TUTOR1.WAV. This file is a
recording of someone saying, “Wow, sound editing just gets easier and easier.”
Notice that, although the file name is TUTOR1.WAV, the name of the data
window is “Wow, sound editing...” This is because a title for the file is stored
within the WAV file itself. Sound Forge XP allows you to embed descriptive
titles as well as copyright information and other text fields for any WAV file.

Sound files in Sound Forge XP can have a title different from the file
name.To edit the title, use the Summary page of the Properties folder
(File menu).You can quickly get to the Summary dialog by pressing
Alt+Enter.
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PLAYING A F ILE
To play an opened sound file:

1. Click on the Play All button on the Transport toolbar.

2. While the file is playing, a pointer will move along the data window
showing the current position.You will also see the current position in the
first selection status field in the playbar.

3. Play the TUTOR1 file now.You will hear the words “Wow, sound editing just
gets easier and easier.”

You can begin play from any point in the window by moving the cursor.

1. Move your mouse pointer to the silence section right after the “Wow”
portion of the file. Left-click (make sure you don’t drag the mouse) and you
will see the flashing cursor in the silence area after the word “Wow.” Click
the Play button on the Transport toolbar and now you will only hear “sound
editing just gets easier and easier.”

2. If you don’t hear anything, you may have accidentally selected a small
portion of data by dragging the mouse. To see whether you’ve made a
selection, look at the three right-hand status fields in the data window
status bar. If only the first one is filled, then no data is selected. If they all
have values, click in the data window again to clear the selection.
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PLAYING A SECTION
You can also play parts of the sound data by selecting a portion of the
waveform display with the mouse.To play a section:

1. Click and drag the left mouse button starting at the section of silence prior
to “Wow.” Drag the mouse until you are in the portion after the “Wow.”
Notice that as you drag the data, the background appears in another color.
Release the mouse button and you will now have a highlighted section of
data.

2. Click the Play button. You should now hear just the “Wow” portion of the
file.

3. While selecting waveform data, notice that the three selection status fields
on the right side of the playbar display values. These values show you the
start (Selection Left), end (Selection Right), and length (Selection Length) of the
selection you have made.When no data is selected, the cursor position (also
called the insertion point) is displayed.

Clear the selection and put the cursor back at the start of the file. To do this,
click on the Go to Start button in the Transport toolbar.



USING THE TRANSPORT TOOLBAR 
VS.  THE DATA WINDOW PLAYBAR
There are a number of ways to play your sound files in Sound Forge XP. The
most common method is to use one of the Play buttons located either on the
Transport toolbar or the playbar in the data window.This section describes both
methods.

THE PLAYBAR BUTTONS
On the left-side of the playbar at the bottom of every data window are five
buttons. These buttons allow you to play the sound data in a variety of ways.
The first two buttons allow you to set the cursor to the start or end of the
current file. These are the Go to Start and Go to End buttons. The third button is
the Stop button, which you can use at any time to stop playback.
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The last two buttons play the sound in different ways and, at the same time, set
the default play mode. The first button is the Play Normal button. This button
plays the currently selected section of data. If there is no data selected, pressing
the Play Normal button plays from the current cursor position to the end of the
file.

The next button is the Play Looped button.This button plays the selected section
in a continuous loop or, if no data is selected, the entire file in a continuous
loop. In addition, while the Play Looped button is selected, playback will follow
any new cursor position or selection that is made.

Whenever you play a file using playbar buttons, you will notice a small line
that appears underneath the arrow in the Play button you have selected.This is
the current play mode, which will be used whenever you select the Play button
in the Transport toolbar (or hit the Spacebar). Play Normal is the current play mode
in the playbar graphic shown above.

To change the current play mode, press the corresponding playbar button or
use Control+Spacebar.



THE TRANSPORT TOOLBAR
The Transport toolbar has nine buttons.

The Transport toolbar buttons are described below from left to right:

Record Brings up the Record dialog, which allows you to
record to either a new or existing window.
Shortcut: Control+R

Play All Plays the entire sound file from beginning to
end. This allows you to hear the entire sound
even if you have a selection or the cursor
positioned somewhere other than the start of
the data. Shortcut: Shift+Spacebar

Play Plays the file using the current play mode.To set
the play mode select one of the two play buttons
on the playbar as described in the above section
(The Playbar Buttons).The last button used becomes
the active play mode. Shortcut: Spacebar

Pause Works like the Stop button in that it stops play of
the current file. However when selecting Pause,
the cursor is placed at the current play position
rather than back to where it was when play was
selected. Shortcut: Enter during playback

Stop Stops play and positions the cursor where it was
prior to selecting play. Shortcut: Spacebar during
playback
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Go to Start Places the cursor at the beginning of the sound
file. Shortcut: Control+Home

Rewind Shuttles the cursor backward in the sound file.
Shortcut: Control+Left Arrow

Forward Shuttles the cursor forward in the sound file.
Shortcut: Control+Right Arrow

Go to End Places the cursor at the end of the sound file.
Shortcut: Control+End

THE ACID TOOL BAR
The ACIDToolbar has eight buttons which are detailed from left to right in this
section.

The Edit ACID Properties button opens a menu which can be used to
manipulate ACID specific information in the wave file. Shortcut:Apostrophe



ONE-SHOT

One-Shots do not stretch with tempo or change pitch with the ACID project’s
key. Sounds such as cymbal crashes and vocal samples are usually played as
One-Shots.

LOOP

Loops stretch with tempo, and may also change pitch with the ACID project’s
key. Loops are the most common types of samples used in ACID.

NUMBER OF BEATS

This option determines the length, in beats, of the Loop. If a 16-beat Loop is
specified as an eight beat Loop, it will play twice as fast as it should in ACID.
You can type a new length number directly in the field, or use the up and down
arrows to the right of the field to change the length number.

ROOT NOTE FOR TRANSPOSING

This option determines the root note that ACID will use to pitch the Loop to
the project key. If the root note is A, and the project key is C, the Loop will be
transposed up three semitones. You can change the note by clicking on the
down arrow to the left of the field and clicking on a new root note in the list.

DISK-BASED

Disk-Based files can stretch with tempo, but will not change pitch with the
ACID project’s key. Long files like vocal tracks are usually considered Disk-
Based.

TEMPO

Disk-Based tracks can stretch to the tempo of the project, but the original
tempo must be specified. If a tempo is not specified, the Disk-Based track will
not stretch.

The Edit Tempo key will open dialog which will automatically calculate the
musical tempo (Beats per minute) from the current selection.
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To use Edit Tempo, first highlight a selection in the waveform display. The
selection made should be equal in size (or an integer multiple) to the length
of a beat or measure. The easiest way to tune a selection to be exactly one
measure long is to play the selection looped and change the selection points
until a constant downbeat is heard.

Sound Forge XP uses the current tempo to display measures in the Time Ruler.

START,  END,  LENGTH,  INPUT FORMAT

Determines the selection used to calculate the tempo based on the Input Format.

SELECTION LENGTH IN BEATS

Sound Forge XP calculates the current selection’s length in beats.

BEATS PER MINUTE (1.0 TO 1000.0)

Sound Forge XP calculates this tempo value depending on your selection
length, selection type (Measures or Beats), and Beats per Measure.

BEATS PER MEASURE (1 TO 32)

Use to specify the number of beats in a measure when selecting a measure (e.g.,
4 for most pop music). It can also be used to specify beats per selection length
if the selection is larger than one measure.



The default tempo (Default: 120) can be changed on the Status page of
the Preferences folder (Options menu).

Double Selection The Double Selection button does exactly what
its name implies – it doubles the current
selection.When you are creating loops, it is very
handy to be able to select (highlight) a single
measure and then use the Double Selection tool
to automatically increase the selection to two or
four measures. Shortcut:Apostrophe

Half Selection The Half Selection tool is as logical; it halves the
current selection. Again, it is rather convenient
to select a four measure section and then reduce
that selection to one or two measures. Shortcut:
Semi-colon

Shift Selection Left, Right The Shift Selection Left and Shift Selection Right
buttons perform tasks which mirror each other.
Once you have selected (highlighted) a portion
of the track, you can move it left (Shift Selection
Left) or right (Shift Selection Right) by the
length of the selection using the appropriate tool.
Because the exact length of the selection is
maintained, this tool is perfect for moving the
selection a beat or measure at a time. Shortcut(Shift
Left): Less Than Symbol. Shortcut(Shift Right):Greater Than
Symbol

Rotate Audio The Rotate Audio tool is best used to change the
feel of a given loop. It works by taking selected
audio at the beginning or end of the file and
moving to the other end of the file. Shortcut: Colon
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For example, if you had a drum part that went BOOM, BOOM, BANG, BOOM
and you selected the first BOOM and selected Rotate Audio, the resulting drum
part would go BOOM, BANG, BOOM, BOOM. Get it? If there is no selection,
the file will rotate by 1/16th of its length.

Selection Grid Lines The Selection Grid Lines creates (imagine this!)
a grid of lines on the area selected. These lines
are superimposed on any selection and divide it
into four equal parts. When creating loops from
raw material, lining up the lines on visible
transient peaks in the waveform can help
immensely.

After you have made a selection, press the <Z> key on the keyboard to
snap the edges of the selection to the nearest zero crossing. This will
eliminate any clicks at the loop points.

CREATING A NEW WINDOW
In this exercise, you will create a new data window with the same data format
as the file TUTOR1.To create a new data window:

1. Select the New command from the File menu. You can also press Ctrl-N.
Sound Forge XP displays the New Window dialog.

2. Select the new data format in the New Window dialog. Set the Sample size to 16-
bit, the Channels to Mono, and the Sample rate to 44,100.

3. Notice the Maximum editing time line at the bottom of the dialog.The numbers
in this line show the hours, minutes, and seconds of time available for
recording and editing. For example, if you see 00:51:49 on the New Window
dialog, you can work with sounds that last up to 51 minutes and 49 seconds.
The time depends on a number of factors including the amount of storage
on your system and the format of the sound data.

N O T E



4. Click the OK button. A new window will appear titled Sound2. This is an
empty data window into which you will place data from TUTOR1.

ACTIVE WINDOWS VS.  INACTIVE WINDOWS
When you have multiple windows on the screen, only one window is
considered the active window. This is the window in which you are currently
working. Any operations you perform will only affect this window.

To make a window the active window click anywhere on the window with the
left mouse button. The window’s title bar will change to the color you have
defined as the active window color in Control Panel in Windows.

COPYING DATA TO A NEW F ILE
To copy data to a new window:

1. Make “Wow, sound editing...” the active window by clicking on its title bar.
If you don’t have the word “Wow” selected, select it again as described
above.

2. From the Edit menu, select the Copy command. This will copy the sound
data for “Wow” onto the clipboard.

3. Make Sound2 the active window by clicking on its title bar. (If the title bar
is covered by another window, you can always activate a data window by
selecting it from the list at the bottom of the Window menu.)

4. Select the Paste command from the Edit menu and the “Wow” data will
appear in the Sound2 window. If you press the Play button, you can hear
how our new file sounds with just the word “Wow.”

Other methods of copying data from one window to another, or from an
existing window to a new window, are covered later.
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SAVING A F ILE
To save a data window:

1. Make sure the Sound2 window is active.

2. Select the Save command from the File menu. Because the Sound2 window
is a new file, Sound Forge XP displays the Save As dialog. If the file had been
opened or previously saved by Sound Forge XP, the file would be saved
immediately.

3. Type a file name into the File name field in the Save As dialog and select the
OK button. Save the new sound file, Sound2, as MYFIRST – Sound Forge XP
will add the file extension, WAV, automatically.

The Save As dialog also allows you to change file types, data format, and set
summary information fields.This is covered later.
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CHAPTER 3:
EDITING AND NAVIGATION
Chapter 3 provides explanations and tutorials covering Sound Forge XP’s
editing functions and how to navigate through sound files. Sections covered
include:

• Simple Editing and Navigation

• Advanced Editing and Navigation

• Regions and Markers

SIMPLE EDITING AND NAVIGATION
This section will describe the basic editing operations of Sound Forge XP.You
will learn about:

• Common Edit Operations

• Status Formats

• Magnification and Zooming

COMMON EDIT OPERATIONS
The edit operations used most often include Cut, Copy, Paste, Crossfade, Mix,
Clear/Delete, and Trim/Crop. Most of these make use of the clipboard, which is a
temporary storage area.The clipboard can also be used to move data from one
window to another. The following list provides a brief description of each
operation:

Cut Deletes a selected portion of data and copies it
onto the clipboard. Shortcut: Control+X

Copy Copies a selected portion of data onto the
clipboard. Shortcut: Control+C

Paste Inserts the contents of the clipboard into a data
window at the current cursor position or
replaces the current selection. Shortcut: Control+V



Crossfade Crossfades the contents of the clipboard with the
current data in a window starting at the current
cursor position. Shortcut: Control+F

Mix Mixes the contents of the clipboard with the
current data in a window starting at the current
cursor position or at the start of a selection.
Shortcut: Control+M

Clear/Delete Deletes a selected portion of data but doesn’t
copy it onto the clipboard. Shortcut: Delete

Trim/Crop Deletes all data in a window except the selected
section. Shortcut: Control+T

SELECTING WAVEFORM DATA
To make a data selection:

1. Open the TUTOR1.WAV file as described in the previous chapter. Make sure
that TUTOR1 is the active data window by clicking on its title bar.

2. Make sure you are using the Edit Tool. To do this, look under the Edit menu
for the Tool function and select Edit (it should already be checked).

3. Select (highlight) the word “Wow” with the mouse by clicking and
dragging as described in the previous chapter. You can verify you have the
right section of data by pressing the Play button to hear it.

COPYING DATA ONTO THE CLIPBOARD
To copy data:

• Make a data selection as described above.

• From the Edit menu, choose the Copy command.This will copy the selected
data onto the clipboard. You will see no change since the Copy command
does not change the data; it only copies it to the clipboard.
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PASTING DATA FROM THE CLIPBOARD
To paste data:

1. Move the cursor to the beginning of the TUTOR1 file by selecting the Go to
Start button on the playbar

2. Choose the Paste command from the Edit menu. You should now see the
data for the word “Wow” appear at the beginning of the window. Press the
Play button just to make sure. You should hear “Wow Wow Sound editing
just gets easier and easier.”

You have just made your first edit in Sound Forge XP! There are quicker ways
to copy and paste data with Sound Forge XP – you’ll find these described in
the Advanced Editing section.

PASTING DATA TO ANOTHER WINDOW
Data on the clipboard remains there until it is replaced by another operation
that places data onto the clipboard. Therefore, you can continue pasting the
data anywhere you want.

To paste data to a new window:

1. Create a new window by selecting New from the File menu.

2. Again, select the Paste command from the Edit menu.You should now have
a new data window with the data for the word “Wow.”You can also do this
by selecting the Paste to New option from Paste Special on the Edit menu. This
creates a new window and fills it with the clipboard contents in one easy
step.

CUTTING DATA
To cut data:

1. Select a section of data you want to cut. Select one of the “Wow” words
(you should have two if you have been following the examples) from
TUTOR1.

2. Now select the Cut command from the Edit menu. This will remove the
selected data and place it on to the clipboard.
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UNDOING AN EDIT OPERATION
You can reverse the effects of any editing operation.

To undo the above “cut”:

1. Select Undo Cut from the Edit menu. You will see the original two “Wow”
words in the TUTOR1 window.

REDOING AN EDIT OPERATION
If you change your mind and decide you really liked an edit you undid, you
can repeat the edit operation you last undid.

To redo an operation:

1. Select Redo Cut from the Edit menu. In this case, the second “Wow” has been
cut from TUTOR1 file again.

TR IMMING/CROPPING
Trim (also called Crop) allows you to single out a section of data and cut
everything else out of the window except that section.You can use this feature
with the Play button to hear selections until you have just the right amount of
data and then cut everything else using Trim/Crop.

To trim data:

1. Select the “Wow, sound editing” section in the TUTOR1 window, but don’t
select “just gets easier and easier.” Remember you can use the Play button to
hear how the selection sounds at any time.

2. Select Trim/Crop in the Edit menu. After cropping you will have only “Wow,
sound editing” left in the window.

3. Close the “Wow, sound editing” window. Either click on the close box of the
TUTOR1 window, or select the Close command from the File menu.You will
be asked whether you want to save the changes that you have made to
TUTOR1. Select the No button to close without saving your changes.

Also close any other windows you may have open, like MYFIRST.WAV.
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MIXING
Mixing is a powerful and useful edit operation that you will use often. Mixing
allows you to combine two sounds together into one window so you can
create composite sounds.

To mix data:

1. Open two files, TUTOR1.WAV and TUTOR2.WAV, as described in the
previous sections.TUTOR2 is a file that contains the sound of a snare drum
and crash cymbal. You are going to mix this sound with TUTOR1, the
“Wow, sound editing...” window.

2. Before mixing data, make sure the Status Format is set to Time to make finding
the mixing points a little easier. To do this, select Time from Status Format
under the Options menu.You will need to do this for both data windows
since Sound Forge XP keeps track of the format type for each individual
window.

3. To make the windows easier to view during the mix operations you may
want to maximize Sound Forge XP by pushing the Maximize Window button
in the upper right-hand corner and selecting Tile Vertically from the Window
menu. This will arrange the windows vertically and make it easier to see
your work.

4. If you examine each of the TUTOR windows you will notice that the length
of TUTOR1 is 5.0 seconds long and TUTOR2 is 3.0 seconds long. (You can
see the length of a file by placing the cursor at the end of the sound data
and examining the status bar.You should see a field that shows the length
of the file in hours, minutes, and seconds.) For this example, the drum hit
should occur just before the “Wow.” You could just copy the drum hit
sound onto the clipboard and then paste it before the “Wow,” but this
would increase the length of TUTOR1 to 8.0 seconds. Instead, use the Mix
command.

5. Select all the data in Drum Hit by making it the active window and then
double-clicking in the waveform display with your left mouse button (or
use Select All under the Edit menu). Now copy the data onto the clipboard
by selecting the Copy command from the Edit menu.

6. Make TUTOR1 the active window and then select the Go to Start button on
the playbar.This will put the cursor at the beginning of TUTOR1. Select Mix
from the Paste Special command in the Edit menu.
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7. The Mix dialog now appears. Keep both levels at 0 dB and select OK.

8. The drum hit sound has been mixed into the TUTOR1 window and the
length of TUTOR1 is still 5.0 seconds. Press the Play button to hear the
results.

9. Select the Undo Mix command from the Edit menu to return TUTOR1 to its
original state.

10.This time, mix the drum hit sound closer to the “Wow” portion of
TUTOR1. The “Wow” occurs at about 0.8 seconds into TUTOR1, so move
your cursor in the TUTOR1 window to approximately 0.8 seconds.You do
this by clicking with the left mouse button in the data window of TUTOR1
and watching the cursor position status field on the status bar (the left-
most field).You don’t have to be exact. Once you’ve positioned the cursor,
select the Mix command again and then hit Play for the result. Notice how
the drum hit sound and the “Wow” sound overlap each other.
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STATUS FORMATS
By right-clicking on the Time Ruler and selection status fields on the playbar,
files can be set to different status formats. By changing the format, you can
coordinate sound files with other events measured in that format, or use a
timing base most familiar to you. Lengths and positions can be displayed in a
variety of formats including Samples, Time, Seconds, Frames, Measures and Beats, and
SMPTE.

SELECTING A STATUS FORMAT
To select a format, choose the Status Format command from the Options menu.
This shows the ten different formats available. Choosing one of these options
sets the status format for the current data window.

The available formats are:

Samples Number of samples

Time Hours, minutes, seconds and milliseconds

Seconds Seconds and fractions thereof

Time & Frames Hours, minutes, seconds and frames as defined
by the Edit Frame Rate (Special Menu) command

Absolute Frames Frames and fractions thereof

Measures & Beats Measures, beats and quarters of a beat

SMPTE Non-Drop SMPTE at 30 or 29.97 frames per second (fps)
non-drop

SMPTE Drop SMPTE at 30 fps with drop frames

SMPTE EBU SMPTE at 25 fps

SMPTE Film Sync SMPTE at 24 fps

In this exercise, you will see how the status formats affect values in the status
display fields.

1. Using the TUTOR1 file, select Samples from Status Format under the Options
menu.

2. Now select all of the data in the TUTOR1 window. To do this, choose the
Select All command from the Edit menu. You can also double-click the left
mouse button anywhere in the waveform display of the data window.



3. In the selection status fields on the playbar (at the lower right-hand side of
the data window) you should see the values of 0, 220,506, and 220,507.
This means that the first selected sample (Selection Left) is sample 0, the last
selected sample (Selection Right) is 220,506, and the total number of samples
in the selection (Selection Length) is 220,507.

4. Now select the Time option from Status Format under the Options menu.You
will see that all these values change to values specified in hours, minutes,
and seconds rather than samples. You can see that a sound containing
220,507 samples with a sample rate of 44,100 Hz will play for about 5.0
seconds. You can experiment with each of the status formats to see how
each format is displayed.

CONFIGURING FRAMES AND MEASURES & BEATS
When setting the status format to Frames or Measures & Beats, you customize how
these values are displayed.The Edit Frame Rate dialog in the Special menu allows
you to change the frames per second. In the Edit Tempo dialog from the Special
menu, you can specify the Beats per minute and Beats per measure values used to
calculate measures and beats. The default values for Frames and Beats are set on
the Status page in the Preferences folder (Options menu).

MAGNIF ICATION AND ZOOMING
When sound data is drawn on the screen, it is necessary to represent many
samples of data for each horizontal point on the screen. There are almost
always many more samples in a sound file than there are horizontal points
(pixels) on the screen. Depending on the editing operations you need to use,
you may want to view the entire file at once, or you may want to look at only
a small portion in greater detail. This is where the magnification, or zoom,
ratio comes in.

TIME RULER ZOOMING
In the bottom right corner of the data window, just above the data window
playbar, is the current time magnification ratio. The Zoom Ratio defines how
many samples of sound data are squeezed into each horizontal point on the
screen. This setting is shown as a value of 1:XX , where XX is the number of
samples represented by each horizontal point on the screen.
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For example, if the setting is 1:1 then each point on the screen is one sample.
With this setting, a very short length of time is shown on the waveform display.
You might not be able to see the cursor or selection because you are seeing it
at such close range. If the setting is 1:1,024, then there are 1,024 samples
represented by each point on the screen and a longer length of time can be
seen. By dragging the Time Ruler right or left, you can easily scroll the data
window. The further you drag in either direction, the faster the window will
scroll.

If you right-click on the waveform display you can quickly select various
Zoom commands from the Data Window shortcut menu.

When Sound Forge XP opens a file it sets the horizontal magnification to the
value specified by the Normal zoom ratio set on the Display page in the Preferences
folder, unless the file is too small.

To increase or decrease the Zoom Ratio, use the Zoom In/Out spinner control
found on each data window next to the ratio. Clicking on either of the
magnifying glasses increases or decreases the zoom ratio by single steps. If you
drag the small rectangular button between the two magnifying glasses, you can
spin the zoom ratio by larger amounts.

LEVEL RULER ZOOMING
In the bottom left corner of the data window, just above the Go To Start button,
is the spinner control for zooming in and out vertically in the data window.
Zooming in along the level axis allows for more precise editing at the lower
levels (where many edits start and end).

N O T E



The labels for this axis can be either in decibels or in percent and are switched
by right-clicking on the Level Ruler. When zoomed in, only the lower level
samples can be seen; the peaks of the waveform will have moved beyond the
scope of the data window.To view these peaks, drag the Level Ruler up or down.

To optimize the level scaling of a selection, double-click on the Level
Ruler. Double-click again to zoom out to the normal level.

USING ZOOM SELECTION AND ZOOM OUT
To quickly magnify a section of a data window horizontally, use the Zoom
Time/Selection command in the View menu or in the Data Window shortcut menu.
To use the Zoom Time/Selection command you must first select an area of data to
magnify. After selecting Zoom Time/Selection, Sound Forge XP will calculate the
minimum zoom ratio that will allow the full selection to fit on the screen and
then center the selection within the waveform display.

This will not affect the zoom ratio of the Level Axis. Only the Zoom
Selection command in the Level Ruler shortcut menu will zoom the
selection both vertically and horizontally.

To display all data in a window at one time, use the Zoom Time/Out Full
command in the View Menu. This command sets the Zoom Ratio to the lowest
value needed to display all of the data at once in the waveform display.

If you wish to set the zoom factor to its maximum magnification (1:1), use the
Zoom Time/In Full command also found in the View menu or the Data Window
shortcut menu (Zoom In Full).You will then be able to see the actual waveform
oscillations that correspond to physical sound waves when played through
your speakers.

MAGNIFY TOOL
Another way to zoom in to a particular section of the sound file is to use the
Magnify Tool. You can select this tool from the Edit menu (Tool/Magnify) or by
clicking on the Edit Tool selector (upper left-hand corner of data window) until
the magnifying glass appears.
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When the Magnify Tool is enabled, instead of making a selection, the mouse
cursor will become a magnifying glass and a dotted square will appear when
dragging the cursor. The zoom will take place within this dotted square. The
three different modes of operation for the Magnify Tool can be selected by
toggle-clicking (see Using the Mouse in chapter 2). These allow you to time
zoom, level zoom or zoom both simultaneously. You must then return to the
Edit Tool mode to do edit operations.

You can also enter this Magnify mode temporarily by holding down the Control
key when making a selection. If you drag the mouse while still holding the
Control key, you can select a region that will then be magnified to a “best fit”
ratio within the waveform display.

ADVANCED EDITING AND NAVIGATION
This section will show you how to use the advanced editing and navigation
operations of Sound Forge XP.You will learn about:

• Go To

• Making a Data Selection Using the Set Selection Dialog

• Making a Data Selection with Markers

• Adjusting Selection Points

• Using the Overview

• Drag and Drop Operations

• Editing Stereo Files



GO TO
To quickly move the cursor to a specific point and center it in the waveform
display, use the Go To command.You can reach the Go To dialog in a number of
different ways:

• Select the Go To command from the Edit menu

• Right-click on the waveform display and select Go To from the shortcut
menu

• Double-click on the left-most selection status field

• Press Control+G

The Go To dialog is much like the Set Selection dialog described below. You can
type in the location where you want to go or use one of the predetermined
locations from the list.

MAKING A DATA SELECTION USING THE SET
SELECTION DIALOG
If you need to select data at specific points, the Set Selection dialog allows you to
type in selection points or choose a selection from a list of regions. To reach
the Set Selection dialog, choose the Selection command from the Edit menu.
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In the Set Selection dialog, you can modify the Start, End, Length, and Channel of the
selection. Pre-determined regions can also be chosen from the Selection drop-
down list.

MAKING A DATA SELECTION WITH MARKERS
Sound Forge XP has numerous techniques for selecting sound data. The drag
and drop method and the Set Selection dialog are described above. The next
section covers the various keyboard shortcuts you can use for selecting data.

Of all the selection methods, markers are unique. A marker is a placeholder
that you drop in a sound file to define the beginning or end of a selection.The
unique thing about markers is that you can use them in real time.That is, you
can select portions of an audio file while you’re listening to it.

Sound Forge XP has two corresponding marker functions:

• Press [ (the left bracket key) to mark the beginning of a selection.You can
also choose Mark In from the Special menu.

• Press ] (the right bracket key) to mark the end of a selection.You can also
choose Mark Out from the Special menu.

Although the bracket keys and the menu options are equivalent, the keyboard
is probably easier for working in real time.



For example, you might have a sound clip of three events: a pool cue hitting a
ball, the first ball hitting a second one, and the second ball falling into the
pocket. Using markers, you can select the middle sound as you listen during
playback.After you hear the cue hitting the ball, you would press [ to mark the
beginning of the selection. After you hear the first ball hit the second one, you
would press ] to mark the end.The result is that the middle section of the data
appears highlighted as a normal selection.

Although markers are helpful during playback, you can use them when the
sound isn’t playing. For example, you could mark the beginning of a selection
before you’re sure of where it should end.Then you might perform a number
of tests or sound processing functions. Once you know where the end of the
selection should come, you would drop the second marker.

For more information about markers, see Regions and Markers later in this
chapter.

ADJUSTING SELECTION POINTS

EXTENDING A SELECTION WITH THE MOUSE
After selecting a portion of sound data, you will sometimes find that the start
or end points are not exactly where you want them to be.You could just re-
select the data, but it is often difficult to get the start or end points just right.
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Sound Forge XP allows you to update the selection by grabbing a selection edge
and moving it. Once you have established a data selection, place the mouse over
the selection start or end point.You will notice that the cursor changes to a bi-
directional arrow. Once this arrow appears, you can press the left mouse
button and move the selection to a new position. The new position will be
updated once you release the mouse button.

SELECTING WITH THE KEYBOARD
The keyboard selection controls allow you to quickly select data or update a
selection accurately. For example, if you want to extend the selection end by a
small amount, first make sure that the cursor is at the end of the selection.You
can move the cursor from one end of the selection to another by pressing the
Home (moves to the start) and End (moves to the end) keys. You can then use
the Shift+Right arrow and Shift+Left arrow combinations to extend the selection
end point by small increments.

The following list shows the available keyboard commands for selecting data.

Press To select from cursor to . . .

Shift+Right arrow the next screen pixel.

Shift+Left arrow the previous screen pixel.

Shift+End the last sample visible in the waveform display.

Shift+Home the first sample visible in the waveform display.

Press To select . . .

Shift+Page Up 10% of the current view previous to the cursor
position.

Shift+Page Down 10% of the current view past the cursor position.

Shift+Control+Right arrow 2% of the current view past the cursor position.

Shift+Control+Left arrow 2% of the current view previous to the cursor
position.

Shift+Numpad + the next sample.

Shift+Numpad - the previous sample.

Shift+Control+Numpad + 10 samples past the current position.

Shift+Control+Numpad - 10 samples previous to the current position.



Due to a limitation in Windows 95, the last two commands work only
in Windows NT.

As you can see from the above lists, Sound Forge XP has extensive keyboard
support for selecting data. You will find that almost any operation has an
equivalent keyboard shortcut which advanced users find invaluable. For a
complete listing of keyboard and menu shortcuts, see Appendix C.

To see how some of these keys function:

1. Open the file TUTOR1.WAV. Make sure that you’re using the Edit Tool by
selecting it from Tool under the Edit menu. Now make a data selection that
encompasses the word “Wow” with a generous amount of space on each
side of the word. After pressing the Play button you should hear a little bit
of silence, “Wow,” and a little more silence.

2. Choose the Zoom Selection command from either Zoom Level or Zoom Time in the
View menu. This will fit the selection on the screen with the best possible
resolution.

3. Now adjust the right side of the selection. Grab the end of the selection
with the mouse and drag to the right. Adjust the selection to be close to the
end of the word “Wow” and release the mouse button. Now do the same
operation with the keyboard. Hold down the Shift key and press the right
arrow key. The selection will extend to the right by one screen pixel. If you
hold down the Shift key and press the left arrow key, the selection will
decrease by one pixel. One screen pixel is equal to the number of samples
shown in the Zoom Ratio field.You can move the end of the selection in this
manner until you’ve got the selection just right.

4. Now adjust the start of the selection. Since the cursor is at the end of the
selection, any keys you press for selecting data will adjust the end. Put the
cursor at the front of the selection by pressing the Home key.You will see the
cursor jump to the start point of the selection. Now, use the selection keys
to adjust the start of the selection.

If you’re working in Windows NT, you can use the keyboard to select samples
as well as pixels. As noted in the above list, the Shift + Numpad + (plus) and -
(minus) keys select individual samples. This technique allows you to get the
exact selection you need without having to change the Zoom Ratio.
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RESTORING A SELECTION
When you change the cursor position (with the mouse or keyboard) without
holding the Shift key down, you lose your selection and only the cursor is
displayed. If you want to return to the last selection, select the Toggle Selection
command under the Special menu or press the ‘S‘ key.

SHIFTING A SELECTION
Sometimes it is necessary to move a selection’s position without changing the
length of the selection.This can be accomplished in one of two ways.

The first is to use the mouse. Hold down the Shift key and grab the edge of the
selection. Now, when you move the mouse left or right, the selection will move
as a block and the length will be preserved.

The second way is more mathematical. Using the ACID Loop creation tools,
you can shift a selection forward or backward by the length of the selection.
This is very useful if you have exactly a beat or a measure selected and you
want to jump ahead to the next beat or measure. Select Shift Selection Left or Right
from the ACID Loop Creation fly-out menu under the Special menu and the
whole selection will jump forward or backward by the length of the selection.

USING THE OVERVIEW
While making data selections and navigating through sound files, you probably
noticed the overview (the thin bar directly underneath the title bar) change.
The overview represents the length of the entire sound file, as if you were
zoomed out all the way. From the overview, you can determine what section of
the entire sound file is being displayed, the data selection made, and the cursor
location.

GETTING THE WHOLE P ICTURE
To view zooming using the overview:

1. Zoom out all the way on the TUTOR1 window (Zoom Out Full in the Data
Window shortcut menu) and select the waveform data corresponding to the
word “Wow.” Notice that the entire overview has brackets above and below
it, since the entire sound file is being displayed. Also notice how the
selection and the cursor are displayed on the overview.



2. Now press the Zoom In button a few times (the large magnifying glass in the
lower right-hand corner of the data window) and notice how the brackets
become smaller.This corresponds to the smaller fraction of the entire sound
file that you can see when you zoom in on the waveform display. The
selection size, however, remains the same and does not move. Even when
you can’t see them on the waveform display, you always know where the
cursor or the selection are in the sound file by referring to the overview.

You can also change the cursor position by left-clicking anywhere on the
overview. As always, when you change the cursor, you lose your selection.
Remember you can use Toggle Selection if you want to restore it.

FAST NAVIGATION AND PLAYBACK
When you left-click outside the bracketed region in the overview, you will not
be able to see the cursor on the waveform display. However, double-clicking
anywhere on the overview will move the cursor and center the waveform
display to the selected position in the sound file.
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You can also play back the sound file starting from the current cursor position
by right-clicking anywhere on the overview. Right-clicking again pauses
playback. Left-clicking in the overview also moves the cursor position. Also
note that left-clicking on the overview during playback moves the cursor to
the point where you clicked and continues playback at that point. These
navigation tools make it very easy to find sections in large files.

As an example, if you wanted to move the cursor to the beginning of a phrase
in a speech, you can right-click on the overview bar to begin playback and
then left-click at different positions within the overview until you find the
right start point. Once you find the start point, you can press the Stop button
to stop playback.

AUDIO EVENT LOCATOR
Holding down the left mouse button and dragging it in the overview bar will
begin playback of small looped portions of audio around the cursor position.
This is similar to a scrub function in that it allows you to hear brief segments
of audio material in order to quickly scan or locate events within the sound file.

DRAG AND DROP OPERATIONS
You can perform a mix, paste, or crossfade by dragging a selection from one
data window and dropping it on another.

To drag and drop:

1. Open both TUTOR1.WAV and TUTOR2.WAV and select Tile Vertically from
the Window menu to make them easier to work with. One will be called
the source window and the other the destination window.

2. Press and hold the left mouse button in the selected area of the source data
window. While holding the mouse button down, move the cursor until it
changes to an arrow dragging a little box.

3. Drag the cursor onto the destination window. You will see a shaded block
that represents the range of the source material. You will also see that the
little box accompanying the cursor now contains an “M”(Mix), “C”
(Crossfade), or “P” (Paste). Position the block at the place in the destination
window where you would like the mix, paste, or crossfade to occur.



4. Let go of the left mouse button. This will bring up the Mix dialog. To
perform a crossfade instead of a mix, hold the Control key down while letting
go of the mouse button. Holding down the Alt key when dropping performs
a paste.

An easier way to select a mix, paste, or crossfade is to drag the block to
the destination window.Then, while holding the left mouse button, click
the right mouse button to toggle between the Mix, Paste, or Crossfade
functions.You will see the block change according to the method; a mix
will look like a solid block, a crossfade will look like an “X”(or perhaps,
a butterfly), and a paste will be represented by a segmented vertical line
rather than a block.

DRAG AND DROP MIXING
To mix using drag and drop:

1. As in the previous example, open TUTOR1.WAV and TUTOR2.WAV. Again,
to make the windows easier to view you may want to select the Tile Vertically
command from the Window menu. For this exercise,TUTOR1.WAV will be
the destination window and TUTOR2.WAV the source window.

2. Highlight all the data in TUTOR2 by making it the active window and
double-clicking in the waveform display. Now drag the selected section by
pressing and holding the left mouse button in the data window of the
TUTOR2 window. Notice that the cursor changes to a pointer with a small
box when you begin dragging. Drag the block to the beginning TUTOR1
data window and let go of the mouse button to drop the section.

3. When you let go of the mouse in the TUTOR1 window, you will see a dialog
that shows the TUTOR2.WAV window as the source and TUTOR1.WAV as
the destination. Leave the levels at 0 dB, and select OK.You will see that again
the drum hit sound has been mixed into the TUTOR1 window. Press the Play
button to hear the results.
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DRAG AND DROP CROSSFADING
To Crossfade using drag and drop:

1. Undo the last operation.

2. Select all of TUTOR2 and drag it toward the end of TUTOR1.

3. Press and hold the Control key to see the crossfade block.This X-shaped block
shows you where one sound begins to fade out and the other to fade in. By
dragging the crossfade block left or right from the end of the destination
file or the end of a data selection, you can adjust the length of the crossfade.

4. Once you have determined where you would like the crossfade to begin, let
go of the mouse button. When you press the Play button, you should hear
the end of TUTOR1 fade out as the beginning of TUTOR2 fades in.

DRAG AND DROP PASTING
To paste using drag and drop:

1. Undo the last operation.

2. Select all of TUTOR2 and drag it over to TUTOR1. Hold the Alt key down
while you position the paste point at the beginning of TUTOR1.

3. Let go of the mouse button. If everything was done correctly, you should
have pasted the data from TUTOR2 at the insert position in TUTOR1.

CREATING A NEW WINDOW WITH DRAG AND DROP
A very useful feature of drag and drop is the ability to quickly create a new
window from a data selection. Make a selection in a data window and drop it
on an empty area of the Sound Forge XP workspace. A new data window is
automatically created containing the data from the selection.

EDITING STEREO F ILES
When editing stereo files you have two channels of data on which to work.The
upper channel is the left channel and the lower channel is the right channel.
In the following examples, both labels (left/upper, right/lower) will be used.



SELECTING DATA IN STEREO F ILES
When selecting data in stereo files, Sound Forge XP allows you to select either
the left channel, right channel or both channels for playing, editing, and effects
processing.

When editing a stereo file, the waveform display showing the two channels is
split into three logical sections for selection with the mouse.The upper quarter
of the waveform display is the left channel section, the lower quarter is the
right channel section, and the middle half selects both channels. When
selecting data with the mouse, the cursor location determines what channel(s)
will be selected.

To select data in a stereo file:

1. Open the TUTOR1.WAV file.

2. Convert the file to stereo by editing the Format under Properties in the File
menu or by right-clicking on the Channels playbar field and selecting Stereo.
Set the Channels to Stereo and press OK. Select Both Channels for the destination
in the Mono to Stereo dialog. You should now have a stereo version of
TUTOR1.WAV.

3. Move the mouse pointer near the top of the left channel and select the word
“Wow.” Notice the change to the left channel selection cursor, and that only
the left channel of the data becomes highlighted. Do the same thing in the
middle half of the window near the top of the right channel and the
bottom of the left channel. This time you should see both channels being
selected. Do this one more time near the bottom of the waveform display
and you should see only the right channel being selected.

4. The cursor will change to reflect which channel(s) are being selected:

Cursor when selecting both channels of a stereo file or when in 
a mono file.

Cursor when selecting the left channel of a stereo file.

Cursor when selecting the right channel of a stereo file.
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TOGGLING CHANNEL SELECTIONS
Once you have made a selection in a stereo file you can switch between
channel selections by pressing the Tab key. The Tab key will cycle between
selections of Left Channel, Right Channel, and Both Channels. You can also set the
channel selection by using the Channel drop-down list in the Set Selection dialog
(Edit menu).

PREVIEWING CHANNELS
Selecting a single channel allows you to hear a preview of a single channel in
the stereo file.

To preview a channel:

1. Triple-click in the TUTOR1 window to select all the data (or use Select All
from the Edit menu). Press the Play button and listen to the clip.

2. Press the Tab key to toggle the channel selection into a single channel and
press the Play button again. Do this one more time to hear the other
channel.

SINGLE CHANNEL EDITING
Stereo data files are tied together by the nature of their format. In other words,
they always play together.This means that there are some edit operations, such
as Cut and Paste, that you can’t use on a single channel. It would leave one
channel shorter or longer than the other.This is usually not a problem in real
world editing situations. To shift a single channel in time by small amounts,
you can use the Delay/Echo function.

You can copy a selection from a single channel to the clipboard by selecting
the data in either the left or right channel and using the Copy command. This
will place a mono clip on the clipboard.You can then paste the mono clip to
a mono file, both channels of a stereo file, or you can mix it into a single
channel or both channels of a stereo file. When mixing mono clipboard data
to a stereo file you will be asked with a dialog whether you wish to mix to a
single channel or both channels.



REGIONS AND MARKERS
This section covers Sound Forge XP’s ability to create regions and markers in a
data window. Each data window can have its own Regions List stored along with
the sound data when saved in the WAV file format.

Sections covered are:

• Using the Regions List 

• Creating Regions

• Editing a Region

• Using Markers

USING THE REGIONS LIST
The most basic use of the Regions List is for dividing a sound file into separate
named regions.These regions can then be quickly played or highlighted in the
data window.You can also mark important time positions with markers so that
you can navigate through large files faster.

CREATING REGIONS
This section will describe how to create regions within a sound file.

CREATING A REGION USING MENU COMMANDS
As with most features in Sound Forge XP, you can create a region in your sound
file in a number of different ways. One of the simplest ways is to drag a
selection from a data window into the Regions List.

To create a region:

1. Open the TUTFILL.WAV file.

2. Open the Regions List window by selecting Regions List from the View menu.
You can also open this window by pressing Alt+1. There should be no
regions in the Regions List; creatinging one is what we are setting out to do!

3. To create a region, listen to the file by pressing Play and then select the
cymbal crash at the end of the file. Next, select Add from the Regions List
command in the Special menu.The Add Marker/Region dialog will appear.
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4. Name the region Cymbal Crash and then select OK. A region will be created
and placed in the Regions List. Each region in the Regions List has a Play button
that you can use to play that particular region. In addition, Region Tags that
show the location of the region appear in the Time Ruler.

OTHER WAYS OF CREATING REGIONS
There is also a shortcut menu to let you quickly create regions.

1. Select the beginning part of the TUTFILL.WAV file with the drum roll and
then right-click on the ruler. From the Ruler shortcut menu, select Add
Marker/Region and the Add Marker/Region dialog will appear.

2. Name this region Drum Roll. Notice that if you click on Drum Roll or Cymbal
Crash, in the Regions List window, the region is selected in the data window.

3. The easiest way of creating regions is to drag them from a data window and
drop them directly into the Regions List window.



4. In the TUTFILL.WAV file, select the portion of data between the Drum Roll
and Cymbal Crash regions and then drag it to the Regions List window and
release the mouse button. The Add Marker/Region dialog will immediately
appear upon releasing the mouse button. Name this region Toms and press
OK.

5. Pressing “R” after making a data selection will create a region as well. This
is a very fast method of creating regions, however, the Add Regions dialog
won’t pop up. This means the region will be named automatically by its
time boundaries.You can change the region name later (see below).

EDITING A REGION
This section describes how to edit an existing region in a sound file.

EDITING REGIONS WITH THE RULER REGION TAGS
Changing the end points of a region is as simple as sliding the region tags on
the data window ruler (above the waveform display). When you left-click on
a region tag, the corresponding region end point tag is also highlighted. Also,
the name of the region is displayed in the left side of the status bar. Double-
clicking on a region tag changes the selection points to the region area.

To perform region edit operations, right-click on the region tags. This brings
up the Marker/Region shortcut menu. You can then choose from the following
options:

Select Modifies the current selection points to be equal
to the region end points.

Delete Deletes the region, not the sound data, from the
Regions List.

Edit Takes you to the Edit Marker/Region dialog for
manually editing region attributes.

Update Modifies the region end points to be equal to the
current selection.
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EDITING REGIONS IN THE REGIONS LIST
Another way to edit region points is to double-click on a region name in the
Regions List.This brings up the Edit Marker/Region dialog, which allows you to type
in region parameters. Also, right-clicking on the Regions List allows you to
choose from various commands in the Regions List shortcut menu.

USING MARKERS
While regions specify a section in a sound file, a marker is a location in the
sound file you wish to use as a reference point. Markers are often used to tag
important file locations, making it easier to navigate around the sound file.

CREATING A MARKER WITH THE RULER SHORTCUT MENU
A marker can be created in the same ways discussed earlier for making regions.
The fastest way is to place the cursor where you want the marker and then
right-click anywhere on the ruler.This will bring up the Ruler shortcut menu,
where you then select the Add Marker/Region option. In the Add Marker/Region
dialog, type in a name for the marker and select OK. If no data is selected,
Sound Forge XP will automatically create a marker at the cursor position. If
you have selected data, Sound Forge XP defaults the Type to Region in the Add
Marker/Region dialog.

EDITING MARKERS
Markers can be edited in the same way as regions (see above section). The
marker tags in the ruler can be moved back and forth, and shortcut menus
appear when you right-click on the tag.

STARTING PLAYBACK FROM A MARKER LOCATION
To play the sound file beginning at a marker location, press the small Play
button to the left of the marker name in the Regions List window.



DROPPING MARKERS WHILE PLAYING OR RECORDING
Another useful feature in Sound Forge XP is the ability to create markers as you
listen to the sound file.To do so, first start playback on any sound file.A marker
will be created each time you press the ‘M‘ key. When finished, you can then
rename each marker to whatever you wish.

While recording, you can press the Drop Marker button (to the right of the Play
button) in the Record dialog.After pressing this button once, pressing the Spacebar
will create other markers.
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CHAPTER 4:
F I LE FORMATS AND ATTR IBUTES
This chapter describes how to work with file formats, including AVI and
Internet files, and file attributes.The sections are:

• Working with Sound File Formats

• Working with AVI Files

• Working with Internet Media Formats

WORKING WITH SOUND F ILE FORMATS
This section will show you how to deal with many different sound formats.
You will learn about:

• Changing the Format of a Sound File.

• Converting Between Stereo and Mono.

• Converting Sound Files from 16-bit to 8-bit.

• Converting Files from One Format to Another.

• Embedding Summary Information.

CHANGING THE FORMAT OF A SOUND F ILE
When you open a file or create a new data window, the format for the window
is shown on the first three status fields of the main status bar at the bottom of
the program window. The format parameters consist of the Sample Rate, Sample
Size, and number of Channels (Mono or Stereo).The last status fields display the
Total Length of the sound data, and the amount of Free Storage available.



Changing the sample rate will make your sound play faster or slower and
with a higher or lower pitch. If you want the file to sound the same at a
different sample rate, use the Resample command under the Process
menu.

When you right-click on any of the three format fields, a shortcut menu will
pop up at the current mouse location allowing you to change that parameter.
You can also change all three parameters at one time by selecting
Properties/Format under the File menu.The Properties folder can also be invoked by
double-clicking on any of the format fields, or by right-clicking on the
waveform display of the data window and selecting Properties in the shortcut
menu.
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CONVERTING BETWEEN MONO AND STEREO
To convert a file from mono to stereo:

1. Open the TUTOR1.WAV file. Right-click on the status field, which has the
word Mono, and select Stereo from the shortcut menu.

2. When you convert from mono to stereo, the Mono to Stereo dialog will appear,
asking you where you want to put the data.Your choices are:

Left Channel The mono data is placed in the left channel.The
right channel is set to silence.

Right Channel The mono data is placed in the right channel.
The left channel is set to silence.

Both Channels The mono data is copied into both channels.

When performing stereo to mono conversions, the following options are
available:

Left Channel Mono data is taken only from the left channel of
the stereo file.

Right Channel Mono data is taken only from the right channel
of the stereo file.

Mix Channels Mono data is created by mixing both channels of
the stereo file.

3. For this exercise, put the data in the left channel to see how the function
works. Click the radio button next to Left Channel and select the OK button.



4. You will now have data in the upper half of the data window (the left
channel) and silence in the right channel. Press the Play button and you will
hear “Wow, sound editing just gets easier and easier” in only the left
channel.

If your sound card supports only mono data you will still be able to play
stereo files if you set your playback device to Sound Mapper on the Wave
page in the Preferences (Options menu).

5. Now go back to a mono sound file, but do it in a different manner. Select
Properties from the shortcut menu that appears when you right-click on the
waveform display. In the Properties folder select the Format page. This page
allows you to change all the parameters at once. Set the radio button for
Channels to Mono and select the OK button. Select the Left Channel for the
source channel in the Stereo to Mono dialog and you’re back where you
started.

The above steps were used as an illustration. Using Undo would have
been the more efficient option.

CONVERTING SOUND F ILES FROM 16-B IT  TO 8-B IT
To save storage space, 16-bit sound files are often converted to 8-bit files.
However, when you represent a sound file with only 8 bits, an audible
distortion referred to as quantization error becomes very prominent. To
minimize quantization error, there are things you can do to the 16-bit sound
file before converting it to 8-bit.You can:

• Apply a Noise Gate (Effects menu) to completely mute out the silent parts in
a sound file. Often, a low level signal in a 16-bit sound file will become
noise after the 16- to 8-bit conversion, so it’s best to have complete silence
between the sound parts.

• Normalize (Process menu) the sound to 0 dB (peak). This ensures that the
entire dynamic range available in 8-bit samples is used and lowers the signal
to noise ratio.
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Once you have performed the above operations, you should use Convert to 8-Bit
in the Process menu to do the 16- to 8-bit conversion. Sound Forge XP
provides three different 16- to 8-bit conversion options; Truncate, Round, and
Dither.

Truncate removes the lower 8 bits and they are lost forever. Round is similar to
Truncate, only some attempt is made to represent the highest of the low bits by
rounding up if possible. Dithering is used to mask the quantization noise with
less obtrusive noise. In the Convert to 8-Bit dialog, set the Dither bit depth to a low
value (like 0.1) and increase the value slowly until you reach an acceptable
sound.

Remember, an 8-bit sound file will always sound noisier than a 16-bit sound
file, so whenever possible, stick with 16-bit. When trying to save space, it is
possible to get better results from lowering the sample rate than using 8-bit
samples. For more information, see Resample under the Process menu in chapter
6, Sound Forge XP Reference.

CONVERTING F ILES FROM ONE FORMAT TO ANOTHER
When producing audio files you may find that you need to work with a variety
of file formats. For example, WAV files could have data formats such as 8-bit
mono, 16-bit stereo, or even ADPCM.You may need the files converted to Raw
data, VOC, or some other PC format. You may even need to convert to a
different platform like Macintosh AIF files or Amiga SVX.

In the previous sections you’ve seen that you can quickly convert between
mono/stereo, 8-/16-bit, and change the sample rate with Sound Forge XP.You
can also use the Save As command to save the file to a new name, or you save it
in a new file format.

To convert file formats:

1. Open the TUTOR1.WAV file. Select the Save As command from the File
menu.The Save As dialog will be displayed.



2. In the Save As dialog, there are three controls that are used for file
conversion: Save as type, Format, and Attributes.

The Save as type is the list of all available output file types.The Save as type will be
set to the type from which the file was opened.The default for new files is Wave
(Microsoft) (*.wav). You can change to the type of file you want to save by
selecting the new type from the Save as type list. Notice that the extension of the
file name will be changed to reflect the type of file you are saving.
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The Format drop-down list shows the format of the data that will be saved in
the file. Usually this will be PCM (Pulse Code Modulation), which is the standard
for most file types. PCM is a standard format for normal uncompressed audio.
If you are saving a file to a file type that supports other formats, they are
displayed in the drop-down list. Other formats are typically used when saving
audio data in a compressed form.

The Attributes drop-down list shows the sample size, channels, and sample rate
that will be stored when saving this file. Examples include 11,025 Hz, 8-bit
Mono or 44,100 Hz 16-bit stereo.You can quickly change the attributes of the
data by selecting one of the options available in the drop-down list.When you
change from a mono file to a stereo file using the Attributes field, that data is
copied to both channels. If you change a stereo file to a mono file, the data is
mixed to one channel.

When you change the Save as type you may notice that the Format and Attributes
fields will also change.This is because not all file types support the same types
of sound data. For example the Dialogic VOX format only supports 16-bit
mono Dialogic ADPCM files.This means you can’t store stereo 8-bit data in this
file. Don’t worry, in most cases Sound Forge XP automatically converts any file
you save to an acceptable format.

EMBEDDING SUMMARY INFORMATION
Several important sound formats let you include text information with sound
data.These formats include:

• WAV

• AVI (Microsoft Video for Windows)

• ASF (Active Streaming Format files using Microsoft NetShow)

• RM (RealMedia, including RealAudio and RealVideo)

When you create one of these files, you can include over 30 text fields
including, Creation Date, Copyright, Keywords, and a variety of other informational
text data. Sound Forge XP supports viewing and editing any of these fields.



SUMMARY INFORMATION
Use the Summary properties to view or change summary information for a file.
To see these options, choose Properties from the File menu and select the Summary
page.

EXTENDED SUMMARY INFORMATION
To see the Extended Summary dialog, click Extended on the Summary page. The
Extended Summary dialog contains a list of available fields, each of which may or
may not have attached text. The Fields list shows the abbreviation of the field
type and a short description. If the field is currently empty, the word Empty
appears after the description. Below the list of fields is the Contents, which
shows the contents of that field. At the bottom of the dialog is a longer
description of the current field.
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To the left of each field in the list is a check box, which is used to enable or
disable fields of this type when saving files. The field is enabled or disabled by
clicking on the check box. If a field is empty, i.e., has no text, enabling the
check box has no effect on a saved file. Field information is only saved if text
information exists for that field.

The Save Summary Information in file (.WAV, .AVI, .ASF, .RM) check box in the Save As
dialog is used to quickly enable/disable saving of all summary fields to a file
during a Save As operation. This allows you to quickly strip all summary
information from a file.

For a description of the fields available, refer to Properties in the File menu in
chapter 6, Sound Forge XP Reference.



DEFAULT
If the Default button is selected, the text in the summary fields is saved with the
default fields that are automatically filled when creating a new WAV file. The
Creation date field (ICRD) is always filled with the current date for new files.
Saving a custom default setup is handy for saving copyright and engineer
information for new files created at your site.

To view extended summary information:

1. Open the TUTOR1.WAV file.

2. Select the Summary page from Properties in the File menu.This will show you
the Summary dialog.

3. Press the Extended button. Notice that the default for saving summary
information is to have all fields enabled. The fields that have already been
filled in for TUTOR1.WAV are Comments, Copyright, Creation Date, Engineer,
Name/Title, and Software.

4. Scroll to and select each field. You will see the embedded text for each of
these fields.

ADDITIONAL EMBEDDED INFORMATION
You can also embed non-text data in a WAV, AVI, ASF, or RM file. If you open
and edit a file which has additional information created by other software,
Sound Forge XP will keep track of this data and place it back in the file when
you save to the original format.

If you wish to add or remove additional data (such as embedded bitmaps,
metafiles, etc.), you can use the Save As command from the File menu. When
you save data using the Save As option, Sound Forge XP will ask you if you wish
to copy the additional non-audio information to the new file. At this point
you can answer either Yes to place the additional information in the new file
or No to save only audio data and any additional data types you have selected.

Sound Forge XP will only prompt you to save if such data exists.
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WORKING WITH AVI  F I LES
Sound Forge XP lets you work with Microsoft Audio and Video Interleave (AVI) files.
You can edit the audio tracks of a video with single frame accuracy.This section
covers:

• Opening an AVI File

• AVI Navigation

• Attaching a Video to a Sound File

• Saving an AVI file

• AVI Video Compression

• Editing Audio in AVI Files

OPENING AN AVI  F I LE
To open an AVI file, choose Open from the File menu and select Video for Windows
(*.avi) from the Files of type list.Then, double-click on the file you wish to open.
If the AVI file being opened in Sound Forge XP contains exactly one video
stream and one audio stream, it will open these streams automatically.
However, if no audio is present an audio stream will be created containing only
silence for the entire length of the video.

HANDLING MULTIPLE STREAMS
AVI files can contain more than one video or audio stream. A stream is not the
same as a track in a multi-track video or audio editor. Multiple streams are
most commonly used to contain different versions of a video or audio track.
For example, you could have an AVI file with one video stream and multiple
audio streams in different languages. An AVI player, such as Microsoft’s Media
Player, can detect which language version of Windows your computer is using
and automatically play the correct audio stream for that language.

If more than one stream exists, the Video Stream dialog will be displayed when
opening the file. In this dialog, you must select a video and audio stream to
open by using the Stream Selectors (black diamonds) to the left of each stream.
Once you’ve selected one of each, press OK.



AVI  NAVIGATION

VIDEO STR IP
When you open an AVI file, you will notice the video strip on top of the
waveform display. When you use Zoom Out to view the waveform, all of the
frames in an AVI will not be displayed.The left edge of the displayed frames are
aligned with the audio in time. If you’d like to see the frame numbers appear
on the frames, activate the Video Strip shortcut menu by right-clicking on the
video strip and select Number Frames.

To resize the video strip, drag its lower edge up or down.

To enable frame animation in the video strip, select Animate frames from the
Video Strip shortcut menu.When this option in enabled, moving the cursor will
cause the nearest frame to be displayed above it. During playback, you will see
the active frame window play the video as the cursor moves past it.

VIDEO PREVIEW
Selecting Video Preview from the View menu opens theVideo Preview window. The
frame closest to the cursor (during editing or playback) will always be
displayed in this window.

At the top of the window, the original frame size and current display size (in
parenthesis) are displayed, along with the frame rate and current frame
number. An asterisk (*) by a frame number indicates that the frame is a key
frame (see the section on compression below).

ATTACHING A VIDEO TO SOUND F ILE
To attach a video to an opened sound file:

1. Select Properties from the File Menu and go to the Video page. Pressing the
Attach button will display the Attach Video dialog, where you can select an AVI
file as a source of video.
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2. Press Open after selecting an AVI file with a video stream. The Video Properties
will now display the audio and video streams in the AVI file. An AVI file can
contain multiple streams, but in most cases you’ll have one audio stream
and one video stream.



3. The check box to the left of each stream indicates which streams will be
stored when you save your file. The black diamond next to it is the Stream
Selector, which indicates which streams are currently being used in Sound
Forge XP.

4. Press OK and you should now see the video strip above the waveform
display. Once you’re done editing, you must save the file in AVI format if you
want to store the video.

SAVING AN AVI  F I LE
To save an opened file in the AVI file format:

1. Select Save or Save As from the File menu. From the Save As dialog, select Video
for Windows (*avi) from the Save as type drop-down list. After naming the file
and selecting attributes, select Save.

2. The Video Save Options dialog appears next. Here, you can select which streams
to store in the AVI file by checking the square check box to the left of each
stream. In this dialog, it is also possible to edit the titles of the streams.
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3. Pressing OK will take you to the Compression Options dialog. Here, you can
select a compression scheme for each audio and video stream.To change the
options for a stream, select it and press the Options button. By checking the
Interleave every _ Frames option, you can specify how frequently the audio
chunks are interwoven with the video.

4. If you pressed the Options button, yet another dialog, Video Compression, lets
you select from different compression algorithms, and even go to another
dialog to set specific compression configuration parameters. For more
information on compression, see the next section. Selecting No Recompression
saves the stream in its original format, which is the Sound Forge XP default.

5. Once you’re done setting compression options, selecting OK will complete
the process. If the video is long and/or the compression scheme selected is
slow, saving the file might take a while. However, if you didn’t change any
video compression formats, the save will be much faster, since no
recompression takes place.



AVI  VIDEO COMPRESSION
If you thought audio files chewed up your hard-disk space quickly, wait until
you start using video! CD quality audio takes up about 10 MB of hard-drive
space per minute (60 seconds x 44,100 samples per second x 2 tracks for stereo
x 2 bytes per 16-bit sample). However, typical video for multimedia use can
easily take up about 200 MB per minute for a small window of video (60
seconds x 15 frames per second x 320 x 240 x 3 bytes for 24 bit pixels). Using
uncompressed video as a final distribution format is out of the question for
most practical purposes.Video compression is a necessary evil.

COMPRESSION ALGORITHMS
Many different compression algorithms exist and many more will continue to
be created in the next several years. With all algorithms, there will be trade-
offs between video quality, size reduction, and compression/decompression
processing time. Compressing by large amounts quickly will generally produce
visual artifacts such as jumpy or grainy video.

When saving an AVI file in Sound Forge XP, you can select from all of the
compressors installed in your system. Included with Windows are Cinepak by
Radius (cvid), Intel Indeo (IV32), and Microsoft Video 1 (CRAM). These can
be selected from the Video Compression dialog (see section above).

COMPRESSION SETTINGS
Many compressors use key frames during compression and decompression. A
key frame is a frame in the video stream that is not inter-frame compressed.
The following compressed frames are derived from the closest key frame.
Having fewer key frames will make the video size smaller. However, it will take
a lot more time to display the frames, especially when jumping around the end
video.

When editing AVI files in Sound Forge XP, the display speed will suffer
greatly if there is only one key frame in the entire file. In such cases,
Sound Forge XP needs to scan all preceding data when drawing every
single frame.
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Also in the Video Compression dialog, you can specify the Data Rate of the video,
which relates directly to the final size of the file. Different compressors do
different things with this value, since it’s only an expected value. In most cases
you should leave this unchecked. If you have very limited playback data rates,
such as with a single-spin CD-ROM, you might then want to set this value.
However, note that the Compression Quality control setting will also affect the
output size.

Use the Preview button to get an idea of the video’s output quality and
compression amount.

EDITING AUDIO IN AVI  F I LES
When doing any operations on the soundtrack of an AVI file, the video stream
is always left untouched. For example, doing a cut or paste on a sound file will
not change the duration of the video stream.

In Sound Forge XP, the video stream and audio stream will always start
together, and you will see the video frames only where audio exists.Therefore,
if you want to view the entire video stream, you should use Insert Silence to add
enough audio to run the entire length of the video.You can then later mix into
the file any needed sounds.

WORKING WITH INTERNET MEDIA FORMATS
Sound Forge supports two different formats for creating files that are
optimized for streamed playback over (usually) slow networks such as the
Internet. RealNetwork’s RealAudio and RealVideo (.RM,.RA), and Microsoft’s
NetShow Advanced Streaming Format (.ASF) files can be created in Sound
Forge. To play these files, you must have the appropriate player application
installed in your computer.

This section covers the following topics:

• Using Sound Forge XP to create RealMedia files

• Using Sound Forge XP to create ASF files.

N O T E



USING SOUND FORGE XP TO CREATE REALMEDIA F I LES
Sound Forge XP gives you the ability to save sound files in RealMedia formats
(RealAudio and RealVideo) along with editing tools that help maximize the
audio’s fidelity.This section first explains how to save files in RealAudio format,
then covers saving files in RealVideo format. All of the tips for converting files
to RealAudio also apply for converting AVI files to RealVideo. For more
information on authoring RealMedia content, refer to Progressive Networks’
RealMedia home page (www.real.com).

PREPARING REALAUDIO F ILES
Preparing RealAudio files is a three-step process:

1. Recording the audio.

2. Preparing a sound file for RealAudio encoding.

3. Setting the RealAudio text fields.

RECORDING THE AUDIO

To record a sound file:

1. Click the Record button.The Record dialog appears displaying the settings from
the last clip recorded.
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2. Use the defaults or click the New button to change the Sample Rate, Sample Size
or number of channels of the source file.

3. Check the Monitor box and play the clip to be encoded. Check for clipping.
You want the levels to be mostly in the green area, a little in the yellow and
only occasionally in the red. If Sound Forge XP displays a red Clip warning
above the Monitor, you should:

4. Stop the input source.

5. Click the Reset button.

6. Lower the volume of the input source either by turning down the output
of your sound source or by turning down the input volume on your sound
card’s mixer window. In general, you don’t want any of your levels too high
or too low.

7. Check the levels again. It is better to be conservative with the starting levels.

8. Click the Record button to re-record.

9. When the file is recorded completely or when you click the Stop button, a
graphical display of the wave file appears.

10.Click the Close button to close the Record dialog.

PREPARING A SOUND F ILE FOR REALAUDIO ENCODING

When you have finished recording a file, it is recommended that you
normalize and compress the file before saving it in RealAudio format.

Normal ize

When you have finished recording a new file or opening pre-existing files, it
is recommended that you perform the following processes on the file before
saving the file in a RealAudio format.

Sound Forge allows you to save preset settings for each of these processes.
So once you set them up the first time, you can always use the same
settings.

N O T E



This process ensures that the loudest part of the file is at the maximum level.
Follow these steps to normalize a file

1. Press Ctrl-A to select the entire file.

2. Select Normalize from the Process menu.The Normalize dialog appears.

3. Move the Normalize fader to -.50 dB (94.41%).

4. Select OK. Sound Forge XP normalizes the file.

Compress 

If you have not already audio compressed the file you can do so now.
RealAudio files benefit from compression because it increases the overall
volume and intelligibility of the sound. The suggested settings use very light
compression. Follow the steps below to compress the clip:

1. Press Ctrl-A to select the entire file.

2. Click on the Effects menu, followed by the Dynamics option.

3. Move the Threshold slider to -10.00 dB and the Ratio slider to 2.0:1.

4. Finally, set the Attack control to 1.0 milliseconds, and the Release control to
300.0 milliseconds.

5. Click the OK button.
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SETTING REALAUDIO TEXT F IELDS

RealAudio and RealVideo files can store information about the title, author
and copyright of the clip.To set the RealAudio and RealVideo text fields, follow
these steps:

1. Choose Properties from the File menu.The Properties window for the current
file displays.

2. Click the Summary tab.

3. Enter the Title, Engineer, and Copyright information. This information
appears in the Title, Author, and Copyright text boxes on the RealPlayer.

4. Press the OK button, and the fields are transferred in to the RealAudio or
Video file when it is saved.

SAVING AN AUDIO F ILE AS REALAUDIO

To save an audio file as RealAudio, follow these steps:

1. Click on the File menu, followed by the Save As option. The Save As dialog
displays.

2. Enter the file name of the file you are saving.

3. Select RealMedia (*.rm;*.ra) as the Save as type.The default extension for this
type of file is .rm.To save using the .ra extension, type .ra at the end of the
file name.



4. Next, click the Save button. The RealMedia Save Options dialog box opens.
This dialog box is explained in detail in the reference chapter in the “Save
As” section.

5. Select the Audio compression type from the drop-down list. A brief description
of the highlighted compression type displays below this list.

6. If the file you recorded was stereo, and you selected a mono compression
type, select the appropriate Stereo to mono conversion option. It is recommend
that you use the Both Channels option.

7. Click the OK button. After the file has been saved, a message appears, asking
whether you want to listen to the saved file through the RealPlayer. This
message verifies that you have saved the file in RealAudio or RealMedia
format.You can listen to the file by clicking the Yes button if you have the
RealPlayer installed.

SAVING AN AVI  F I LE AS REALVIDEO

To save an AVI file as RealVideo, follow these steps:

1. Click on the File menu, followed by the Save As option. The Save As dialog
displays.

2. Enter the file name of the file you are saving.

3. Select RealMedia (*.rm;*.ra) as the Save as type.

4. Click the Save button and the RealMedia Save Options dialog displays. This
dialog box is explained in detail in the reference chapter in the “Save As”
section.

5. If you wish to include the audio in the new RealVideo file, make sure the
Save Audio Stream option is checked. Next, select the Audio compression type from
the drop-down list.A brief description of the highlighted compression type
displays below this list.

6. If you wish to include the video in the new RealVideo file, make sure the
Save Video Stream option is checked. Next, select the Video compression type from
the drop-down list. For a brief description of the two compression types,
see the reference chapter’s “Save As” section.

7. Specify the Desired maximum data rate in total kilobits per second (Kbps). This
option is only available if you are saving a video stream. Refer to the
documentation for “Desired Maximum Data Rate” in the “RealMedia Save
Options” section for more information.
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8. Click the OK button. After the file has been saved, a message appears, asking
whether you want to listen to the saved file through the RealPlayer. This
message verifies that you have saved the file in RealVideo format. You can
view the file by clicking the Yes button if you have the RealPlayer installed.

REALMEDIA SAVE OPTIONS

This dialog is reached when you select RealMedia (*.rm;*.ra) from the Save as type
list in the Save as dialog.

Enable select ive record capabi l i t ies

When checked, RealMedia-compatible players can allow users to save (record)
RealMedia streams to their hard drives. Use this option only if it is acceptable
for users to create copies of the RealMedia file. The RealPlayer Plus from
Progressive Networks supports Selective Record capabilities.



Enable Per fectPlay capabi l i t ies

When this option is enabled, users connected with standard modems can select
to download a higher quality version or the audio and/or video that is
normally only available over ISDN or LAN connections.The higher bandwidth
RealMedia stream is then played back from the user’s hard disk after the
download process is complete.The RealPlayer Plus from Progressive Networks
supports PerfectPlay capabilities.

Create event  f i le  (RAE)  f rom Marker  and Reg ion labels

When this option is enabled, events can be embedded from the Regions List
(View menu) into the RealMedia stream.

To embed an event, create a marker or region with a label starting with one of
the below prefixes followed by a colon.

RM URL: Specifies a URL (web address) to open.

RM Title: Sets the Title field in the RealPlayer.

RM Author: Sets the Author field in the RealPlayer

RM Copyright: Sets the Copyright field in the RealPlayer

For example, if you create a marker with the label RM URL:http://
www.sonicfoundry.com, the RealPlayer would open the Sonic Foundry 
home page at the marker’s location in the file during playback. You can just 
as easily open specific web pages. For example, RM URL:http://
www.sonicfoundry.com/realaudio.html would open the realaudio.html page
on Sonic Foundry’s web site.

Progressive Networks publishes extensive information on RealMedia events on
their web site (www.real.com). However, Sound Forge XP is capable of
generating all event files automatically rather than requiring several tools as
described in Progressive Networks’ documentation.

Save audio st ream

When checked, the file’s audio stream will be converted and saved into the
RealMedia file.

Audio compression

This option selects the RealAudio compressor that is used when saving the file.
If you need to save RealAudio files with Bandwidth Negotiation capabilities,
you can automate the process using Sonic Foundry’s Batch Converter Plug-In.
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When a compression type is selected, a brief description of it is displayed
below the list box. The frequency response parameter of the description
indicates how wide, in Hertz, the bandwidth of the audio in the RealMedia file
will be.The bandwidth of a normal human’s hearing is about 20,000 Hz or 20
kHz.

Stereo to mono convers ion

If the source audio file is stereo and you choose to convert to a mono
RealAudio format, you will need to decide what channel(s) to use for the
mono signal. Selecting Both channels will evenly mix the signal together. If you
are unsure of this option, always choose Both Channels.

Save v ideo st ream

When checked, the file’s video stream will be converted and saved into the
RealMedia file.

Video compression

Currently there are two types of RealVideo compression: RealVideo (Standard)
and RealVideo (Fractal). Each type is optimized for different types of video and
transfer rates. Detailed information on the two types is available on the
RealMedia home page (www.real.com).

Video compression qual i ty  (1  to 100)

This option allows you to compromise between quality of compression and
lowest possible data transfer rate. Setting this level at 100 provides the best
quality video with the greatest required bandwidth to stream. A setting of 1
gives you the lowest quality video but requires the least bandwidth to stream
effectively.

Frames per  second (0 .050 to 1000)

This setting allows you to change the frame rate of the video that is being
compressed. A lower frame rate, such as three or five frames per second, will
greatly lower the bandwidth requirements for streaming the video. Type the
desired frames per second into the edit box, or choose one of the presets from
the drop-down list.



Desired maximum data rate (1 .0  to  500.0 Kbps)

This setting is available only if you are saving a video stream. The data rate
specifies the desired total kilobits per second (Kbps) for the RealMedia file
(including audio and video).To increase the bandwidth available for streaming
the video, you can either lower the data rate for the audio, or increase the
desired maximum data rate. Note that you must allow some room for
inconsistent transfer rates. For example, a 28.8 modem cannot sustain 28.8
Kbps. Instead, you should target your maximum data rate for between 20.0 and
22.0 Kbps. The allowed data rates are displayed next to the Audio/Video
compression options. After the file has been saved, statistics about the actual data
rate will be displayed. Use this information to adjust parameters as necessary.

USING SOUND FORGE TO CREATE 
MICROSOFT NETSHOW F ILES
This tutorial shows how to create Advanced Streaming Format (ASF) files using
Sound Forge. ASF is a multimedia file format used for streaming information
across the Internet using Microsoft NetShow. With ASF files, you can deliver
multimedia content, audio or video, open Web pages, or deliver scripting
commands to the client computer.

Sound Forge includes support for saving WAV and AVI files, as well as their
associated markers and script commands, in an ASF file. ASF files can be played
off of your local drive, streamed off of an HTTP server, or optimally stored and
streamed off of a NetShow server.

NETSHOW REQUIREMENTS
In order to play ASF files, you must install the Microsoft NetShow Player and Tools.
These components install all of the necessary audio and video codecs for saving
ASF files. Both of these components are available on the Sound Forge CD-ROM
and can also be downloaded free of charge from the NetShow web page at
www.microsoft.com/netshow.

To install the NetShow Player, select Microsoft NetShow Player from the list in the
main setup program on the Sound Forge XP CD-ROM. This will run
Microsoft’s setup program for the player.
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To install the ASF authoring and conversion tools, select Microsoft NetShow Tools
from the list in the main setup program on the Sound Forge XP CD-ROM.This
will run Microsoft’s setup program for the NetShow Tools.

Further documentation for this software is available on the NetShow web page.
At this time, the components shipped on the Sound Forge CD-ROM are for the
x86 and Pentium platforms only. See Microsoft’s web page for availability of
components for other platforms.

USING THE BUILT- IN TEMPLATES
Sound Forge contains a number of built-in templates for saving AVI or WAV
files as ASF files. These templates have been designed by Microsoft to be
optimized for certain bandwidths.To use these templates, follow these steps:

1. Open Sample1.avi from the Tutorial Files\NetShow folder on the Sound
Forge CD-ROM. This file is a short video clip that uses the Intel Indeo
Interactive VCM video codec installed with the NetShow Player. The Intel
codec is well-suited for mid to high bit-rate video. The audio track in this
file is PCM.

2. Click on the File menu, followed by the Save As option.

3. Select Advanced Streaming Format from the Save as type drop-down list.

4. Click the Save button. The NetShow Settings dialog appears.

5. A high bit rate ASF file can be created from this file by simply choosing a
built-in template. The numbers preceeding the names of the templates
indicate the target bandwidth for the ASF file. Higher numbers require
wider bandwidth conncetions.

For this file, choose the 100 Presentation Video template from the Template list.
This template is designed for a Dual ISDN connection and a “talking head”-
type video like Sample1.avi.

5. Click the Save button, and the AVI is saved.



CREATING CUSTOM TEMPLATES
Custom templates can also be created in the NetShow Settings dialog and saved for
future use.To create a custom template, follow these steps:

1. Follow steps 1-4 in the section above.

2. Click the Custom button.The NetShow Encoder Template wizard starts and guides
you through the template creation process.

3. Type the name of your custom template in the Template Name field.

4. Click the Next button to continue.

5. Select the desired bandwidth for the output file.The bandwidth selected in
this step determines what compression options are available in the next
step.You can enter a custom bandwidth in bits per second by selecting the
Custom option.

A bandwidth selection of 14.4 will not allow you to save a video stream
due to the amount of bandwith required for video.

6. Choose the audio and video codecs you wish to use.

7. Click the Finish button. Each audio codec will have a set of Formats that are
available, depending on the bandwidth that was selected in the previous
dialog.

Microsoft provides a free Content Creation Guide on their web site at
www.microsoft.com/netshow. This guide is a great resource for
understanding which codecs work best in certain situations.
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ADDING MARKERS AND SCR IPT COMMANDS
Sound Forge can embed markers in ASF files. These markers can be used for
navigation in the file or for triggering events or custom script commands.

ADDING NAVIGATION MARKERS

Open Sample1.avi from the Tutorial Files\NetShow folder on the Sound Forge
XP CD-ROM if you haven’t already done so. If you want viewers to have the
ability to jump to certain parts of the ASF file, you will want to add markers
in the source file. To learn how to add markers, follow these steps:

1. Find the part of the AVI file where John says, “No, not gonna do that.”

2. Place the cursor right before that point and press the <M> key on your
keyboard.The Edit Marker/Region displays.

3. Type “No, not gonna do that” in the Name field.

4. Click the OK button.You now have a named marker in the file.

5. Click on File menu, followed by the Save As option.

6. Select the Advanced Streaming Format option from the Save as type drop-
down list.

7. Click the Save button. The NetShow Services Settings dialog displays.

8. Choose the 100 Presentation Video template from the Template list.

9. Make sure that the Use markers in source file checkbox is checked.

10. Click on the Save button.

11. When the file is done saving, click the Yes button to open the ASF file. If you
look just above the copyright information part of the NetShow Player
window, there is a drop-down list that contains all of the markers that have
been saved in the file.The marker you just added should now appear in that
list.

12. Select your marker from the list, and click the Play button. Playback should
now start from that point in the ASF file.



ADDING SCR IPT COMMANDS

Markers are also used to store script commands that are embedded in the ASF
file. The most popular of these is the URL flip. This command causes the
opened web browser to open specified pages as the ASF file reaches certain
points in the file.

Sound Forge has a special function to automatically add certain script
commands, but regular markers work just as well. Using the built-in function
simply saves you from remembering the syntax for basic commands. To learn
how to store script commands in a marker, follow these steps:

1. Open Sample1.avi again.

2. Put the cursor close to the beginning of the file, and choose ASF
Marker/Command|Add from the Special menu. Notice that the name of the
new marker has already been filled in with the correct syntax for a URL flip
(http://). After “http://”, type the following: www.sonicfoundry.com/
SoundForge.

3. Click the OK button. A new marker is inserted into the file.

4. Click on File menu, followed by the Save As option.

5. Select the Advanced Streaming Format option from the Save as type drop-
down list.

6. Click the Save button. The NetShow Services Settings dialog displays.

7. Choose the 100 Presentation Video template from the Template list.

8. Make sure that the Use script commands in source file checkbox is checked.

9. Click on the Save button.

10. After the file is saved, choose Yes to listen to the file in the NetShow Player.
As the file is played, you will notice that your default web browser has been
opened and the Sound Forge page of the Sonic Foundry web site has been
loaded.

If you aren’t already connected to the internet, the time it takes to
connect will, of course, throw off the timing of the URL flip. Ideally, the
viewer of the ASF file will already be online and the URL flip will be
more accurate.
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SAMPLE HTML USING AN ASF F I LE
We have included an example HTML file on the Sound Forge XP CD-ROM,
showing how to use the NetShow ActiveX control to add an ASF file to a web
page. You can find the example in the \SAMPLES\NETSHOW folder on the
CD-ROM.

The HTML sample requires Microsoft Internet Explorer v3.0 or better.

Follow these steps to use this example:

1. Copy SAMPLE.HTM to the folder on your hard drive that contains the ASF
file you wish to use.

2. Modify the FILENAME parameter within the NSOPlay object to reference
your local ASF file (a fully qualified path is required).

3. Open the edited SAMPLE.HTM file within your browser.

4. Continue with the additional instructions listed on the example page.

CONVERTING A H IGH B IT-RATE AVI  F I LE TO ASF FORMAT
This section of the tutorial demonstrates how you can create high bit-rate
video content and convert it to ASF. SAMPLE1.AVI is a short video clip that uses
the Intel Indeo Interactive VCM video codec installed with the NetShow Player.
The Intel codec is well suited for mid to high bit-rate video. The audio track
in this file is PCM format.

1. From the File menu, open SAMPLE1.AVI from the \SAMPLES\NETSHOW
folder on the Sound Forge XP CD-ROM. From the File menu select Properties.
Select the Format page and set the audio Sample Size to 16 bits. Make sure that
Channels is set to mono. Select OK.

Note that editing and playback performance of an AVI file will suffer
greatly unless you first copy it to your hard drive. It is strongly
recommended that you always copy AVI files that you are editing onto
your hard disk.

N O T E
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2. From the Process menu select the Resample command. The Resample dialog
will appear. Set the new sample rate to 8,000 Hz and select OK.

3. From the Process menu select the Normalize command and select OK.

4. Now convert the edited AVI file to an ASF file by saving it on your hard
drive. Select the Save As command from the File menu. Select Active Streaming
Format (*.asf) from the Save as type drop-down list.

5. The NetShow Player installs the Lernout & Hauspie CELP 4.8kbit/s ACM
codec (see previous section), which is excellent for low bit-rate voice
audio. Select this codec from the Format drop-down list. Select Save. (Note
that it is not a requirement of ASF to convert the audio from PCM. We
perform the conversion as part of this tutorial to demonstrate how to take
advantage of the installed codecs.)

6. The ASF Save Options dialog presents the settings for the Active Streaming
Format file. Select OK to select all the default settings.

7. Next, the Video Save Options dialog appears. It allows you to view the audio
and video properties of the AVI file. Select OK.

8. The Compression Options dialog presents the available video compression
options. Press OK to select the Indeo codec.

9. When the ASF file has been created Sound Forge XP will prompt you to play
it. Select Yes. This will start the NetShow Player.
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10. From the File menu in the NetShow Player select Properties. Note the
following Properties pages:

The General page contains the general information contained within the
AVI file.

The Details page shows that the ASF file has a bit-rate of 875,000 bps.

The Codecs page displays information about the codecs being used with
the file.

AUTHORING A LOW B IT-RATE ASF F I LE
This section of the tutorial creates a low bit-rate video suitable for playback on
the Internet at 28.8 Kbps. SAMPLE2.AVI is a smaller version of SAMPLE1.AVI.
It uses the Intel Indeo Interactive codec and has been re-sized to 160 x 120 at
6 frames per second with one key frame every 36 frames. The VDOnet
VDOWave codec and the Intel Indeo Interactive codec require that the video
frame size be a multiple of 16 (i.e., 160 x 120, 320 x 240, etc.).The audio track
in this file is PCM.The steps below describe how to use the VDOnet VDOWave
video codec, which is an exceptional codec for low bit-rate content.

1. From the File menu, open SAMPLE2.AVI from the \SAMPLES\NETSHOW
folder on the Sound Forge XP CD-ROM. You will be prompted with a
message from Sound Forge XP asking if you want to disable the video strip.
Select No.

2. Note that editing and playback performance of an AVI file will suffer greatly
unless you first copy it to your hard drive. It is strongly recommended that
you always copy AVI files that you are editing onto your hard disk.

3. From the File menu select Properties. Select the Format page and set the audio
Sample Size to 16 bits and verify that Channels is set to mono. Select OK.

4. From the Process menu select the Resample command. In the Resample dialog,
set the New Sample Rate to 8,000 and select OK.

5. From the Process menu select the Normalize command and select OK.



6. Now add Markers and ASF Script Commands. From the Special menu select
Region List/Add. Add the following three Markers:

Type Name Time

Marker ASF CAPTION:John is here to… 00:00:01.000

Marker This is the middle of my ASF 00:00:09.000

Marker ASF CAPTION:John is not here… 00:00:10.000

7. Note that you can drag and drop the markers along the time line once they
have been created and during playback. Markers that start with the preface
ASF are processed as stored as script commands within the ASF file. For
more information, see Sound Forge XP online Help.

8. Now save the edited AVI file to an ASF file. Select the Save As command from
the File menu. In the Save As dialog, Select Active Streaming Format (.asf) from
the Save as type drop-down list.

9. The NetShow Player installs the Lernout and Hauspie CELP 4.8kbit/s ACM
codec, which is excellent for low bit-rate voice oriented audio. Select this
codec from the Format drop-down list. Select Save.The ASF Save Options dialog
presents the settings for the ASF file.

10.Set the Maximum Lead Time setting to 5,000 and select OK. Note that 5,000 is
the lead time setting that should be use when authoring low bit-rate video
ASF files.

11. Select OK to close the Video Save Options dialog.

12. The Compression Options dialog presents the available video compression
options. Select the Options button, and in the Video Compression dialog select
the VDOnet VDOWave codec from the Compressor drop-down list.

13. Select the Configure button to bring up the Encoder Configuration dialog. This
dialog allows you to set the specific bit-rate for the video stream. Drag the
slider to the left until it is at the 14 Kbit/sec setting. Select OK.
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14. Back at the Video Compression dialog verify that the check box next to the Key
Frame Every field is enabled and set the Frames edit field to 60. This will set a
key frame every 10 frames. It is necessary to reduce the number of key
frames to attain the desired low bit-rate. Select OK.

15. Back in the Compression Options dialog verify that the Interleave Every check box
is clear. Select OK to start building the ASF file.

When the ASF file has been created Sound Forge XP will prompt you to play
it. Select Yes. This will start the NetShow Player.

16.From the File menu in the NetShow Player select Properties. Note the
following Properties pages:

The Details page shows that the ASF file has a bit-rate of 19,332 bps. Achieving
the exact bit-rate for a video stream will vary depending on the content.
Complex video may require fewer frames per second or less frequent key
frames. Frame rate, key frames, and video frame size are all variables that affect
bit-rate.

The Codecs page displays information about the codecs being used with the file.

ADDING AN ASF F I LE TO A WEB PAGE
On the Sound Forge XP CD-ROM in the \SAMPLES\NETSHOW folder there is
an HTML file containing an example of how to use the NetShow Active
Control to add an ASF file to a web page.This sample will be used with the low
bit-rate video ASF file, SAMPLE2.ASF. Note that the HTML sample requires
Microsoft Internet Explorer v3.0 or better.

1. Copy SAMPLE.HTM to the folder on your hard drive that contains
SAMPLE2.ASF.

2. Modify the FILENAME parameter within the NSOPlay object to reference
your local SAMPLE2.ASF file (a fully qualified path is required).

3. Open the edited SAMPLE.HTM file within your browser. There are
additional instructions on the sample page.



CALCULATING APPROPRIATE B IT-RATES FOR THE INTERNET 
When authoring Internet file formats, it is important that the content not
exceed the bit-rates of your targeted modem connection. The reason is that
modem connections to the Internet are often less than 14.4 Kbps or 28.8 Kbps.
It is important not to consume all the bandwidth available to the browser,
control protocols, etc.The following guidelines suggest a combined (audio and
video) bit-rate with error corrections slightly below the targeted Internet
connection:

Internet Connection Authored Bit-Rate Total Bit-Rate 
(audio + video) with Error Correction

28.8 Kbps 18,500 bps 20,813 bps

14.4 Kbps 10,000 bps 11,250 bps

For example, in the Authoring a Low Bit-Rate File section above, the audio was set
to 4.8 Kbps and the video was set to 14 Kbps. With the addition of error
correction to the stream, the total ASF file bandwidth as displayed in the
NetShow Player is 19,332 bps.

WHAT DO I  DO WITH MY ASF F I LES?
ASF files are specifically designed for network streaming and are authored for
specific network bandwidths. For network streaming,ASF files can be stored on
an HTTP server or optimally off of a Microsoft NetShow server.The NetShow
Player can play back ASF content as an embedded Active control within an OCX
container such as Microsoft Internet Explorer 3.0 or Microsoft Visual Basic.The
NetShow Player can also run in standalone mode, such as when an ASF file is
launched as a link within any Internet browser.ASX files (ASF Redirector Files)
are meta files that pass the ASF file link from the browser to the NetShow
Player so it can start streaming.

For more information, see the NetShow web site. The entire Microsoft
NetShow product can be downloaded free of charge from http://
www.microsoft.com/netshow.
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CHAPTER 5:
RECORDING AND 
SOUND PROCESSING
In this chapter, you will be introduced to the recording functions of Sound
Forge XP and how to work with processes and effects. The chapter is divided
into three sections:

• Recording

• Applying Sound Processing Functions

• Sound Processing Techniques

RECORDING
Sound Forge XP has a variety of sound recording modes and options. Each one
has features designed for specific recording situations.These include recording
new data, recording over existing data commonly known as Punch-In
mode and Remote Recording.This section will cover:

• Recording to a New Window

• Selecting an Alternate Record Window

• Available Recording Time 

• Record Meters

• Previewing Recorded Sounds

• Using the Prepare button

• Recording Modes

• Changing the Start Position

• Recording Status

• Finishing Recording

• Remote Recording



To start a record session you can either select Transport then Record from the
Special menu or press the Record button on the Transport toolbar (the first toolbar
button).

If you experience problems recording, refer to Appendix B,
Troubleshooting for information on common recording problems.

After pressing the Record button or selecting Transport/Record from the Special
menu, the Record dialog appears. Notice that the window into which you will
be recording has its title displayed in the dialog title.

The Record and Record Remote dialogs are always destructive and
contain no Undo capabilities.

To prevent accidentally recording over sound data, record into a new or scratch
data window and paste the takes you want into the desired sound data window.
For extra safety Sound Forge XP automatically defaults to record in a new
window when the current sound file is opened in direct edit mode.
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In the upper left corner of the dialog are the Recording attributes. These are the
sample rate, sample size, and number of channels that will be used when
recording.These attributes are applied to the data window into which you will
be recording. If you want to change these attributes, exit the Record dialog and
change them in the data window (using the Status Bar shortcut menus), record
to a new window, or record to a different existing window.
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RECORDING TO A NEW WINDOW
If you want to record to a new window rather than the currently selected
record window, select the New button at the upper right of the Record dialog.
This brings up the New Window dialog where you can specify the Sample rate,
Sample size, and Channels for the new data window. These attributes will be
applied while recording.

SELECTING AN ALTERNATE RECORD WINDOW
If you wish to record to a specific data window other than the one currently
displayed in the Record dialog title, you can do so by selecting the Window
button. Pick the window you want to record to from the drop-down list in the
Record Window dialog and select OK.The title of the window you select will now
appear in the Record dialog title.
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AVAILABLE RECORDING TIME
Near the bottom of the Record dialog you will see the Time recorded and Time left
on drive fields. These two boxes show how much time you have recorded and
how much time is available on your hard drive for additional recording. If
your Time left on drive field shows a limited amount of available time, you may
want to free up some space on your hard drive or pick an alternate drive
where Sound Forge XP stores its temporary files. You can get more
information on temporary file usage by referring to the Temporary Storage
section in chapter 6, Sound Forge XP Reference.

RECORD METERS
The Record Meters can be scaled to view differing dynamic ranges by right-
clicking on the meters and selecting the appropriate range from the shortcut
menu. For most recording situations it is probably best to select -42 to 0 dB,
as this is the most practical range to view a good record signal. To view very
low levels, select -90 to 0 dB. This is a good way to measure the amount of
noise you have in your system due to noisy sound sources and/or poor
equipment (such as an inexpensive sound card).

Also in this shortcut menu, you can set the meters to Hold Peaks and Hold Valleys.
A good way to view the peak levels while setting the record level is to select
Hold Peaks (see Adjusting Levels Using the Peak below). To reset the current peak,
single-click on the meter’s text output (just above the meters).

CHECKING RECORD LEVELS
Sound Forge XP allows you to check the level of your input source before
recording begins.To view your levels, select the Monitor check box.The meters
will light up in relation to the level of the incoming signal. For best results,
the input level should be somewhere in the yellow range with an occasional
red. Once your levels are checked you can immediately begin recording by
selecting the Record button. If you do not see the meters light up, you may have
your mixer levels or input source set incorrectly. (For more information, refer
to Appendix B, Troubleshooting.)
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ADJUSTING LEVELS USING THE PEAK 
The peak values displayed above the level meters are useful for maximizing
your input level without distortion.When recording, you generally want your
input signal to be as ‘hot’ as possible without clipping. This means you want
your input levels to be as high as possible without exceeding the range of
values that can be stored digitally when recording.When you clip, the peaks of
your waveform become clipped off resulting in distortion. The peak values
show you (in decibels) the highest peak that you have reached after selecting
the Monitor check box.

To adjust your levels, select the Monitor check box so that Sound Forge XP begins
to listen to your recording device.This is just like recording except that Sound
Forge XP doesn’t store any of the data it receives. Apply an input signal by
speaking into the microphone, playing your CD, or whatever it is you’re trying
to record. If the peak value stays at a low value, increase the levels of sound you
are supplying so that the peak value is somewhere in the -6 dB range. If the
peak reaches 0 dB, then you have clipped the waveform and will see the word
Clip above each meter. Once you lower your input levels, right-click on the
meters and select Reset to clear the current peak value. Sound Forge XP always
keeps the maximum peak displayed above the meters or via Hold Peaks.

Once you have adjusted your levels you can immediately begin recording by
selecting the Record button or end monitoring the levels by clearing the Monitor
check box.

It is particularly important to record sounds with the hottest levels
possible when you plan to later convert 16-bit data to 8-bit.This assures
that you will use the greatest dynamic range possible in an 8-bit file
(which uses fewer values to represent the waveform).

PREVIEWING RECORDED SOUNDS
After recording your material, you can listen to what you have recorded by
selecting the Play button in the Record dialog. To stop playback, select the Stop
button at any time.

R E C O R D I N G
1 0 8

N O T E



R E C O R D I N G
1 0 9

USING THE PREPARE BUTTON
The Prepare button is used when you need Sound Forge XP to begin recording
as soon as possible after selecting the Record button.The Prepare button opens the
wave device and loads all recording buffers in order to minimize the time
between selecting the Record button and the time the sound actually begins
recording.

Using the Prepare button is optional.However, selecting this button prior
to recording allows for more accurate takes in the Punch-In mode.

RECORDING MODES
Sound Forge XP has three modes of recording, which are selected from the
Mode drop-down list in the Record dialog.These are Automatic Retake (automatically
rewind), Multiple Takes, and Punch-In (record a specific length). Each mode is described
below.

AUTOMATIC RETAKE (AUTOMATICALLY REWIND)
The Automatic Retake mode is the easiest method of recording. Recording starts
at the position shown in the Start field when you select the Record button and
continues until you select the Stop button. Any data that is currently after the
position in the Start field will be replaced.When recording is stopped, the start
position is reset to the beginning of the take allowing an immediate review and
retake if desired.

Automatic Retake is the default mode when recording into an empty data
window or when you select the Record button with no data selected in the
current data window.
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MULTIPLE TAKES 
The Multiple takes mode allows you to record multiple takes. Recording starts at
the position shown in the Start field when you select the Record button, and
continues until you select the Stop button.Any data, which is currently after the
position in the Start field, will be replaced. When recording is stopped, the
start position remains at the end of the take allowing the next take to be
recorded immediately.

PUNCH-IN (RECORD A SPECIF IC LENGTH)
Punch-In mode is used when you want to record over a region of data in an
existing data window. Recording starts at the position shown in the Start field
when you select the Record button and continues until you select the Stop
button, or the length of the data recorded is equal to the length in the Length
field.This makes it easy to record over a section of audio without affecting the
rest of the file.You can use the Play button to hear the selected punch-in region
at any time.

You can adjust the punch-in region by changing the values in the Start, End, or
Length edit fields.You may also adjust the format of these fields to a variety of
different display status formats by selecting a format from the Input format drop-
down list.

Punch-In mode is the default mode when you select the Record option while you
have a region of data selected in the current data window.

USING PRE/POST-ROLL WITH PUNCH-IN MODE

At the bottom of the Record dialog are two edit fields which contain the pre-
roll and post-roll times.These can be used when listening to a section of sound
data in Punch-In mode. These times define the amount of audio you will hear
prior to (pre-roll), and just after (post-roll) playing the selected section. This
allows you to hear the transitions between the punch-in section and sound
before and after the section. Click on the check box at the bottom of the dialog
if you want to use the Review pre-/post-roll option. To disable pre-/post-roll, clear
this box.
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CHANGING THE START POSITION
The Start position determines where playback or recording begins from the
time you press the Play or Record button. Four button controls − Go to Start,
Rewind, Forward, and Go to End − allow you to quickly change the Start position.

Although potentially confusing at first, these controls are convenient when
you’re doing multiple recordings.The Go to Start and Go to End buttons move the
Start position to the beginning or end of the file to which you are recording.
After you’ve recorded a take, the Rewind and Forward buttons move the Start
position to the start or end of the take.

For example, to listen to the entire file, press Go to Start before pressing the Play
button. Likewise, to start recording at the end of the file, press Go to End before
selecting the Record button. If you wish to start playback or recording at a
specific point, press the Go To button and enter the desired Start position.

RECORDING STATUS
While you are recording, the amount of Time Recorded will increase and the Time
left on drive will decrease. Make sure to keep an eye on your Time left on drive if the
available record time is limited. It’s never fun to run out of recording time!

F IN ISHING RECORDING
When you have finished recording, select the Close button to exit the Record
dialog and return to normal editing mode.



REMOTE RECORDING
By selecting the Remote button you enter Remote Recording mode. Remote Recording
mode hides the main Sound Forge XP window and puts up the small Record
Remote dialog which always stays as the top-most window.

The Remote dialog is a fully functional but condensed version of the regular
Record dialog. It’s particularly useful when using applications that control your
input sources, sound levels, or CD audio. To return to normal record mode
from the Remote dialog select the Back button.

You can access all of the same Record dialog features from the Remote
Record dialog (right-click on the title bar).
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APPLYING SOUND PROCESSING FUNCTIONS
The Effects, Process, and Tools menus contain a variety of functions you can use
to apply an effect to the sound data, display information, or even synthesize
new sounds. Each function is documented in detail in chapter 6, Sound Forge XP
Reference. In this section, you will see examples of a few of the functions to help
you become accustomed to using them.

You will learn about:

• Applying Simple Processes and Effects

• Applying Functions to Stereo Files

• Using Sound Processing Controls

• Processing Shortcuts

APPLYING SIMPLE PROCESSES AND EFFECTS

APPLYING AN EFFECT TO THE ENTIRE SOUND F ILE
To apply an effect, first select a section of data on which you wish to operate.
To select the entire file, double-click on the waveform display.

If you don’t have a selection when you perform an effect that requires
one, Sound Forge XP will apply the effect to the entire file.

To show how effects are used:

1. Open the TUTOR1.WAV file.

2. Select Reverse from the Process menu.The Reverse operation reverses the data
selection, making it sound like it’s playing backwards.

3. Once the operation has finished, press the Play button to hear how TUTOR1
sounds when played backwards.

N O T E



APPLYING AN EFFECT TO A SECTION OF THE SOUND F ILE
To apply an effect to a selection:

1. Select Undo Reverse from the Edit menu to put TUTOR1 back to its original
state.

2. Select (highlight) only the word “Wow” in the data window.

3. Select Reverse in the Process menu. Play the file again and notice how only
the word “Wow” is played backwards.

After you have listened to the effect, undo Reverse again so you can try another
effect.

1. Again, select only the word “Wow” in the TUTOR1 window.

2. Select Volume in the Process menu. Use the scale factor fader to set the
scaling to -6 dB (50%). Clicking on the fader to move the fader box will
give you more precision. Now select OK.

3. Press Play. You will notice that the volume is now at half of its original
volume. You can undo the last operation by selecting Undo from the Edit
menu.

The previous two examples show how easily effects are applied to files. Sound
Forge XP has a large number of different processes and effects, ranging from
simple volume changes to complex reverb/delays. To learn more about a
particular effect refer to the below section, Sound Processing Techniques and the
Effects, Process, or Tools menus covered in chapter 6, Sound Forge XP Reference.

CANCELING A FUNCTION IN PROGRESS
While applying an effect, the progress meter at the lower left-hand side of the
main screen shows what percentage of a selection has been processed while
running a function.You can select the Cancel button to stop processing the file.
When you cancel an operation in progress, the affected data remains in the
sound file. Undoing the operation will return the file to its original state.
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APPLYING FUNCTIONS TO STEREO F ILES
In a stereo file, only the selected region in the channel that you’ve selected is
processed. Most functions can be applied to the left, right, or both channels.
The only functions that cannot be applied to separate left and right channels
are functions affecting the length of the data, since each track in a stereo file
must be of the same length. These include Insert Silence, Resample, Time
Compress/Expand, and Pitch Bend.

If you need to run a process like Insert Silence in only one channel, you should
divide the stereo file into two mono files first, insert the silence, and then join
them back together into a stereo file. Separating stereo files into two mono
files is a good idea if you are going to be changing the duration of each track
by cutting or inserting space to synchronize different events.

APPLYING A FUNCTION TO A SINGLE CHANNEL 
IN A STEREO F ILE
In the previous exercises, you reversed TUTOR1 to hear how the data sounded
when played backward.

To reverse a single channel of a stereo file:

1. Convert TUTOR1 to stereo by right-clicking on the status field that has the
word Mono and select Stereo from the shortcut menu. Make sure to select
the Both Channels option so that data will appear in both channels of the new
stereo file.

2. Select the entire left channel by double-clicking (or triple-clicking if the
file includes markers) in the upper quarter of the TUTOR1 waveform
display. If you accidentally select both channels, use the Tab key to toggle the
selection to only one channel.

3. Now select Reverse from the Process menu.You will notice that only the left
channel data is reversed.

4. Press the Go to Start button on the playbar to clear the selection and place the
cursor at the start of the file. Press the Play button and you will hear the
audio backward in the left channel and forward in the right channel. If you
only hear one channel then you are in single channel preview mode.To hear
both channels use the Tab key to toggle the cursor or selection to encompass
both channels and again press the Play button.



If you want more information on how to use a function, press the F1 key
while selecting the function title in the menus.Also, you can press the F1
key or the Help button in all function dialogs.

USING SOUND PROCESSING CONTROLS
Before learning more about applying specific sound processing techniques, it
would be helpful first to become familiar with Sound Forge XP’s processing
controls. These controls are simple tools like buttons and sliders that you
manipulate with the mouse.You use them to provide additional information
for sound processing functions and other commands. The following sections
introduce these controls.

VERTICAL FADER AND HORIZONTAL TRACKBARS
To see examples of these common controls, open the Dynamics dialog. Choose
Dynamics from the Effects menu.

In this dialog, the fader controls the Threshold level and the trackbar adjusts the
Ratio.To change the parameter values, just left-click the box (or “thumb”) that
slides along the fader or trackbar. Drag left and right or up and down to
increase or decrease the value.
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You can fine tune a control’s value by holding down both the left and
right mouse buttons at the same time (or holding down Control on the
keyboard) 

There are many keyboard shortcuts for use with faders and trackbars.You can
use the Up,Down,Left and Right arrow keys to change the value in small increments
or the Page Up and Page Down keys to change the value in larger increments.The
Home and End keys change the parameter value to its maximum or minimum.

If you double-click on a fader or trackbar thumb, it returns to its reset value
(usually 0%, 50%, or 100%). Left-clicking on the hash marks in a fader also
changes the value by very small increments.

EDIT BOX SP INNER CONTROL

In the Dynamics dialog the Attack time and Release time parameters are modified
with edit box spinner controls. The edit box is the box containing text, while
the spinner is the small control to the right.With this type of control, you have
several options for changing a parameter value.You can:

• Type in the number by left-clicking on the edit box and then typing in the
value.

• Increment the value by clicking on the two small up/down buttons.

• Use the spinner to change the value. This is done by left-clicking on the
center button (between the two up/down buttons) and dragging the mouse
up or down. Again, holding down both the left and right mouse buttons at
the same time will cause the values to increment in finer steps.You can also
use the Up/Down arrow keys and Page Up/Page Down keys to alter the value.

• Adjust the spinner while holding down both mouse buttons to see the finer
increment resolution (or hold down the Control key).

N O T E



DROP-DOWN LIST
For an example of this control, display the Pitch Bend dialog. Choose Pitch Bend
from the Effects menu.

To select an item from a drop-down list, click on the drop-down list and select
(highlight) the item. If you have to scroll through a large list, click on the scroll
buttons or use the arrow keys. The Pitch Bend dialog uses a drop-down list to
select the channels of a stereo source.

PUSH BUTTON

To use a push button, left-click on it or press the Spacebar while it is selected.
In the Pitch Bend dialog, the OK, Cancel, Help, and Reset Envelope controls are push
buttons.
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CHECK BOX

A check box, as its name implies, is a square box you can check or leave blank.
They are used to turn a feature on or off.The Create Undo and Show Wave controls
on the Pitch Bend dialog are check boxes.

ENVELOPE GRAPH

Envelope graphs are used to draw the shape of a frequency or amplitude
envelope that will be applied. The horizontal axis represents time, with the
left-most point specifying the start of the selection and the right-most point
specifying the end of the selection. The vertical axis represents either
amplitude or frequency.

To create a new knob on the graph, left-click anywhere on the line connecting
the envelope points and drag the knob in any direction, like pulling a rubber
band.

You can delete a knob by double-clicking or right-clicking within it.

To reset the graph (delete all knobs) click on the Reset Envelope button.



MOVING MULTIPLE ENVELOPE POINTS

To select and move more than one envelope point at once:

1. Click on an unused section of the Envelope Graph in the Pitch Bend dialog.

2. While holding the mouse button down, drag the mouse. A dotted-line
selection square will appear.

3. Move the mouse to surround the points to move with the selection square.

4. Release the mouse button.The selected points will now be colored red.

5. To move all of the selected points, drag any one of the points.

You can also select all points by pressing Control+A when the Envelope Graph is
active.

DISPLAYING THE WAVEFORM ON AN ENVELOPE GRAPH

Some envelope graphs (such as in the Graphic Fade or the Pitch Bend dialogs) allow
you to view the waveform of the selected data region on the graph. If the
selection is small, the waveform is automatically displayed. Otherwise, you
must select the Show wave check box. If you have a stereo file, you can choose
between displaying the Left channel only, Right channel only, or Mix channels in the
drop-down list.

RADIO BUTTON
Radio buttons always come in groups of two or more. For examples of radio
buttons, display the Chorus dialog from the Effects menu.

Radio buttons are like the radio station selector in a car radio; turn one on and
the rest turn off. For example, the radio buttons on the Chorus dialog let you
choose Light, Heavy, Vibrato, Reverberant or Echo-vibrato.
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PROCESSING SHORTCUTS

REPEATING AN OPERATION
In some situations, you may want to perform the same operation twice. For
example, you might want to add reverb to one section of a file and then do the
same thing with another section. Sound Forge XP has two techniques for
quickly repeating an operation.

The first is known as shift-clicking. As the name implies, you hold down the Shift
key before you click a button or choose a menu option. This technique
bypasses the dialog of options that often appears when you start to perform a
task. Instead of displaying the dialog, Sound Forge XP immediately performs
the operation using the same parameters you specified last time. Shift-clicking
works for most operations in Sound Forge XP.

You can also use Repeat (Control+Y) under the Edit menu to quickly repeat the
last operation.This works for all Process, Effects, and Tools functions in Sound
Forge XP. Holding down the Shift key while selecting Repeat takes you to the last
function’s dialog.

SOUND PROCESSING TECHNIQUES
This section covers some basic concepts relating to several of the Sound Forge
XP processing functions used for modifying (or creating) sound. Detailed
information about each effect is also available in chapter 6, Sound Forge XP
Reference.

You will learn about:

• Delay/Echo

• Reverb 

• Chorus

• Flange 

• Dynamics

• Changing Time Duration

• Synthesis

• Filtering



DELAY/ECHO
The Delay/Echo effect creates copies of the original sound, which are then
mixed with the sound file to create simple echo effects.

To apply Delay/Echo:

1. Open TUTOR1.WAV. Select Delay/Echo from the Effects menu. The Simple
Delay/Echo dialog will appear.

2. Enter 0.4 in the Delay time field and click OK. When you play the sound, you
hear a second copy 0.4 seconds after the original.The Delay time determines
the time between the original and echoed sound.

3. Check the Multiple delays/echoes box if you want an echo effect that contains
more than a single copy of the original sound. The Decay time determines
how long it takes for these echoes to fade out.

4. The Pre-delay/echo box creates echoes heard before the original sound. Use
this effect while the spaceship in your next sci-fi flick travels back in time
by means of a wormhole.
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REVERB
The Reverb function is used to simulate the acoustics of different environments.
When a sound is generated inside a room, you first hear the original sound,
followed by a quick succession of echoes.These echoes are the early reflections.
Then, as the echoes accumulate, you hear thousands of echoes combined into
a smoothly decaying reverberation.

To apply Reverb:

1. Open TUTOR1.WAV. Select Reverb from the Effects menu. The Reverb dialog
will appear.

2. Select the Bright hall button, click OK, and play the sound. Notice how the
imagined space where the recording took place changes from a small studio
to a large, rich hall.



CHORUS
The Chorus function is used to simulate multiple sound sources from a single
sound.This is achieved by mixing a delayed, pitch-modulated copy of itself to
the sound source.

To apply the Chorus effect:

1. Open TUTOR1.WAV. Select Chorus from the Effects menu. The Chorus dialog
will appear.

2. The buttons on the Chorus dialog provide variations on the chorus effect. For
an introduction to this feature, select the Vibrato option. Click OK and play
the sound, which has a richer, fuller quality than the original.

FLANGE
The Flange function is used to create the sweeping effects often heard in 60’s
guitar recordings and techno-sounds of today.

To hear what flanging sounds like:

1. Open TUTOR1.WAV. Select Flange from the Effects menu. The Flange dialog
will appear.
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2. The buttons on the dialog offer three flanging speeds and two warbling
effects. For a good example of flanging, choose the Fast option, click OK, and
play the sound.

DYNAMICS
Dynamics processing is used to change volume levels within a sound file.
Applying dynamics specifically adjusts the lower levels and higher levels in the
file to create more of a dynamic range, less of a dynamic range, or to keep the
amplitude of a file within a certain range.

NOISE GATING
When recording a sound, there is often an audible noise floor during silent
breaks. Noise is generated by many different things, including electrical
equipment, machinery, and traffic outside your window. When your sound
source is much louder than this background noise, it is simple to remove the
noise during silent breaks, where the noise is most noticeable, with a noise gate.

To apply a Noise Gate:

1. Open TUTOR1.WAV.

2. Move the cursor to a location between “Wow” and “Sound” and select Insert
Silence from the Process menu. In this dialog, insert one second of silence at
the cursor. Select OK. If the file’s status format is not set to a time format,
you will need to change this first before inserting silence in seconds. Close
the dialog and change the status format of the file by right-clicking on the
Selection Status Fields and selecting Seconds from the pull-down menu.

3. After inserting silence, create a new file (New/File menu). In the new file,
use Synthesis (Tools menu) to generate four seconds of noise at -60 dB
amplitude. Choose Noise from the Waveform shape list, enter 2,000 in the
Frequency field, and drag the Amplitude slider until the value is approximately
-60.

4. Next, copy all of the noise onto the clipboard and mix it to the beginning
of TUTOR1. To mix, choose Paste Special from the Edit menu and select the
Mix option. Use 100% for the noise (Source) and 100% for the voice
(Destination). You should now have a file with voice and a relatively low
hissing sound in the background.



5. To remove the noise during silent breaks, first analyze the amplitude of the
noise. In TUTOR1, select a region with only noise (no voice), and run the
Statistics function under the Tools menu.Take note of the Maximum sample value
percentage. If you followed the preceding steps, it should be close to -60 dB.

6. Next, select Noise Gate from the Effects menu. The Noise Gate dialog will
appear.

7. In the Noise Gate dialog, slide the threshold level to a bit over the Maximum
sample value (in percentage). A value of -50 dB should be high enough to
differentiate the noise from the vocals. Press OK. Notice that the noise
during the silent regions should have disappeared (total attenuation). If it
didn’t, try raising the Threshold level until it does.

8. The other two parameters in the Noise Gate determine how fast the gate will
open and close. This will affect how the beginning and end of the sound
will fade in and out. If the Attack time is too slow, the beginning of the vocals
might get cut off. Likewise, if the Release time is too fast, the end of the vocals
will be cut. Experiment with these times until you can remove as much
noise as possible without removing any of the voice.
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COMPRESSION
Compressing a sound lowers the dynamic range. When you compress a sound,
you lower the volume of loud sections and then raise the overall volume to
compensate.This is done to keep the volume level from fluctuating too much
over time.

Compression and Normalization can be used together to increase
the apparent loudness of a file. This is currently a popular mastering
technique.

To apply Compression:

1. Open the file TUTMUSIC.WAV. Make a copy of it by selecting the whole
region and dragging it to an open space in the Sound Forge XP workspace.

2. With the new file active, select Dynamics from the Effects menu.The Dynamics
dialog will appear.

3. Drag the Threshold level fader until you see the value -18 dB. Drag the Ratio
trackbar until the compression ratio is 2:1. Select OK to see the results of
compression in the sound. If you can see both files at once and are zoomed
out, you’ll be able to notice how the levels of the new file are more constant
than the original. Listening should reveal the same thing.

N O T E



4. In this example, sounds above the Threshold (-18 dB) are attenuated at an
input to output ratio of 2:1. The compressor does not affect sounds below
the Threshold.

5. Undo the previous operation and select Dynamics again. Now, increase the
Ratio to 7:1 and select OK. The sound will be even more compressed,
meaning that more attenuation and boosting will be applied to compressed
signals.

Too much compression starting at too low a threshold level will usually
lead to a distorted sound.

CHANGING TIME DURATION
Another Sound Forge XP function unique to digital processing is the ability to
stretch or compress the time duration of a sound without altering the pitch.
This is useful for lengthening or shortening sounds to meet a specific time
length.

To change the time duration:

1. Open SAXRIFF.WAV and select Time Compress/Expand from the Process menu.
The Time Compress/Expand dialog will appear.
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2. This process is very simple to use. In Time Compress/Expand dialog, you have
the ability to specify the final duration of a sound, from 50% to 500% of
the original length.You can select a mode of time compression to match the
type of material you’re processing.The Solo instruments mode does a good job
with this sound file. Select it from the Mode list. Change the Final length from
2.5 to 2.0 seconds (80% of original) and select OK. Press the Play button and
you should hear the sound played at a faster tempo.

The Time Compress/Expand offers a number of compression modes for various
kinds of source material. If you have sounds that have few loud, sustaining
low-bass frequencies, you can use modes that will result in no echoes. These
include the Drum and Solo Instrument modes. For complex music, you must
sacrifice some time localization for the ability to reproduce long bass notes.

If you have a drum recording with bass drum, snare, and cymbals, you will find
the Drums, unpitched (minimum echo) mode does an impeccable job. However, once
you start adding ringing low toms and congas, the Drums (better for toms) mode
will work better. Again, experimentation is the key.

SYNTHESIS

BASIC SYNTHESIS
The Synthesis tool can be used to generate a simple waveform of a given shape,
pitch, and length.

To synthesize a simple waveform:

1. Create a new window by selecting New from the File menu and set the data
format for the window to be 16-bit, 22,050 Hz, Mono.



2. Select Synthesis from the Tools menu.The Simple Synthesis dialog will appear.

3. Select the Sine option from the Waveform shape list. Enter 3 in the Length field
and 261.52 in the Frequency field. Press OK to generate a sine wave in the
window that is 3 seconds long and has a pitch of 261.52 Hz (Middle C).
Press the Play button to hear your reference tone.

DTMF SYNTHESIS
The DTMF Synthesis tool is used to generate the dial tones used by telephone
companies. These dial tones correspond to the numbers in a telephone unit,
along with other special codes.

To Synthesize DTMF tones:

1. Create a new window by selecting New from the File menu and set the data
format for the window to be 16-bit, 22,050 Hz, Mono.

2. Choose DTMF/MF Tones from the Tools menu. The DTMF/MF Tones dialog will
appear.
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3. Enter a phone number in the Dial string field. The Amplitude control
determines how loud the tones will be. Press OK to generate the tones.

4. Play back the sound file − you will hear the tones that would dial the
number you specified.

F ILTER ING
What can you do when you have a sound that is not quite perfect, but not bad
enough to throw away? Sometimes, judicious use of filtering can keep a
favorite sound bite from losing favor. Filtering is not a cure-all for bad sound,
but slight alterations of a sound can bring it back to life.

Sounds are composed of varying amounts of one or more frequencies. For
example, a sound with a rich timbre will contain many different frequencies.
A sine wave sound has only one frequency in it, like 60 or 440 Hz.

Filters allow the tailoring of the frequency spectrum of a sound. A spectrum is
nothing more than a representation of how much of each frequency
component (from 20 Hz up to one-half the sample rate) is present in a signal.
Less of any given component means that the given frequency component is not
as prevalent aurally as another component. Filters pass or reduce (attenuate)
frequency components.



Many factors such as the frequency response characteristic of your speakers
and sound card can also affect which frequencies are more prominent during
the playback of a sound. In general, the goal is to make a recording sound as
close to the original as possible. However, filtering is also commonly used to
remove unwanted sounds such as noise, or make individual instruments in a
recording sound louder.

GRAPHIC EQUALIZER
The Graphic Equalizer divides all the possible frequencies into ten bands which
you can boost or attenuate (cut). Each band has a Center frequency related to it.
The 125 Hz band, for example, affects frequencies between 90 and 190 Hz. The
Gain value above each band indicates the amount of cut or boost applied to the
band.When a band is set to zero, it means that the frequencies in the band will
not be modified. Positive gain values indicate a boost and negative values
indicate a cut in amplitude.

To Filter a sound file using Graphic EQ:

1. Open TUTMUSIC.WAV. Select Graphic EQ from the Process menu.The Graphic
EQ dialog will appear.

2. To remove some of the high frequencies from the music, drag the 1K fader
to the bottom. Repeat the process for all the faders to the right of 1K.

3. Click OK to remove the high frequencies from the music file. Press the Play
button to hear how the music sounds much duller.
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CHAPTER 6:
SOUND FORGE XP REFERENCE
This chapter contains a detailed explanation of every Sound Forge XP
operation. It is organized in the same order as the on-screen menus to allow
for quick reference to information about every Sound Forge XP menu and
dialog option. Where applicable, descriptions include shortcut methods for
performing an operation, either by using toolbar buttons, drag and drop
functions, shortcut menus (right-clicking), or shortcut keys.

This section is intended for the user who is already familiar with Sound Forge
XP. If you aren’t familiar with using Sound Forge XP’s windows and basic
controls, we suggest you first read chapter 2, Sound Forge XP Basics and chapter 3,
Editing and Navigation.

F ILE MENU

NEW

The New command creates a new sound data window.



SAMPLE RATE
Select a standard sample rate from the drop-down list or type in a custom rate.

SAMPLE SIZE
Check the button to select whether the new data will be 8-bit or 16-bit.

Open files are edited in 16-bit format and are only converted to 8-bit or
compressed audio when saving the file.

CHANNELS
Check the button to select whether the new data will be mono or stereo.

MAXIMUM EDITING TIME
Shows the maximum time currently available on the hard drive for editing a
file of the specified type.

Using the New toolbar button (or holding the Shift key down while
selecting New from the menu) will skip the New dialog and create a
window using the previously selected data settings.

Shor tcut :
Control+N

Drag and drop: Highlighting a section of waveform data, dragging it and dropping
it to the Sound Forge XP workspace creates a new window with the same data
attributes.

Selecting a blank portion of the Sound Forge XP workspace creates a new
window with the most recently used attributes.
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OPEN

Use this command to load a sound file into Sound Forge XP.

LOOK IN
Lists available drives and directories.

F ILE NAME
Type the File name you want to open or *. and an extension to see a list of files
with the corresponding extension in the current directory.

F ILES OF TYPE
Shows the type of files displayed. Choose a type from the drop-down list. If
you select All Types (*.*), Sound Forge XP will try to auto-detect the file format.

If you know that the file format is unsupported, select Raw File (.raw;*.*).
Selecting a file with a Raw File format will open the Raw file type dialog. Specify
format parameters for the file using this dialog. (More information about
opening Raw Files and other specific file formats is included at the end of the
Open section.)

MRU FOLDERS
Lists recently used folders. Use to speed the opening of regularly used files.

OPEN AS READ-ONLY
When checked, the sound file will be opened but you will not be able to alter
the sound data in the file.This feature is useful if you only need to play the file
or copy sections from the file.You can still change the Regions List, and Summary
information for the file, but these changes must be saved to a new file.

When you open a sound file, Sound Forge XP defaults to the edit mode you
last selected (either Open as read-only or Operate directly on the sound file).

OPERATE DIRECTLY ON THE SOUND F ILE
When checked, the sound file will be opened for editing but with no
temporary file created.This greatly speeds the opening process but doesn’t give
you the security of a backup file. In most cases this is not a problem since all
changes can be undone (if you have enough disk space). However if Sound
Forge XP terminates improperly, the file would remain in its edited state.
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Whenever you open a file in Sound Forge XP, a backup copy is created so
that the original file is not affected until you elect to save your work.
When you open a file as read-only or direct, Sound Forge XP will not
create a backup copy of the file, which makes opening files quicker and
uses less disk space.

AUTO PLAY
When checked, a file selected in the window will automatically begin playback
without opening it in Sound Forge XP.

PLAY
Auditions the sound file without opening it in Sound Forge XP. If playing a file
from a slow network or CD-ROM, some skipping might occur. This feature is
only available for WAV files.

Shor tcut :
Control+O

Control+F12

Control+Alt+F2

RAW F ILE TYPE DIALOG
This dialog is reached when you open a Raw file type. Use this to open a file that
is not stored in one of the standard sound file formats supported by Sound
Forge XP.

SAMPLE RATE (2 ,000 TO 96,000 HZ)
Sample playback rate that will be used by Sound Forge XP when playing the
file.

SAMPLE TYPE
Format used to store each sample value.

8-B IT  PCM
Uncompressed linear format.

R E F E R E N C E
1 3 6

N O T E



16-B IT  PCM
Uncompressed linear format.

G.711 Μ -LAW
Compressed format commonly used for telecommunications in the United
States.

G.711 A-LAW
Compressed format commonly used for telecommunications in Europe.

FORMAT (UNSIGNED,  SIGNED,  SIGN B IT)
Shows the sample format of data storage. Used when saving files in 8- or 16-
bit PCM format.

CHANNELS (MONO/STEREO)
Number of channels, or tracks, stored in the file.

BYTE ORDER (LITTLE ENDIAN OR B IG ENDIAN)
The order in which the high and low bytes of a 16-bit sample are stored. Little
Endian is used by Intel microprocessors, while Big Endian is used by Motorola
microprocessors.

HEADER BYTES
Number of bytes stored in the file before the sound data.

TRAILER BYTES
Number of bytes stored in the file after the sound data.

OPEN VIDEO STREAM 
This dialog is reached when you select an AVI file that has multiple audio or
video streams. It allows you to select a particular video stream and an audio
stream to open in Sound Forge XP. Most AVI files have just one video stream
and one audio stream, in which case this dialog doesn’t appear.
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STREAM
Selecting the black diamond to the left of a stream will open it. More than one
audio or video stream can be selected. Additional information about each
stream is available by clicking on the + area to expand the list.

CLOSE
Use this command to close the current sound file. If the data has not been
saved since the last edit you will be asked if you wish to save your changes.

SAVE

Use this command to save the current sound data. If the data is new data which
was not retrieved from a previous file or was loaded from a format which is
not supported for saving, you will be prompted with the Save As dialog.

The Macintosh Resource (SND) format is not supported for saving. If you
need to export sound files to a Macintosh, use the Macintosh AIFF
format.

Shor tcut :
Control+S

Shift+F12

Alt+Shift+F2

SAVE AS

Use this command to save the current sound data in a different file and/or file
format.
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SAVE IN
Lists available drives and directories.

F ILE NAME
Type the file name you want to save.

SAVE AS TYPE
Shows the file types available. Choose a type from the drop-down list. When
saving as a Raw File, the Save Raw File Type dialog will open. Specify format
parameters for the file using this dialog. (More information about saving Raw
Files and other specific file formats is included at the end of the Save As section.) 

MRU FOLDERS
Lists recently used folders. Use to speed the opening of regularly used files.

FORMAT
Shows the sample format in which the data will be saved. Sound files are most
often saved in the PCM format. However, other formats are often used for
compression purposes. If you have the Microsoft Audio Compression Manager (ACM)
installed, you can save files in a variety of compressed formats including the
Microsoft ADPCM format. (See Appendix E for more information about the
Audio Compression Manager.)

Windows 9x automatically includes ACM.

ATTR IBUTES
Sample Rate, sample size, and stereo/mono. Here, you can change the file’s
sample size (8- or 16-bit), and convert a file between mono and stereo
formats. When you convert from mono to stereo, the data will be stored in
both channels. When converting from stereo to mono, the data from both
channels will be mixed to a single channel.

SAVE REGIONS AND MARKERS IN WAV F ILES
Check if you want to include regions and markers in the audio file.

N O T E



SAVE SUMMARY INFORMATION IN F ILE (WAV,  AVI ,  ASF,  RM)
Check if you want summary information (such as author and copyright)
stored in the file.

RETAIN SAMPLER INFORMATION IN F ILE 
Check if you want sampler information (such as note assignment and loops)
stored in the file.

MRU FOLDERS
Lists recently used folders. Use to speed the opening of regularly used files.

FORMAT
Shows the sample format in which the data will be saved. Sound files are most
often saved in the PCM format. However, other formats are often used for
compression purposes. If you have the Microsoft Audio Compression Manager (ACM)
installed, you can save files in a variety of compressed formats including the
Microsoft ADPCM format. (See Appendix E for more information about the
Audio Compression Manager.)

ATTR IBUTES
Sample Rate, sample size, and stereo/mono. Here, you can change the file’s
sample size (8- or 16-bit), and convert a file between mono and stereo
formats. When you convert from mono to stereo, the data will be stored in
both channels. When converting from stereo to mono, the data from both
channels will be mixed to a single channel.

SAVE REGIONS AND MARKERS IN WAV F ILES
Check if you want to include regions and markers in the audio file.

SAVE SUMMARY INFORMATION IN F ILE (WAV,  AVI ,  ASF,  RM)
Check if you want summary information (such as author and copyright)
stored in the file.

RETAIN SAMPLER INFORMATION IN F ILE 
Check if you want sampler information (such as note assignment and loops)
stored in the file.
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SAVE RAW F ILE TYPE
This dialog opens when you select Raw from the Save as type list in the Save As
dialog. Use this to save an opened file into a file format that is not one of the
standard sound file formats supported by Sound Forge XP.

SAMPLE TYPE (8-B IT  PCM, 16-B IT  PCM, 
G.711 µ-LAW, G.711 A-LAW)

Format used to store each sample.

FORMAT (UNSIGNED,  SIGNED,  SIGN B IT)
Binary format of each sample value. Used when saving files in 8- or 16-bit
PCM format.

CHANNELS (MONO/STEREO)
Number of channels, or tracks, stored in the file.

BYTE ORDER (LITTLE OR B IG ENDIAN)
The order in which the high and low bytes of a 16-bit sample are stored. Little
Endian (low, high) is used by Intel microprocessors, while Big Endian (high,
low) is used by Motorola microprocessors.

VIDEO SAVE OPTIONS
This dialog opens when you select Video for Windows (.avi) from the Save as type list
in the Save As dialog. In this dialog, you can select which video streams you wish
to save and edit the title, language, and priority of the saved streams.

STREAMS
Check the streams that you want to save.The black diamond next to each check
box indicates currently opened streams.

Additional information is available by clicking on the + area to expand the list.
This information can be edited by right-clicking on a field and selecting Edit.



SAVE AUDIO TO NEW STREAM
If this option is checked, the audio track currently open in Sound Forge XP
will be saved to a newly created stream.

COMPRESSION OPTIONS
This dialog opens when you select Video for Windows (.avi) from the Save as type list
in the Save As dialog and then press OK in the Video Save Options dialog.

CHOOSE A STREAM
Check the audio or video stream for which you want to set the compression
formats.

INTERLEAVE FRAMES
When checked, selects how the audio and video streams will be interleaved.
Interleaving the audio and video streams improves playback performance
when using storage devices that are more efficient at providing data
sequentially (such as CD-ROM disks). The Frames value indicates the interval
between video and audio segments. The default is 1 for CD-ROMs, but can be
increased for faster media.

OPTIONS
Press this button to view and/or edit the audio and video compression options
for the selected stream.

VIDEO COMPRESSION
This dialog opens when you select Video for Windows (.avi) from the Save as type list
in the Save As dialog, press OK in the Video Save Options dialog, and after selecting
a stream, pressing the Options button in the Video Compression dialog.

COMPRESSOR
Select a compression format from any of the installed AVI compression
schemes. Compression formats are available from different vendors (not from
Sonic Foundry), and also come included with Windows.
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If the file is already compressed, you should select No Recompression.This will be
faster and will also avoid the loss of quality inherent in most recompression.

COMPRESSION QUALITY (0 TO 100)
Determines the final output quality. Usually, higher quality (close to 100)
means less compression and fewer visual artifacts.

KEY FRAMES EVERY
Some compression formats are based on key frames (sometimes called
temporal compression). A key frame is a frame that is usually less compressed.
Compressed frames that follow a key frame are smaller but slower to draw.This
option is only relevant to video streams.

A high number of key frames increases quality but decreases compression.Also,
if the number of key frames is very low, it will takes a long time to perform
decompression when drawing the video strip or moving randomly through
the file.

DATA RATE (KILOBYTES PER SECOND)
Determines the data rate that will be required to play the compressed stream
in real time. Lower data rates are less demanding on computer systems than
higher rates. If the data rate is too high for a certain computer (usually because
of a bottleneck such as a slow CD-ROM, network, or hard drive) the quality
begins to suffer and glitching can occur.

CONFIGURE
Press this button to set more detailed configuration parameters specific to the
compression scheme being used. Not all compressors provide this options.

PREVIEW
Press this button to view a preview of the final output.



REALMEDIA SAVE OPTIONS
This dialog displays when you select RealMedia (*.rm;*.ra) from the Save as type
list in the Save As dialog, and then click the Save button. This feature is only
available for Windows 9x and NT running on x86 processors.

ENABLE SELECTIVE RECORD CAPABILIT IES
When this option is enabled, RealMedia-compatible players can allow users to
save (record) RealMedia streams to their hard drive. Use this option only if it
is acceptable for users to create copies of the RealMedia file. The RealPlayer
Plus from RealNetworks supports Selective Record capabilities.

ENABLE PERFECTPLAY CAPABILITIES
When this option is enabled, users who are connected with a standard modem
can choose to download a higher quality version or the audio and/or video
that is normally only available over ISDN or LAN connections. The higher
bandwidth RealMedia stream is then played back from the user’s hard disk
after the download process is complete. The RealPlayer Plus from
RealNetworks supports PerfectPlay capabilities.

CREATE EVENT F ILE (RAE)  FROM MARKER AND REGION LABELS
When this option is enabled, events can be embedded from the Regions List
(View menu) into the RealMedia stream.

To embed an event, create a marker or region with a label starting with one of
the below prefixes followed by a colon.

RM URL: Specifies a URL (web address) to open.

RM Title: Sets the Title field in the RealPlayer.

RM Author: Sets the Author field in the RealPlayer

RM Copyright: Sets the Copyright field in the RealPlayer
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For example, if you create a marker with the label RM URL:http://
www.sonicfoundry.com, the RealPlayer would open the Sonic Foundry home
page at the marker’s location in the file during playback.You can just as easily
open specific web pages. For example, RM URL:http://www.sonicfoundry.com/
realaudio.html would open the realaudio.html page on Sonic Foundry’s web
site.

RealNetworks publishes extensive information on RealMedia events on their
web site (www.real.com). However, Sound Forge is capable of generating all
event files automatically rather than requiring several tools as described in
RealNetworks’ documentation.

NETSHOW SERVICES SETTINGS
The Netshow Services Settings dialog displays when you select Advanced
Streaming Format (asf) from the Save as type list in the Save As dialog, and then click
the Save button.

TEMPLATE
The Template list displays preset saving options, as well as any custom templates
that have been created. Templates contain the settings for encoding ASF files.
Choose a template, and then click the Create button to encode a file to ASF.

TEMPLATE DESCRIPTION
The Template Description field displays a short summary of the type of encoding
for which the selected template can be used.

DETAILS
The Details section displays the technical details of the selected template. Here
you will find the name of the audio and/or video codec being used, and details
of the audio and/or video format.

PROPERTIES
The Properties section allows you to enter specific information to embed in the
encoded ASF file. Information such as title and copyright will be displayed in
the player of the ASF file as the file is being played.



GENERATE REDIRECTOR F ILES
When this option is checked, ASX redirector files will be generated. Click the
ASX Settings button for more options.

ASF SERVER PATH
This option specifies a path for the server that will be accessed to play the
NetShow file.

USE ALTERNATE DESTINATION FOLDER FOR ASX F I LES
When this option is checked, the ASX files will be created in the directory you
enter in the field below, rather than the destination directory, for the encoded
ASF files.

PLAY START POSITION
This option allows you to specify an alternate play start position for the
encoded file.

PLAY LENGTH
This option allows you to specify an alternate play length for the encoded file.

MARKERS AND SCRIPT COMMANDS
The Markers and Script Command options allow you to use or not use any markers
that are defined in the source file. If the checkboxes are unchecked, the
encoder will ignore the markers.

CUSTOM
The Custom button at the bottom of the Netshow Services Settings dialog
launches the Custom Template wizard. Using this wizard, you can create your
own custom templates.

TEMPLATE NAME
A unique template name must be provided.

DESCRIPTION
Type a description of the template.
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NETWORK BANDWIDTH

Internet  14.4(10 kbps actual )  
This bandwidth selection supports streaming of both audio and video content
to clients using a network connection that operates at a minimum of 14.4
Kbps.

Internet  28.8(22 kbps actual )  
This bandwidth selection supports streaming of both audio and video content
to clients using a network connection that operates at a minimum of 28.8
Kbps.

Internet  56 Modem (37 kbps actual )  
This bandwidth selection support streaming of both audio and video content
to clients using a modem network connection that operates at 56 Kbps.

Single Channel  ISDN (50 kbps actual )  
This bandwidth selection supports network connections at Integrated Services
Digital Network (ISDN) rates.

Intranet  (100 kbps actual )  
This bandwidth selection supports clients on an intranet or local area network
(LAN).

Custom (bps)  
This bandwidth selection is for users whose system requires a customized
bandwidth setting, such as those using a dedicated network that does not use
one of the preceding bandwidths. When specifying the bit rate, consider other
traffic that must pass over the network. Unlike the preconfigured bandwidth
settings, Microsoft NetShow Encoder uses the entire bandwidth you specify for
streaming ASF information. Note that this value is entered in bits per second,
rather than kilobits per second.



AUDIO PANEL 

Codec and Format
Because some of the audio codecs have multiple formats, the Audio panel has
options for both the codec and the format. Use the Codec list to select the
audio codec. If the codec has multiple formats, use the Format list to select the
amount or type of compression.The format of a codec is the sampling rate (in
kilohertz [KHz] or hertz [Hz]) and sample depth (in bits). The larger the
sampling rate and sample depth, the more information is recorded. When
more information is recorded, the audio content usually sounds better;
however, the audio portion of the total bandwidth allocated also is larger.
Remember that the audio file must share the bandwidth with any video or
script commands.

Advanced
Click the Advanced button to select the audio loss concealment setting.

Audio Loss Concealment
Audio Loss Concealment blends the audio so that if information is lost during
transmission, there is no audible gap. There are two options that provide
different types of concealment. If the audio track has a low dynamic range,
such as when someone is speaking, select Voice by clicking on the radio button
to the left of this option. If the audio track has a large dynamic range, such as
when a band is playing, select Music by clicking on the radio button to the left
of this option.

VIDEO PANEL

Use Video
Place a check in the Use Video checkbox to use video in your template.

Codec
Choose a video codec from the Codec list. Be sure to select a codec that can
share the bandwidth with the audio codec you have selected.
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Advanced
To adjust advanced video settings, such as the size of the window for Microsoft
Media Player, the number of frames per second, and the number of I-frames,
click the Advanced button.

General Tab
Image Size: To determine the height and width of the Advanced Streaming
Format (ASF) content when it is viewed, use the Image Size panel. Quarter
Common Interface format (QCIF) and Common Interface format (CIF) are
predefined image standards: notice that CIF height and width are exactly
double those of QCIF. These standards are provided because their image size
(both height and width) is a standard that is supported by many codecs and
video editing tools.The 160x130 and 320x240 options provide video windows
that are slightly smaller than QCIF and CIF, respectively.The slight decrease in
image size allows for more bandwidth to be used for video frames, and can
improve content quality in some scenarios. Use these options if video
sharpness is more important than video size for your content.

Use the Custom option to define your own image size. When resizing an ASF
stream with the Custom setting, be aware that many codecs require image size
settings in multiples of 16.

Frames/Second: To set the number of frames per second for the ASF stream, use
the Frames/Second field.The Frames/Second value can be set from 1 through 15.
How much you adjust this value depends on the speed of the computer’s
coprocessor, and whether the computer is encoding high-movement or low-
movement video. If more frames per second are used, there are smaller changes
between frames, and the video looks smoother. If fewer frames per second are
used, the video has a slower motion transition rate, and thus video with a lot
of motion can appear disjointed. However, the more frames per second your
computer is required to encode, the harder the coprocessor must work. It is
possible to overwork your coprocessor by requesting it to encode more action
than its capability allows. If this happens, NetShow Encoder stops encoding,
and displays a message.



Second/I-Frames: The Second / I-frames field displays the number of seconds that
separate I-frames.All frames in between I-frames are called delta frames. Delta
frames contain only the information used to display change, and are
considerably smaller than I-frames; however, the visual quality of delta frames
is poor. As I-frames get farther apart, the size of the video (in bytes) gets
smaller. As I-frames get closer together, the size of the video (in bytes) gets
larger, and the computer’s coprocessor must work harder.

Pixel Format: The Pixel Format field displays the color depth standard that has been
selected.The video card that the computer is using to receive the video source
has certain color standards that it can display best, for example, RGBH = 64k
thousand colors and RGBT = 16 million colors. For information about which
pixel format your card works best with, see the video card’s documentation.
The pixel format is set automatically for the preferred video cards when you
select one of the template stream formats.

Delay Buffer: The Delay Buffer is the amount of video coming in from the video
card (measured in seconds) that NetShow Encoder stores before it starts
transmitting ASF information. Five seconds is the default; it allows enough
information to build up so that the client doesn’t have to wait (that is, buffer
information), and so the NetShow Encoder computer’s memory isn’t
overloaded with delayed ASF information. Increasing the Delay Buffer can
overload the NetShow Encoder computer’s memory, and affect the computer’s
ability to encode information. Decreasing the Delay Buffer, in some
circumstances, can cause clients to wait on NetShow Encoder.

Scalable Video: Placing a check in the Scalable Video checkbox creates multiple
content streams within one encoded .asf file. The streams are encoded at
different target bandwidth to allow a player to render content when network
bandwidth is reduced. Using scalable video requires an encoding platform that
has at least a Pentium II processor running at 266 megahertz(MHz). Scalable
video content can only be accurately decoded by NetShow Player 3.0 and
NetShow Server 3.0.
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Image Quality: The Image Quality slider lets you fine-tune the image quality.You
can emphasize either video smoothness or image crispness. Video content is
smooth when movement shown on the screen has easy transition from one
position to another and the edges of objects are not jagged. Video content is
crisp when images and motion are well-defined and clearly delineated. As you
increase the image crispness, the video becomes less smooth. In some cases,
decreasing the image crispness makes the video look better.

Clipping Tab
The fields on the Clipping tab allow you to clip the image size. The image at
the bottom of the tab allows you to see how your changes will affect your
image. You can use the up and down arrows next to each field to adjust the
image size, or you can type a number directly in the field to change the image
size.

SAVE ALL
Use this command to save all the currently opened files.You will be prompted
for each unsaved file. If you hold the Shift key down when selecting this
command, no prompts will be displayed.

DELETE
Use this command to delete a file, you can delete files from within the Open
and Save dialogs.

PROPERTIES
The Properties pages list attributes and information that is embedded in the
currently active sound file.

GENERAL
This page contains technical information regarding the current sound file,
including size, location, file type and attributes of the file.



Microsoft WAV files are composed of sections called RIFF chunks.These chunks
contain the sound data plus other embedded information. If there are any
non-standard chunks found in the current file, the junk, padding, and additional
chunks fields will be checked. These chunks might be used by other sound
utilities, or might just be garbage that can cause problems like glitching in
some less intelligent programs.

SUMMARY 
This page contains extra information that can be embedded in the sound file,
about the sound file. It is available for WAV, AVI, ASF, and RM files.

TITLE,  SUBJECT,  ENGINEER,  COPYRIGHT,  COMMENTS
Commonly used fields you can quickly edit. To view and edit all other fields,
press the Extended button.

PICTURE
Allows you to select an icon, bitmap or cursor to be attached to the current
file.

EXTENDED SUMMARY
Allows you to view and edit all available summary fields.

Fields
To edit a field, you must first select it from the Fields list. Select a field by
clicking in the box to the left of the field title. Click again to de-select the field.
A check mark indicates whether the field is currently enabled for saving to the
WAV file. If not selected, the field will not be written to saved files.

IARL Archival Location
Indicates where the subject of the file is archived.

IART Artist
Lists the artist of the original subject of the file. For example, Bach.

ICMS Commissioned
Lists the name of the person or organization that commissioned the subject of
the file. For example, XYZZY Records.
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ICMT Comments
Provides general comments about the file or the subject of the file. If the
comment is several sentences long, end each sentence with a period. Do not
include newline characters.

ICOP Copyright
Records the copyright information for the file. For example, “© Copyright
Sonic Foundry, Inc. 1997.” If there are multiple copyrights, separate them by a
semicolon followed by a space.

ICRD Creation Date
Specifies the date the subject of the file was created. List dates in year-month-
day format, padding one-digit months and days with a zero on the left. For
example, “1964-03-02” for March 2, 1964.

ICRP Cropped
Describes whether an image or sound has been cropped and, if so, how it was
cropped. For example, “third movement, first through fourth bars.”

IDIM Dimensions
Specifies the size of the original subject of the file. For example, “8.5 in h, 11
in w.”

IDPI Dots Per Inch
Stores dots per inch setting of the digitizer used to produce the file, such as,
“300.”

IENG Engineer
Stores the name of the engineer who worked on the file. If there are multiple
engineers, separate the names by a semicolon and a blank space. For example,
“Sayre, Jack; Feith, John.”

IGNR Genre
Describes the original work, such as, “landscape,” “portrait,” “still life,” etc.

IKEY Keywords
Provides a list of keywords that refer to the file or subject of the file. Separate
multiple keywords with a semicolon and a blank space. For example,
“Madison; aerial view; scenery.”



ILGT Lightness
Describes the changes in lightness settings on the digitizer required to produce
the file. Note that the format of this information depends on hardware used.

IMED Medium
Describes the original subject of the file, such as, “computer image,” “drawing,”
“lithograph,” etc.

INAM Name/Title
Stores the title of the subject of the file, such as, “Madison From Above.”

IPLT Palette Setting
Specifies the number of colors requested when digitizing an image, such as,
“256.”

IPRD Product
Specifies the name of the title the file was originally intended for, such as,
“Encyclopedia of Midwest Geography.”

ISBJ Subject
Describes the contents of the file, such as, “Aerial view of Madison.”

ISFT Software
Identifies the name of the software package used to create the file, such as,
“Sound Forge XP.”

ISHP Sharpness
Identifies the changes in sharpness for the digitizer required to produce the file
(the format depends on the hardware used).

ISRC Source
Identifies the name of the person or organization that supplied the original
subject of the file. For example, “Sonic Foundry, Inc.”

ISRF Source Form
Identifies the original form of the material that was digitized, such as, “slide,”
“paper,” “map,” etc.This is not necessarily the same as IMED.

ITCH TechnIcian
Identifies the technician who digitized the file. For example, “Jones, Henry.”
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DISP Sound Scheme Title
Sets the title that is displayed for MS Sound Systems.

Contents
Shows the text associated with the selected field. The text can be changed by
typing in this box.

Default
Sets the default fields to the current file’s field information. Use this to save
information that will be used in a number of different files, like copyright and
engineer information at your recording site.

Load
Sets the current file’s summary information fields to the default settings.

FORMAT
Use this page to change the data format of the current data window. This
includes Sample rate, Sample size, and Channels.

SAMPLE RATE (2 ,000 HZ TO 96,000 HZ)
The playback rate can be set from 2,000 Hz to 96,000 Hz by entering the rate
you wish to use.You may also select the most common sample rates by using
the drop-down list. Note that this will not resample the sound file. If the
playback rate is different from the originally recorded rate, the pitch will vary
unless resampling is done.

SAMPLE SIZE (8-B IT  OR 16-B IT)
Select 8- or 16-bit for the sample size.

CHANNELS (MONO/STEREO)
Select Mono or Stereo for the number of channels.

CURSOR POSITION
Displays the cursor position in the sound file using the current units.

SAMPLE VALUE
Displays the sample value at the current cursor position in the sound file. For
16-bit audio, this value ranges from -32768 to 32767. For 8-bit audio, it
ranges from -128 to 127.



PEAK DATA RATIO
Ratio at which the peak data is stored. This means that when zoomed out
beyond 1:512, the peak file instead of the entire file is scanned when drawing
the waveform.

SOUND DATA SIZE
Amount of storage space being used by the sound data.

VIDEO SOURCE FORMAT
Frame size (height, width, bits per pixel) and compression algorithm of the
original AVI file.

VIDEO DECOMPRESSION FORMAT
Intermediate frame size (height, width, bits per pixel) and compression
algorithm used by Sound Forge XP before displaying the video frames. The
video decompression mode can be changed from the Performance page in the
Preferences folder (Options menu).

UNDO BUFFERS
Number of Undo buffers currently existing for the sound file and the amount of
hard-drive space they consume.

REDO BUFFERS
Number of Redo buffers currently existing for the sound file and the amount of
hard-drive space they consume.

VIDEO
This page contains information specific to Microsoft AVI files. If your sound
file does not currently contain any video, you can attach a video from an AVI
file by pressing the Attach button.

An AVI file can contain multiple video and/or audio streams (or tracks). For
example, you can include multiple audio tracks in different languages to go
along with a video. When playing back, Microsoft’s Media player detects what
language the operating system is set to and plays the corresponding video
stream.
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STREAM 
Displays information about the video and/or audio streams present in the AVI
file, such as name, compression format, frame rate, and language.

The black diamond to the left of the streams indicate the active streams. You
can view and edit additional information (stream name, language, and priority
of the active audio stream) by clicking on the + sign to expand the list. Right-
clicking on a field allows you to edit it.

Streams that are checked will be preserved when the file is next saved. Streams
that are not checked will be deleted when the file is next saved.

DISPLAY
This page allows you to change how the data window of the sound file appears
on the Sound Forge XP workspace. Checking a box will display that item in the
current sound file’s data window. An unchecked item will not be displayed.

To set the current settings as the default display for all sound files, check the
Save as the default for all new windows check box.

Shor tcut :
Alt+Enter

SEND
Use this command to send the current sound file via electronic mail.

This option is only available in the 32-bit version of Sound Forge XP.

This option sends a mail message with an attached sound file. Note that you
must have electronic mail (email) capabilities to use this feature. When you
select the Send command, your email program opens with a new message and
embeds the active sound file from Sound Forge XP in the message. You then
have the option of sending the new mail message to the desired recipient.

When a sound file is embedded into a mail message, the entire contents of the
sound file are inserted into the message. To do this requires that any
modifications to a sound file be saved before the message can be sent. Sound
Forge XP will prompt you to save the file if this is necessary.

N O T E



Sound files are generally very large. An email message containing an
embedded sound file can take a considerable amount of time to send and
receive, especially if you are using a modem and not a high-speed
network.

EXIT
Use this command to exit Sound Forge XP. You will be asked whether you
would like to save any sound files that you have modified during the editing
session.

EDIT MENU
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UNDO

Use this command to undo the last edit operation. For instance, if you deleted
a section of data by accident, choose the Undo option from the Edit menu to
put the data back.

When working on large selections, it takes Sound Forge XP longer to
create an undo buffer.To save time and file space,you can disable the undo
feature.This is done by selecting Disable Undo/Redo under the Edit
menu or from within most processing dialogs.

Shor tcut :
Control+Z

Alt+Backspace

REDO

Use this command to re-perform an undone event. For instance, if you decide
that you really did want to delete that selection of data, select Redo and the
undo will be undone.

Shor tcut :
Control+Shift+Z

REPEAT

Use this command to repeat the last performed operation. This can be used
with most processing functions.The last dialog settings will be used unless you
hold down the Shift key, which allows you to change the operation’s dialog
parameters.

Shor tcut :
Control+Y to repeat last operation with the last used dialog options

Control+Shift+Y allows you to change the dialog settings before repeating

N O T E



CUT

Use this command to remove selected sound data and put it onto the
clipboard. This command has no effect if there is no selected data. Cutting
sound data replaces the previous contents of the clipboard.

Cutting data from the beginning of a very large file will take a long time to
process.This is because large amounts of data need to be moved.

You cannot cut from a single channel in a stereo file since the two
channels in a stereo file must always be equal in length.To shift a single
channel in time, use Delay/Echo in the Effects menu.

Shor tcut :
Control+X

Control+Del

COPY

Use this command to copy selected sound data onto the clipboard. This
command has no effect if there is no selected data.

Shor tcut :
Control+C

Control+Insert

COPY OBJECT LINK

This option is only available in the 32-bit version of Sound Forge XP.

Use this command to copy an object link for the active sound file onto the
clipboard.You can then Paste (or Paste Special) the link into another application
(such as Microsoft Word or Write) that supports Object Linking and Embedding
(OLE). This feature is useful for embedding sound files in documents.
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Object links are references to existing sound files on your hard disk or network
server. If you embed an object link to a sound file in a document, the sound
file is not actually inserted into the document, just a reference. Therefore, if
you copy the document to another computer, any sound file(s) that are
embedded will not be available on the other computer unless the sound file is
stored on a common network server.

If you intend to share documents between computers that contain embedded
sound files, it is suggested that you store all sound files on a network server and
embed them using Universal Naming Convention (UNC) path names. For example, if
your server and share name for sound files is \\myserver\sounds, then open
and embed all sound files using the UNC path (i.e., \\myserver\sounds\
<directory and file name >).

In Windows 9x, UNC path names are extremely simple to use. Instead of using
a drive letter when browsing in the Open dialog, select Network Neighborhood in
the Look in field and browse to the appropriate network server and share
containing your sound files. This method of browsing uses UNC names
exclusively.

For more information on Copy Object Link, and OLE support in general, refer to
Appendix F: Object Linking and Embedding.

PASTE

Use this command to insert a copy of the clipboard contents at the current
insertion point. If there is a selection made, the Paste command deletes the
selected data before inserting.

This command has no effect if the clipboard is empty.

Pasting into a stereo file will insert data to both channels since the channels in
a stereo file must always be equal in length.

Pasting data of different sample rates will cause the data in the clipboard to
play at the same rate as the rate of the window in which the data is pasted.

Shor tcut :
Control+V

Shift+Insert

Drag and drop a selection to another data window + Alt



Drag Paste
Specifies that dropping the data here will perform a paste operation.The data
will be pasted at the current cursor position within the data window.The paste
operation is used rather than mix when the Alt key is held down while
dragging. A small “L” or “R” will appear next to the cursor when pasting only
to a left or right channel respectively.

Instead of using the Alt key while dropping, you can also hit the right mouse
button while dragging. This toggles between Mix, Crossfade, and Paste drag and
drop.

PASTE SPECIAL

CROSSFADE
Use this command to crossfade a copy of the clipboard contents with the
sound data. The crossfade start point is either the cursor point or the start or
end of the selection in the destination file.

The Crossfade operation is similar to a mix, except that you apply a linear fade
to the source and destination data. It is commonly used as a transition between
one sound segment to another.

Crossfading data of different sample rates will cause the data on the clipboard
to play at the same rate as that in the current sound data with which the data
is crossfaded.

This command has no effect if the clipboard is empty.

When dealing with mono and stereo data, crossfading will occur on the
channel which the selection is dropped to (Left, Right, or Both).

Shor tcut :
Control+F

Drag and drop a selection from the source to the destination data window
while holding the Control key. Make sure that you don’t start the drag with
the Control key down, otherwise you will switch to Magnify mode.The Control
key must be down when you release (drop) the selection.
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Drag Crossfade

Specifies that dropping the data here will perform a Crossfade operation. The
crossfade will occur at the current insertion point within the data window on
which the data is dropped.The Crossfade operation is used rather than Mix when
the Control key is held down while dragging. When dragging a single channel
from a stereo file or a mono file onto a stereo file you can select whether the
data is placed in the left or right channel by the vertical position within the
data window. A small “L” or “R” will appear next to the cursor when
crossfading only to a left or right channel respectively.

MIX

Use this command to mix a copy of the clipboard contents with the sound
data. The mix start point is either the cursor point or the start or end of the
selection in the destination data window.

DRAG MIX

Specifies that dropping the data here will perform a Mix operation. The mix
will occur at the current insertion point within the data window on which the
data is dropped. When dragging a single channel from a stereo file, or a mono
file onto a stereo file, you can select whether the data is placed in the left or
right channel by the vertical position within the data window. A small “L” or
“R” will appear next to the cursor when mixing only to a left or right channel
respectively.

SOURCE VOLUME (- INF.  TO 15 DB)
Gain applied to the source data before mixing with destination data.

DESTINATION VOLUME (- INF.  TO 15 DB)
Gain applied to the destination data before mixing with source data.

APPLY DESTINATION VOLUME TO OVERLAPPING AREA ONLY (ON/OFF)
When off, the Destination Volume gain is applied to the entire destination sound
file. Otherwise, the Destination Volume gain is applied only to the area where the
destination and source data are mixed.



When mixing two sound files together, phase cancellation of some frequencies
often occurs. Very small delays can cause very audible differences in tone
quality. Mixing data of different sample rates will cause the data on the
clipboard to play at the same rate as that in the current sound file with which
the data is mixed.This command has no effect if the clipboard is empty.

Shor tcut :
Control+M

Drag and drop a data selection from the source to the destination data window.

OVERWRITE
Use this command to replace an area of sound data with the contents of the
clipboard.

The Overwrite command replaces data using the following rules:

If an area is selected which is greater than the length of the clipboard, the data
from the beginning of the selection is overwritten for the length of the
clipboard.

If an area is selected which is less than or equal to the length of the clipboard,
the data within the selection is overwritten with the clipboard for the length
of the selection.

The Overwrite command is useful when you are trying to replace silent sections
of audio with background noise.

REPLICATE
Use this command to copy multiple copies of the clipboard data to the current
data window.

The Replicate command will copy as many copies of the clipboard as will fit in
a selected area. If no selection is currently made in the data window, the
function will have no effect.

COPY PARTIALS
Selecting the Copy partials button will fill the selected region completely, using
a partial copy of the clipboard if needed.
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WHOLE COPIES
Selecting this option will use only whole copies of the clipboard, and will not
fill the selected region completely if its length is not an exact multiple of the
clipboard length.

Example:

1. Copy a 1 second section of sound data onto the clipboard.

2. Insert 5.5 seconds of silence in the data waveform.

3. Select the 5.5 second area and select Replicate.

If you choose Whole copies, 5 copies of the clipboard will be placed in the area
the silence previously occupied and 0.5 seconds of silence will remain at the
end.

If you choose Copy partials, 5.5 copies of the clipboard will be placed in the data
rather than just 5. No silence will remain.

The Replicate command is useful when you are trying to replace silent sections
of audio with background noise. It can also be used to introduce stuttering
effects or echoes.

PASTE TO NEW
Use this command to create a new data window that contains the contents of
the clipboard.

Shor tcut :
Control+E

Drag and drop a data selection to the Sound Forge XP workspace to create a
new file from the selection.

TR IM/CROP

Use this command to remove all data from the sound file except the selected
data. This command has no effect if there is no selected data. Trim/Crop sound
data does not copy data onto the clipboard.



CLEAR/DELETE
Use this command to remove selected sound data without copying it onto the
clipboard.

You cannot clear data from a single channel in a stereo file since the two
channels in a stereo file must always be equal in length.This command
has no effect if there is no selected data.

Shor tcut :
Delete

SELECT ALL
Use this command to select all data in the current data window.

Shor tcut :
Control+A

Control+Numpad 5

Double-clicking the left mouse button in the waveform display will select
all data.

TOOL

EDIT

Use this command to use the Edit Tool of Sound Forge XP. This is the typically
the tool you will use to do all of your selecting, editing, and processing.

MAGNIFY

Use this tool to zoom in to a particular region without losing your selection.
While the Magnify Tool is activated, dragging the magnifying cursor over a region
of data will draw a dotted rectangle around this area and magnify it when the
mouse button is released.
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DATA MAGNIFY MODE

When you are working in the data window using Magnify, this cursor shows
that you can select an area to magnify.

There are three modes of operation for the Magnify Tool.These can be chosen by
toggle-clicking while the Magnify Tool is selected. (Refer to chapter 2, Sound Forge
XP Basics for an explanation of toggle-clicking.)  These modes allow for Zoom
Time only, Zoom Level only or Time/Zoom Level.

To return to the normal editing, choose the Edit Tool from the Edit menu.

Shortcut:
While using any tool, if you hold the Control key down before selecting data
with the mouse, you will switch to the Magnify Tool.This is handy for quickly
magnifying a particular section of your sound file.

PENCIL 

Use this tool to edit the waveform by drawing on it. For example, if you have
a glitch in the sound data, zoom in to the glitch and smoothly re-draw the
waveform using the Pencil Tool.

DATA PENCIL MODE
When you are working in the data window using the Pencil Tool, this cursor
shows that you can draw new audio data. Dragging within the data window
will draw a new line that represents the new audio data. While holding down
the left mouse button, you can also use the arrow keys to fine tune the pencil
position.

The Pencil Tool is only available when operating at magnification levels between
1:1 and 1:16. To return to the normal editing mode, choose the Edit Tool from
the Edit menu.

GO TO
Use this command to set the cursor to a particular location in the sound file.

GO TO
Provides preset locations to pick from.



POSITION (0 TO TOTAL LENGTH)
The position where the cursor will be moved can be specified here.

INPUT FORMAT
Determines the input format that will be used to enter the position.

If you have a data selection, you can switch the cursor between selection
points with the ` key (reverse quote, normally above Tab key).You can
also switch the cursor between selection points by holding the Control
key while selecting the Go to Start or Go to End buttons in the
Playbar or Transport toolbar.

Shor tcut :
Control+G

F5

Waveform Display shortcut menu

Double-click on the Selection Start field in the playbar

SELECTION
This command displays the Set Selection dialog. It allows you to manually define
the selection by start and end points or length.

SELECTION
Provides preset regions to pick from.

START (0 TO TOTAL LENGTH)
The start point of the selection is specified here.

END (START TO END)
The end point of the selection is specified here.
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LENGTH (0 TO TOTAL LENGTH )
The total length of the selection is specified here.

CHANNEL (LEFT,  R IGHT,  BOTH )
If the sound file is stereo, you can specify which channel of the data will be
selected.

INPUT FORMAT
Determines the input format that will be used to enter the Start, End, and Length.

PLAY LOOPED
Check this box to play the selection repeatedly.

Shor tcut :
Control+D

Waveform Display shortcut menu

Double-click on the Selection Length field in the playbar

UNDO ALL
Use this command to undo all operations performed on a file. Unless Undo was
disabled at some point, this will return your file to its original state when first
opened. However, if you disable undo at any time, you might not be able to
return to the file’s original state.

When not working in direct mode, you can close the file without saving
changes to revert to the original file. However, when working in direct mode
if you decide to not save the current changes, Sound Forge XP does an Undo All
operation automatically before saving.

DISABLE UNDO/REDO
Use this command to prevent Sound Forge XP from creating temporary files
used for undoing operations. Since creating undo files takes time and disk
space, it is sometimes more convenient to have the Disable Undo option on,
especially when working with large files.



Remember to turn the Disable Undo feature off when you wish to be able to
undo operations.

Since Sound Forge XP doesn’t modify the original file unless the file is
opened direct or read-only, you can always recover it by re-opening it.
However, saved changes are permanent.

Shor tcut :
Control+U

VIEW MENU

MAXIMIZE WIDTH
This command stretches the active data window to fit between the extents of
the Sound Forge XP window.

FULL SCREEN
This command super maximizes the Sound Forge XP workspace in your
display.To return to the regular window display choose the Full Screen command
again.
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TOOLBARS
This command brings up the Toolbars page in the Preferences folder (Options
menu) and allows you to quickly display any toolbars on the Sound Forge XP
workspace. Placing a check next to the toolbar title will display it.

CLIPBOARD 
Use this command to display information on the current contents of the
clipboard.

CONTENTS
Information includes Format,Attributes, Length, Samples, and Total bytes. If no data is
in the clipboard you will be notified with a message box.

PLAY
This command will play the audio on the clipboard.

ZOOM LEVEL (VERTICAL)

OUT FULL
Use this command to zoom out vertically to allow viewing the entire
amplitude range of the waveform.This command also centers the centerline.

WINDOW
Use this command to zoom in or out vertically to the maximum zoom ratio
that allows you to view the entire waveform on the waveform display. This
command also moves the centerline if the maximum positive and negative
peaks are different.

SELECTION
Use this command to maximize a selected area both vertically and
horizontally.



Shor tcut :
Control+Up arrow (when a selection is active)

Level Ruler shortcut menu

Double-click on the Level Ruler

To zoom in and out vertically by small increments, you can use
Shift+Up or Shift+Down arrow keys or the Level Zoom
In/Out buttons on the lower left-hand side of the data window.

ZOOM TIME (HORIZONTAL)

IN FULL
Use this command to maximize the horizontal magnification to one sample
per pixel on the screen. When you zoom in full, the entire waveform display
length will span a very small amount of time, usually around 20 milliseconds
(depending on the sample rate and window size).

Shortcut:
Control+Up arrow (when no selection is active)

Waveform Display shortcut menu

NORMAL
Use this command to zoom out to the default zoom ratio preference setting. If
the entire sound file can fit in the window at a closer magnification, zoom
normal will only zoom out to that ratio.

To change the default for the Normal zoom ratio, go to the Display page in the
Preferences folder (Options menu).

OUT FULL
Use this command to zoom out to the lowest magnification so that the entire
sound file will fit on the screen.
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SELECTION
Use this command to maximize a selected area in the data window.

The Zoom Selection command will calculate the maximum zoom factor for the
size of a selection area, draw the data at this zoom factor, and center the
selection in the data window.

Shortcut:
Control+Up arrow (when a selection is active)

Waveform Display shortcut menu

To zoom in and out in time by small increments, you can use the up and
down arrow keys or the Zoom In/Out buttons on the lower right-
hand side of the data window.

FOCUS TO DATA WINDOW
Use this function to return the screen focus to the sound file’s data window.
This is the same operation as left-clicking anywhere on the data window.

Shor tcut :
Alt+0

REGIONS LIST
Use this to open or close the Regions List window.The Regions List contains all of
the regions and markers that exist in the currently selected data window. To
play a region, press on the Play button to the left of each region. Selecting a
marker or region moves the cursor or selection in the data window.

VIDEO PREVIEW
Use this to open or close the Video Preview window. This window shows the
video frame at the current cursor or play position.

Shor tcut :
Alt+2 to turn on or make active

N O T E



SPECIAL MENU

TRANSPORT
Use this to perform playback and record operations.

RECORD
Use this dialog to record to an existing or new data window.To record directly
to a specific file, use the Window button in this dialog (see below).

If the current window is opened direct, opening the Record dialog will
default recording to a new window.

MODE
Selects the current recording mode. Modes are as follows:

R E F E R E N C E
1 7 4

N O T E



R E F E R E N C E
1 7 5

Automatic  Retake (automatical ly  rewind)
In this mode, recording begins at the specified Start position and replaces any
sound data that already exists after that position. When recording is stopped,
the next record start position is automatically rewound to the original starting
position, allowing you to immediately do a retake which replaces the last take
if necessary.

Mult iple  Takes 
This mode will record successive takes of data.

Punch-In ( record a speci f ic  leng th)
This mode is used to record over the top of an existing region of sound. This
allows you to record a portion of a previous take without recording a whole
new file.

START,  END,  LENGTH,  INPUT FORMAT
Use to change the selection. Sound Forge XP automatically fills in the values
depending on your selection or cursor position.The Input Format determines the
recording format for the Start, End, and Length of the file.

REVIEW PRE/POST-ROLL
Check this option to specify the amount of time that will be played prior to
and after reviewing a take.The pre- and post-roll times are entered in the edit
boxes and measured in seconds.

MONITOR
Select this box to monitor the level of the input signal.The meters light up as
a function of the volume of the recording input. For best results, the level
should be somewhere in the yellow range with an occasional red.This button
also activates the peak value. The peak value shows the maximum input level
recorded since the monitor input box has been checked. If the peak value reads
clip, clipping has occurred and the audio quality has been compromised.
Clicking on the peak value display will reset it.



RECORD METERS
A number of commands and options affect what the Record Meters will display.
Each is described below.To activate the Record Meters options:

• Right-click anywhere in the dialog, or

• Use Alt+Spacebar

• Choose Record Meters from the pop-up menu that appears.

• For direct access, right-click anywhere in the meters.

Reset  Cl ip
This function resets the clip indication on the Record Meters. After a clip occurs,
the clip indication will remain lit until the Reset Clip function is invoked. You
can also click on the clip light or levels to clear it.

Resolut ion (-24,  -42,  -60 -78 or  -90 to 0 DB)
These settings display the minimum and maximum readings for the Record
Meters. Changing the resolution of the meters is helpful for metering sound files
of varying dynamism.

Show Labels
This option turns on or off the markings on the Record Meters.

Hold Peaks
This option turns on or off the markings to indicate the highest peaks in the
sound file.

Hold Val leys
This option turns on or off the markings to indicate the lowest peaks in the
sound file.

Aggressive Update
Enabling this option attempts to make the record meters more reactive. This
function does not work with all sound cards. If Aggressive Update is selected but
the meters are not accurately reflecting the audio input, disable this option.

BLINKING STATUS (ON/OFF)
This option enables or disables blinking of the status indicator. It is reached by
right-clicking anywhere in the Record dialog.

R E F E R E N C E
1 7 6



R E F E R E N C E
1 7 7

PREPARE
Pressing the Prepare button prepares your system for recording.This means that
the record device is opened and all preparation that can be done prior to
recording is completed.This allows the system to begin recording as quickly as
possible after the Record button is pressed. You do not need to use the Prepare
button unless you are trying to begin recording immediately after pressing the
Record button.

RECORD
Pressing the Record button starts recording.

Shor tcut :
Control + R

PLAY
Pressing the Play button allows you to hear a section of data over which you
are going to record or which you have just recorded. This allows you to keep
recording until you get the correct take. When pressed, the Play button turns
into the Stop button; press again to stop playback.

Shor tcut :
Alt + P

DROP MARKER
This tool inserts a marker at the current record position in the audio file.

Shor tcut :
Alt + M

GO TO BEGINNING
Pressing this button returns the cursor to the beginning of the current sound
file. Use to review takes or to begin recording from the beginning.

Shor tcut :
Alt + Z

REWIND
Pressing this button moves the cursor backwards, take by take, in the current
sound file. Use to review previous takes, or record over them.



FORWARD
Pressing this button moves the cursor forward, take by take in the current
sound file. Use to navigate through several takes either to review, or record over
them.

GO TO END
Pressing this button puts the cursor at the end of the current sound file. Use to
quickly continue recording from the end of the current sound file if the cursor
was moved to review the previously recorded material.

TIME RECORDED
This field displays the total time recorded for the current sound file. The
display is in the units displayed in the Input Format field above.

TIME LEFT ON DR IVE
This field displays the total time left on the drive for recording. The display is
in the units displayed in the Input format field above.

REMOTE
Press this button to enter the Remote Recording dialog. This mode will hide the
main Sound Forge XP window and show only the Record Remote dialog. This
allows you to easily record while using other components of your system like
a CD player, mixer, or sequencer.

GO TO
Press this button to see the Go To dialog. The controls on this dialog let you
select the position in the file where recording begins.You can also choose an
input format.

SELECTION (START,  END,  LENGTH,  INPUT FORMAT)
Press this button to see the Set Selection dialog. Use this dialog to determine the
start, end and length of the current selection, based on the Input Format. This
option is only available when a data selection has been made.

WINDOW
Press this button to see the Window dialog. Use it to choose a window to hold
the sound data you record.
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RESET
Press this button to reset the peak values on the record meters.

PLAY ALL
Use this function to play the entire sound file from beginning to end,
regardless of cursor position or selection.

Shortcut:
Shift+Spacebar

PLAY
Playback file in current playback mode (Normal or Looped mode)

Shortcut:
Alt+P

Spacebar

Right-click on overview bar

PAUSE
Pause playback and keep the cursor at its current position.

Shortcut:
Enter

Shift+Spacebar

Right-click on overview bar (during playback) 

STOP
Stop playback and return the cursor to its position prior to playback.

Shortcut:
Spacebar (during playback) 



GO TO START
Move the cursor to the start of file.

Shor tcut :
Control+Home

REWIND
Pressing this button moves the cursor backwards, take by take, in the current
sound file.

FORWARD
Pressing this button moves the cursor forward, take by take, in the current
sound file.

GO TO END
Move the cursor to the end of file.

Shor tcut :
Control+End

PLAY NORMAL MODE
Sets playback to Normal mode. When Play is selected while in this mode:

• If there is no data selected, playback occurs from the cursor to end of file.

• If there is data selected, playback occurs from the beginning of the selection
to the end of the selection.

Shor tcut :
To switch between playback modes, use Control+Spacebar.

PLAY LOOPED MODE
Sets playback to Looped mode. When Play is selected while in this mode:

• If there is no selection, the entire sound file is played in an endless loop.

• If there is a selection, the selection is played in an endless loop.
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Shor tcut :
To switch between playback modes, use Control+Spacebar

REGIONS LIST
The Regions List is used to store region and marker positions in a file. (To view
and edit the Regions List, display it first by selecting it from the View menu.)

ADD 
Use this dialog to add a selection to the Regions List.

TYPE (MARKER/REGION)
A Marker is a single point, a Region is a start and end point with an associated
length.

START,  END,  LENGTH,  INPUT FORMAT
Use to change the selection. Sound Forge XP automatically fills in the values
depending on your selection or cursor position.The Input Format determines the
recording format for the Start, End, and Length of the file.

Shor tcut :
R to create a regions

M to create a marker

Time Ruler shortcut menu

Region Tag shortcut menu

Region List shortcut menu

Press Enter when a region in the Regions List is selected

Double-click on a region in the Regions List

Drag and drop selection to Regions List

DELETE 
Use this function to delete a region from the Regions List.

Shor tcut :
In the Regions List, select a region and press Delete

Region Tag shortcut menu



EDIT 
Use this function to modify a region in the Regions List.

TYPE (MARKER/REGION)
A Marker is a single point, a Region is a start and end point with an associated
length.

START,  END,  LENGTH,  INPUT FORMAT
Use to change the selection. Sound Forge XP automatically fills in the values
depending on your selection or cursor position.The Input Format determines the
recording format for the Start, End, and Length of the file.

Shor tcut :
Region Tag shortcut menu

Region List shortcut menu

Press Enter when a region in the Regions List is selected

Double-click on a region in the Regions List

REPLICATE
Use this function to create a new copy of the marker/region.

Shor tcut :
Region List shortcut menu

UPDATE
Use this function to modify the current marker/region location in the Regions
List to correspond with the current cursor selection in the wave file.

Shor tcut :
Region Tag shortcut menu

Region List shortcut menu

CLEAR
Use this function to remove all markers/regions from the Regions List. This
action will also clear the Playlist.
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COPY ONTO CLIPBOARD
Use this function to copy the text of the Regions List onto the clipboard for use
with a text editor. Excellent for making a hard copy of the Regions List.

Shor tcut :
Region List shortcut menu

ACID LOOPING TOOLS

HALF SELECTION 
Halve the currently selected area.

Shor tcut :
Semi-Colon 

DOUBLE SELECTION 
Doubles the current selection.

Shor tcut :
Apostrophe

SHIFT SELECTION LEFT
Shifts the highlighted portion of a track left the exact distance of the
highlighted selection.

Shor tcut :
Less Than Symbol

SHIFT SELECTION R IGHT 
Shifts the highlighted portion of a track right the exact distance of the
highlighted selection.

Shor tcut :
Greater Than Symbol



THE ROTATE AUDIO
The selected audio at the beginning or end of the file is moved to the other
end of the file.

Shor tcut :
Colon

EDIT ACID PROPERTIES
Use this menu option to change ACID specific information in the wave file.

ONE-SHOT
One-Shots do not stretch with tempo or change pitch with the ACID project’s
key. Sounds such as cymbal crashes and vocal samples are usually played as
One-Shots.

LOOP
Loops stretch with tempo, and may also change pitch with the ACID project’s
key. Loops are the most common types of samples used in ACID.
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NUMBER OF BEATS
This option determines the length, in beats, of the Loop. If a 16-beat Loop is
specified as an eight beat Loop, it will play twice as fast as it should in ACID.
You can type a new length number directly in the field, or use the up and down
arrows to the right of the field to change the length number.

ROOT NOTE FOR TRANSPOSING
This option determines the root note that ACID will use to pitch the Loop to
the project key. If the root note is A, and the project key is C, the Loop will be
transposed up three semitones. You can change the note by clicking on the
down arrow to the left of the field and clicking on a new root note in the list.

DISK-BASED
Disk-Based files can stretch with tempo, but will not change pitch with the
ACID project’s key. Long files like vocal tracks are usually considered Disk-
Based.

TEMPO
Disk-Based tracks can stretch to the tempo of the project, but the original
tempo must be specified. If a tempo is not specified, the Disk-Based track will
not stretch.

EDIT FRAME RATE
Use this dialog to change the Frames per second value used by Sound Forge XP for
status information when using Absolute Frames or Time & Frames format. The
included presets are there for your convenience. You can manually enter the
frame rate below.



SET FRAME RATE TO:

HALF NTSC VIDEO (14.985 FPS)
This is one half of the standard rate for video broadcasts.

NTSC VIDEO (29.970 FPS)
This is the standard rate for video broadcasts.

RED BOOK DIGITAL AUDIO (75.000 FPS)
When recorded to CDs, audio tracks are divided into frames, which occur at
about every 8 ms. When editing a sound file that will end up on an audio CD,
Red Book Digital Audio ensures that the start and end of a selected audio track
will concur with the Audio CD’s frame architecture.

SMPTE NON-DROP (29.970 FPS)
This is the same as NTSC video.

VIDEO FOR WINDOWS DEFAULT (15.000 FPS)
Default rate used by Video for Windows AVI files.

FRAMES PER SECOND (1 TO 1 ,000)
Number of frames per second used.You can select a preset from the list above
or manually enter a value.

EDIT TEMPO
Use this dialog to automatically calculate the musical tempo (Beats per minute)
from the current selection.

To use Edit Tempo, first highlight a selection in the waveform display. The
selection made should be equal in size (or an integer multiple) to the length
of a beat or measure. The easiest way to tune a selection to be exactly one
measure long is to play the selection looped and change the selection points
until a constant downbeat is heard.

Sound Forge XP uses the current tempo to display measures in the Time Ruler.

TYPE (BEAT/MEASURE)
Choose whether the current selection in the waveform display is one beat or
one measure long.
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START,  END,  LENGTH,  INPUT FORMAT
Determines the selection used to calculate the tempo based on the Input Format.

BEATS PER MEASURE (1 TO 32)
Use to specify the number of beats in a measure when selecting a measure (e.g.,
4 for most pop music). It can also be used to specify beats per selection length
if the selection is larger than one measure.

BEATS PER MINUTE (1.0 TO 1000.0)
Sound Forge XP calculates this tempo value depending on your selection
length, selection type (Measures or Beats), and Beats per Measure.

The default tempo (Default: 120) can be changed on the Status page of
the Preferences folder (Options menu).

CENTER CURSOR
Selecting this item will center the display so that the cursor appears in the
center of the data window. This item does not actually move the cursor to a
new position in the data window, it redraws the display so that you will now
see the areas of the sound file equally on either side of the cursor. If the cursor
does not seem to center when selecting this, it is because the cursor is either
very close to the beginning or end of the sound file, and therefore cannot be
centered.

If you have a data selection, you can switch the cursor between selection
points using Home and End. You can also switch the cursor between
selection points by holding the Control key while selecting the Go to
Start or Go to End buttons in the Playbar or Transport toolbar.

Shor tcut :
C
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DROP MARKER
The Drop Marker command is a way to mark positions in a sound file. You can
drop a marker at the current cursor position while editing or on the fly during
file playback.

Markers can also be created by pressing ‘M’ on the keyboard. Markers can be
quickly selected from the list in the Go To dialog located in Edit menu. Also,
markers are placed in the Regions List for quick playback.

There is usually a very small delay between the time when you select
Drop Marker and when the marker is actually created. Using the
keyboard shortcut ‘M’ gives the fastest response, and thus the highest
accuracy.

Depending on the sound card you are using, there might be an offset error
between what you hear and where the cursor is located. To correct this, go to
the Wave page in the Preferences folder (Options menu) and use the Play position
bias to correct for the sound card driver’s offset error.

Some sound cards do not return position information to Sound Forge XP
very efficiently. If the cursor moves in large chunks during playback,
check the Play position bias or Interpolate play position for
inaccurate devices between fields options on the Wave page in
the Preferences folder (Options menu).

CREATE REGION
Use this function to create a new region in the Regions List from the current
selection.

Shor tcut :
R
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MARK IN
This item lets you mark the start (or “in point”) of a new selection while the
sound file is playing back.You can also use this as a method of marking the in
point of a new selection while editing by moving the cursor to where you
want the selection to start. This is a good way to accurately set the start of a
selection. For greatest accuracy you should use the keyboard shortcut key ‘[’
when Marking In during playback.

If there is a discrepancy between what you hear and the cursor position
on screen, use the Play position bias or Interpolate play
position for inaccurate devices between fields options on the
Wave page in the Preferences folder (Options menu).

Shor tcut :

[ (left square bracket)

MARK OUT
Use this function to create a mark out point of a new selection. Mark In and
Mark Out are used to determine a selection, and can be used during playback.
For greatest accuracy you should use the keyboard shortcut key ‘]’ when
marking out during playback.

If there is a discrepancy between what you hear and the cursor position
on screen, use the Play position bias or Interpolate play
position for inaccurate devices between fields options on the
Wave page in the Preferences folder (Options menu).

Shor tcut :
] (right square bracket)

N O T E
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TOGGLE SELECTION
By using the ‘S‘ key (or this menu item), you can toggle back and forth between
the last selection and last cursor position. For instance, you may be setting the
cursor in various places while navigating throughout a sound file. If you then
hit ‘S’, the last selected region will immediately return to the display.

Shor tcut :
S

UNDO/REDO HISTORY

CLEAR
Use this function to erase the temporary files created in the undo history for
the active file. These files do take up disk space, so you might want to
periodically clear them when you are sure that you don’t want to undo any of
your previous changes.This function only affects the current sound file.

CLEAR ALL
This command will clear the undo histories for all open sound files. Clear all
affects all of the opened sound files. After doing this you will be unable to
undo changes you have made to all modified sound files.

REBUILD PEAK DATA
This function recalculates the peak data file for the active data window. A peak
data file is used in displaying a file’s waveform without scanning the entire
length of the file for the sample amplitudes. This makes screen redraws much
faster.

If for some reason you believe that the waveform display is not accurately
representing the sound file, you can use this function to force Sound Forge XP
to re-scan the entire file. However, under normal circumstances you should
never have to do so since Sound Forge XP will always update the peak file after
every edit operation and when loading a file.
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PROCESS MENU

The Process menu contains commands that perform various standard audio
processes.

CONVERT TO 8-B IT
Use this dialog to convert 16-bit sound files to an 8-bit format. Because the
signal-to-noise ratio of 8-bit audio is so small (42 instead of 96 dB), it is
suggested that the volume of the sound file be maximized by using Volume or
Normalize (Process menu) before performing the conversion.

TRUNCATE
This method of 16- to 8-bit conversion removes the least significant bits of a
16-bit sample. It is the least desirable of the three.

ROUND
When rounding, 8-bit values are mapped to the nearest 16-bit value, thereby
slightly reducing the quantization noise.



DITHER (0.01 TO 2 .00 B ITS)
Dithering is used to reduce the audible effects of quantization noise which are
most audible in 8-bit samples.This is accomplished by adding a small amount
of noise to the signal to mask the more obtrusive 8-bit quantization distortion.

The dither depth is the amplitude of the added noise in terms of the least
significant bits of the sound file. For most cases, a value between 0.5 and 1.2 is
sufficient.

Use very small amounts of dithering and listen to whether the
quantization noise is less obtrusive. Increase the dither amount until the
dither noise is louder than the quantization noise.

DC OFFSET
Use this dialog to change the baseline of a sound file. A recorded wave that is
not centered around the zero baseline in the waveform display is said to have
a DC offset.To correct for offsets, a constant value is added to each sample.

DC offsets are usually caused by electrical mismatches between your sound
card and microphone. Glitches and other unexpected results can occur when
sound effects are applied to files that contain DC offsets.

AUTOMATICALLY DETECT AND REMOVE
When this option is checked, the DC offset is calculated for each channel
individually and then automatically corrected.

ADJUST DC OFFSET BY ( -32,768 TO 32,767)
Enter the offset value.The offset can be from -32768 to 32,767 for 16-bit data
and from -128 to 127 for 8-bit data.

An easy way to spot DC offset is to zoom close up to a spot in the sound
file containing only silence and see if the silence waveform matches the
centerline in the waveform display.
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An approximation of the DC offset of the waveform can be obtained by
running the Statistics function under the Tools menu. For example, if a DC
offset of 100 exists, then you should apply a -100 DC offset to cancel out the
existing offset.

COMPUTE DC OFFSET FROM F IRST 5 SECONDS ONLY (ON/OFF)
When this option is enabled, only the first 5 seconds of a sound file are
analyzed when measuring the DC offset. The only time that 5 seconds is not
sufficient is if a long fade-in or mute has been applied at the beginning of
the file.

FADE
Use a fade to vary the volume of a sound file over time.

GRAPHIC FADE
The Graphic Fade dialog allows you to draw a fade envelope that will be applied
across the current data selection. Up to 16 envelope points are allowed.

Draw the envelope by pulling the small square boxes (drag points) up or down.
The envelope default setting locates the drag points in the upper corners of the
wave display (100%).You can create a new drag point by left-clicking on any
point of the fade envelope. To delete a drag point, single-click on it with the
right mouse button, or double-click on it with the left mouse button. Once
you have finished with the envelope, press the OK button to apply the fade.

SHOW WAVE
Select this option to draw the current selection’s waveform on the envelope
graph. This is done automatically if the selection is small. For stereo files, you
also have the option of displaying the left, right, or a mix of the two channels.

RESET ENVELOPE
Press this button to return the fade envelope to its default shape.

IN
Use this command to linearly fade a selection from a volume of 0 dB to a
volume of -Inf.



OUT
Use this command to linearly fade a selection from a volume of -Inf. to a
volume of 0 dB.

GRAPHIC EQ
Use the Graphic Equalizer dialog to boost or attenuate selected frequency bands to
alter a signal’s frequency spectrum.

BAND ATTENUATION/GAIN FADERS ( -60 DB TO 20 DB)
Each of the ten faders corresponds to the gain or attenuation factor that will
be applied to the specified frequency band.The frequency on the bottom of the
fader is the center frequency of the frequency band affected by the fader.

The value of the fader affects the frequency band as follows:

+20 dB Maximum boost

0 dB No effect

-60 dB Maximum attenuation

ACCURACY (LOW, MEDIUM, H IGH)
Determines a compromise between filter precision and processing speed. Low
precision is not recommended for performing very sharp filtering, when
filtering very low frequencies, or when using a high sample rate.

RESET BANDS
Press this button to return the band faders to their default settings.

INSERT SILENCE
Use this dialog to insert a section of silence into a sound file.

INSERT 

SILENCE LENGTH
Enter the length of the silence block in seconds.

Star t  of  F i le
Inserts the silence at the beginning of the file.
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End of  F i le
Inserts the silence at the end of the file.

Cursor
Inserts the silence at the current insertion point.

You cannot insert silence to a single channel of a stereo file since the
length of each channel must always remain equal.

If you wish to shift in time a single channel of a stereo file, you can use
the Delay/Echo function (Effects menu) to delay one channel
backward or forward in time.

INVERT/FLIP
Use this command to invert the sound file at the base line (reverse polarity).
Although this does not make an audible difference, it can be useful for
matching a sample transition when executing certain pastes or mixes.

MUTE
Use this command to set a selection to a volume of 0 (silence).

NORMALIZE
Use this dialog to maximize the volume of a selection without clipping. The
Normalize function scans the audio and applies a gain to raise its level to a
specified (often very high) value.

NORMALIZE TO (-60 TO 0 DB)
This value indicates the level to which the sound file will be normalized. For
example, when using peaks, if the peak level is -10 dB, and the Normalize to
setting is set to -3 dB, a constant boost of 7 dB will be applied to the entire file.

N O T E

N O T E



When using RMS levels, normalizing to 0 dB means boosting the signal so that
it has the same apparent loudness as a 0 dB square wave, meaning incredibly
loud. If you were to do so, all of the dynamic range of the signal would be
squashed and all the peaks would either be clipped or seriously compressed
(see below). The lesson is, normalizing a peak to 0 dB is all right, but
normalizing RMS to anything above -6 dB is playing with fire.

PAN

GRAPHIC
The Graphic Pan dialog allows you to draw a pan envelope that will be applied
across the current data selection.You can create up to 16 envelope points.

Draw the envelope by pulling the small square boxes (drag points) up or down.
The envelope default setting locates the drag points at the center on each side
of the wave display. You can create a new drag point by left-clicking on any
point of the fade envelope. To delete a drag point, single-click on it with the
right mouse button, or double-click on it with the left mouse button. Once
you have finished with the envelope, press the OK button to apply the pan.

PROCESS MODE

Pan (preserve stereo separat ion)
Allows you to perform right and left channel panning effects without mixing
the channels together. This is used to simulate left/right positioning of stereo
recordings.

Pan (mix channels  before panning)
Allows you to perform right and left channel panning effects by first mixing
the two channels and then changing the volume between channels.

OUTPUT GAIN
The gain applied to the signal after processing.

SHOW WAVE
Check this box to draw the current selection’s waveform on the envelope
graph. This is done automatically if the selection is small. For stereo files, you
also have the option of displaying the left channel, right channel, or a mix of
the two channels.
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RESET ENVELOPE
Press this button to return the pan envelope to its default shape.

LEFT TO R IGHT
Select this option to create a smooth panning effect from the left channel to
the right. If the original source data is mono, Sound Forge XP automatically
converts it to stereo.

RIGHT TO LEFT
Select this option to create a smooth panning effect from the right channel to
the left. If the original source data is mono, Sound Forge XP automatically
converts it to stereo.

RESAMPLE
Use this dialog to change the sampling rate of an existing sound file.

NEW SAMPLE RATE (2 ,000 TO 96,000 HZ)
Sample rate to which the sound file will be converted.

APPLY AN ANTI-ALIAS F ILTER DURING RESAMPLE (ON/OFF)
Apply an anti-aliasing low-pass filter to the sound file before resampling when
changing to a lower sampling rate. Since the maximum frequency that can be
represented by a particular sample rate is one-half of the sampling rate (the
Nyquist frequency), high frequencies in a sound file cannot be represented if
the sound file is resampled to a lower sampling rate.Therefore, when changing
to a lower sampling rate, if the sound file has a strong high-frequency content,
anti-aliasing should be used to prevent these high frequencies from becoming
low-frequency distortion.

SET THE SAMPLE RATE ONLY (DO NOT RESAMPLE) (ON/OFF)
If this option is checked the playback rate is changed without resampling the
data. This means that the original pitch of the file is not preserved. When
converting between two very close sample rates and speed is of the essence, this
option can be turned on.



INTERPOLATION ACCURACY (1 -  4)
The Interpolation Accuracy parameter determines the complexity of the
method used during the resampling process. The audible difference between
the different values can be subtle without the use of test tones and is most
apparent in high frequencies.

In general, a setting of 1 is more than adequate for general purpose audio.
Settings of 2 and 3 are good for high-end audio. Setting this parameter to 4
forces some heavy duty number crunching (i.e., slow processing) but produces
very near perfect results, good for audiophiles and audio researchers.

Resampling data consists of changing the number of recorded samples per
second. When changing to a higher sample rate, extra samples are
interpolated and the file size increases.When changing to a lower sample
rate, some samples are removed and the file size decreases.

REVERSE
Use this command to reverse a selection.

SMOOTH/ENHANCE
Use this dialog to add or remove high frequency content in a sound file
selection.

The Smooth function will smooth out fast-changing transients in a sound and
is useful for removing glitches.

The Enhance function boosts the very highest frequencies (close to the Nyquist
rate) in the sound file, making the sound file sound more vivid. It is useful for
compensating for the effects of downsampling or for bringing out very fast
transients in a sound file

OPERATION (-5 TO 5)
Determines the amount of smoothing (high frequency attenuation) or
enhancement (high frequency boost) is applied to the sound file.
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For a very drastic high frequency boost or cut, repeat the effect 2 or 3
times with the amount set to either limit.

Note that since the Enhance function boosts frequencies near the Nyquist rate,
the current sample rate will determine what frequencies will be affected. At
44,100 Hz, the effect can be very subtle (unless you repeat it a few times until
your ears ring).

SWAP CHANNELS
Select this option to exchange the contents of the right and left channels of a
stereo recording.

TIME COMPRESS/EXPAND
The Time Compress/Expand dialog changes the duration of a sound file without
altering the pitch.

MODE
Selects the algorithm used to process the sound.The modes have been labeled
for suggested uses, but do not assume that one mode will not work well with
a certain type of sound. Depending on the source sound, different modes can
vary the resulting quality drastically, so experimenting with all modes is
suggested. In general, the music setting will work with the largest variety of
material.

Check the bottom of the dialog for a summary of your choices.You should be
able to achieve excellent results for ratios between 75% and 115%. Beyond this
range, you will start to hear artifacts such as echoes, flanging, or drop-outs.
Running the process a number of times using small increments (like 105%)
will create different effects than processing all at once with a large time
change.

F INAL LENGTH (50% TO 500% OF ORIGINAL LENGTH)
Desired length of the selection.

N O T E



You cannot perform this function to a single channel of a stereo file since
the length of each channel must always remain equal.

To change the Original tempo displayed at the bottom of the dialog, you must go
to the Edit Tempo dialog (Special menu).

BLEND EDGES WITH ADJOIN ING DATA (ON\OFF)
When this option is turned on, the beginning and end of the selections will be
crossfaded with the original sound data.This is used to minimize glitching.

VOLUME
Use this dialog to change the volume of a selection.

GAIN (- INF.  TO 20 DB)
Select a Gain amount from -Inf. to +20 dB. A value of negative infinity
corresponds to a mute (0%). Negative decibel values lower the volume
(attenuation). Positive values are used to raise the volume (boost).

EFFECTS MENU

The Effects functions allow you to apply different special effects to the sound
data. Most of the functions can be applied to single channels within stereo files
as well as areas selected within the file.
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CHORUS
The Chorus effect creates the illusion of two or more sound sources playing
together.This is done by adding a pitch-modulated and delayed version of the
input signal to the unprocessed input signal.The effect simulates the variances
in pitch and timing that occur naturally when two or more people try to play
or sing the same thing at the same time.

Use the Chorus dialog to choose between five preset chorus effects: Light, Heavy,
Vibrato, Reverberant, and Echo-Vibrato.

DELAY/ECHO
Use the Delay/Echo dialog to add a delayed copy of the sound signal to the file.
A single delay or decaying multiple delays can be added before or after the
sound signal.

DRY OUT (- INF.  TO 0 DB)
Amount of unprocessed signal mixed into the output.

DELAY OUT (- INF.  TO 0 DB)
Amount of delayed signal mixed into the output.

MULTIPLE DELAYS/ECHOES (ON/OFF)
When selected, multiple delayed copies are added to the file by using feedback
(delaying the delayed signal, and so on), which creates a decaying echo effect.
When off, a single delayed copy is added.

PRE-DELAY/ECHO (ON/OFF)
When on, the delayed copy is added before the sound (as heard in the Twilight
Zone).When off, the delayed copy is added after the sound, as heard in everyday
life echoes.



DELAY TIME (0.00001 TO 5 .0  SECONDS)
Determines the amount of time between the delayed copy and the original
sound. Also, if Multiple delays/echoes is checked, subsequent echoes occur at
intervals specified by the Delay time.

DECAY TIME (0.00001 TO 20.0 SECONDS)
Determines the time it takes the multiple echoes to become nearly inaudible.
Technically speaking, this is the time it takes an echo to decrease in amplitude
by a factor of 30 dB. If the Decay time is less than the Delay time, no echo will be
created.

You can also use Delay/Echo to shift one channel of a stereo file backward or
forward in time. For example, if you have a file with music in the right channel
and voice in the left, make a selection in only the left channel around the
voice. Set the following parameters: Dry out level at 0%, Delay out 100%, no
Multiple delays/echoes, no Pre-delay/echo. You can then use the Delay time parameter
to determine the time shift. If you want to shift the vocals backward in time,
check the Pre-delay check box.

To simulate a stereo sound from a mono file, copy the sound to both left and
right channels of a stereo file and then do a very small time delay of a single
channel (Dry out level at 0%, Delay out level at 100%, no Multiple delays/echoes, no
Pre-delay/echo). This simple technique often works in making the sound have a
more realistic stereo image. When a sound wave comes from your side, your
right and left ears receive sounds at different times, which is what this effect
simulates.

DISTORTION
The Distortion effect can simulate the overloading of an amplifier or mangle a
waveform into submission. Use the Distortion dialog to select from five preset
distortion effects: Fuzz, Limiter, Grunge, Soft Clip, and Hard Clip.

DYNAMICS
Dynamics processing is used to change overall volume levels within a sound
file. Compression affects the dynamic range of the sound file by varying the
gain as a function of the input sound level.
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A compressor lowers the dynamic range of a signal by reducing the level of
high volume signals and applying an overall gain to raise the level up again.
Compression is often used in vocals and music to get even volume levels which
often results in a smoother, fuller sound.

THRESHOLD LEVEL (-60 TO 0 DB)
Signal level that differentiates the Attack and Release modes. In a simple
compressor or gate, the threshold is the level at which the gain begins to
deviate from 1.

RATIO (1:1 TO INF. )
Ratio of input to output levels above the Threshold. This Ratio determines how
much a signal above the Threshold will be boosted or faded as a function of its
level. When changing the Ratio, all points above the Threshold move closer or
further away from the No Gain line.

ATTACK TIME (0 TO 500 MS)
Time, in milliseconds, required for the gain to change from a pre-threshold
level to a post-threshold level.

RELEASE TIME (0 TO 2 ,000 MS)
Time, in milliseconds, required for the gain to change from a post-threshold
level to a pre-threshold level.

AUTO GAIN COMPENSATE (ON/OFF)
When on, a gain is applied during processing to try to keep the maximum
input and output levels constant. In general, this gain will be equal to the
highest envelope point in the graph.You can still use the Output gain control
to fine tune the overall gain.

For best results, very low frequencies (below 20 Hz) present in a sound
file should be removed before applying the Dynamics functions.This
makes it easier to monitor audible frequencies while compressing.

N O T E



FLANGE
The flanging effect is heard in many 60s and 70s recordings. It is the result of
mixing a modulated delay signal with the original signal to create a sweeping
sound much like an airplane taking off. Use the Flange dialog to choose
between five preset effects: Slow, Medium, Fast, Warble 1, and Warble 2.

Flange effects are best heard with long, sustaining sounds so that the
entire sweep can be heard.

NOISE GATE
The Noise Gate dialog removes signals below a set threshold. It’s used to remove
noise from silent breaks in a sound file.

THRESHOLD LEVEL (- INF.  TO 0 DB)
Signals below this level will be removed from the sound file. Zero dB is a very
high level, while -30 dB is very low. Noise levels are usually around -20 dB.

To get an estimate of the noise level, select a region of silence (which also
contains noise) and run the Statistics tool. The maximum value (positive or
negative) shown is a good estimate of the threshold noise level required. For
example, if the maximum positive value is -50 dB and the maximum negative
value is- 45 dB, use a number slightly higher, maybe -40 dB, as the noise
threshold level.

ATTACK TIME (1 TO 500 MS)
Time it takes the gain of the gate to change from zero up to one once the level
rises above the threshold. The attack time is best kept to a minimum if
percussive attacks are to be preserved. Larger attack times make sounds slowly
swell up in volume.

RELEASE TIME (1 TO 2 ,000 MS)
Time it takes the gain of the gate to change from one down to zero once the
level falls below the threshold. The release time is usually kept large to allow
for natural sounding decays, otherwise long decays will be cut off.
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P ITCH BEND
Pitch Bend is used to draw an envelope that corresponds to increasing or
decreasing the pitch of a sound file over time.

ENVELOPE (2 TO 16 POINTS,  -RANGE TO +RANGE)
Specifies Pitch Bend over time. The vertical axis represents pitch change, with
zero being no change.The horizontal axis represents the length of the selected
region.

Click the left mouse button to define a point and drag to change its position.
Click the right mouse button over an existing point to remove the point.You
can create up to 16 envelope points.

RESET ENVELOPE 
This button removes all points except the outermost two.

RANGE (-24 TO 24 SEMITONES)
Maximum and minimum pitch change in Semitones (half-steps). Example: A
range of twelve half-steps (one octave) allows an increase or decrease of the
pitch by an octave.

SHOW WAVE
Select this check box to draw the waveform of the current selection on the
envelope graph. This is done automatically if the selection is small. For stereo
files, you also have the option of displaying the left channel, right channel, or
a mix of the two channels.

Pitch Bend is accomplished in the same manner as changing the
playback speed on a tape deck.Therefore, the length of the file will be
changed.
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REVERB
Reverb simulates various acoustic spaces. It consists of early reflections, which
are the first reflections that arrive back to your ear, and the reverb itself. Use
the Reverb dialog to choose from five preset reverberation effects: Medium
room, Small hall, Bright hall, Cathedral, and Metal tank.

TOOLS MENU

The Tools menu contains an assortment of utilities for various purposes.

DTMF/MF TONES
Use this to generate the standard dial tones used by the telephone companies.

DIAL STR ING
Use this to enter the phone number to be generated along with any necessary
pause characters. Unknown characters will be ignored.

AMPLITUDE (- INF.  TO 0 DB)
Peak level of the waveform.

TONE STYLE TO GENERATE

DTMF 
Dual Tone Multi-Frequency signals are used by the standard push-button phones. It
uses combinations of 679, 770, 852, 941, 1209, 1336, 1477, and 1633 Hz sine
waves.
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MF 
CCITT R1 signals are used internally by the telephone networks. They are
generated by a combination of 700, 900, 1100, 1300, 1500, and 1700 Hz sine
waves.

SINGLE TONE LENGTH (0.001 TO 2 SECONDS)
Output length of individual tones.

BREAK LENGTH (0.001 TO 2 SECONDS)
Length of the silence between tones.

PAUSE LENGTH (0.001 TO 5 SECONDS)
Length of silence to insert when the pause character is found.

FADE THE EDGES OF EACH TONE
When on, the tones are faded in and out a few milliseconds to prevent
glitching.

PAUSE CHARACTER
Character which when present in the dial string will cause a pause between
successive tones.

INSERT NEW TONE SEQUENCE AT (CURSOR,  START OF F ILE ,  
END OF F I LE)

Point where the generated waveform will be placed within the existing sound
file.

STATISTICS
This tool displays statistical information about the selected sound file.

CURSOR POSITION 
This indicates the cursor position in samples from the start of the sound file.



SAMPLE VALUE AT CURSOR
This value represents the instantaneous amplitude at this position.

For 16-bit sound files, the range of values is -32,768 to 32,767. For 8-bit
sound files, the range of values is -128 to 127.

MAXIMUM/MINIMUM POSITION AND SAMPLE VALUE
Maximum and minimum sample values and the location, in samples, where
they occur.

This is useful for determining if any clipping occurs in the sound file. It can
also be used to determine the noise level of a signal for use on the Noise Gate
effect. For example, to find the noise amplitude, run the Statistics function on a
region of noisy silence.

RMS POWER
Root Mean Square of the sample values relative to the RMS value of a maximum-
amplitude square wave (the loudest possible recording).

When used on short intervals, this relates to the volume level of the sound file.
However, if used on a large selection with large volume variation, this value
becomes less meaningful.

In Sound Forge XP, the value of 0 dB corresponds to a maximum amplitude
square, not sine wave. A maximum value sine wave will read at -3.0 dB.

AVERAGE VALUE (DC OFFSET)
This is a sum of all of the sample values in the selected region divided by the
number of samples. If non-zero, this usually indicates that there is a DC offset
in the recording process.

ZERO CROSSINGS
Times per second that the waveform changes from a negative value to a
positive value. This value can be used as a rough estimate of the frequency of
the sound data for very simple waveforms.
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SYNTHESIS
Use the Synthesis dialog to generate a simple waveform of a given shape, pitch,
and length.

AMPLITUDE (- INF.  TO 0 DB)
Peak level of the waveform to be generated. When generating Noise, the
amplitude is affected by the cutoff frequency selected.

WAVEFORM SHAPE (SINE,  SQUARE,  SAW, 
TR IANGLE,  NOISE,  ABSOLUTE SINE)

Shape of a single period of the waveform.

LENGTH (0 .001 TO 60.0 SECONDS)
Output length of the generated waveform.

FREQUENCY (0 .01 HZ TO 11,025 HZ)
Frequency of the waveform.

When creating noise, the frequency specifies the low-pass cut-off frequency.
For white noise, the frequency must be set to its maximum available setting.

Note that aliasing occurs with many of these waveforms when using high
frequencies because they are not band-limited.

INSERT NEW WAVEFORM AT (CURSOR,  START OF F ILE ,  
END OF F I LE)

Point where the generated waveform will be placed within the existing sound
file.



OPTIONS MENU

STATUS FORMAT
The current Status Format determines how Sound Forge XP displays position and
length information for the waveform in the active data window.

SAMPLES
Use this option to set the status format to samples.

TIME
Use this option to set the status format to show Hour:Minutes:Seconds:
Milliseconds.

SECONDS
Use this option to set the status format to show seconds with six decimal place
precision.
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T IME & FRAMES
Use this option to set the status format to Hour:Minutes:Seconds:Frames. The
frame rate is adjustable from the Edit Frame Rate dialog (Special menu). In this
mode, the hour, minutes, and seconds are in real time, independent of the
frame rate.

ABSOLUTE FRAMES
Use this option to set the status format to show frames and fractions of a
frame.

MEASURES & BEATS
Use this option to set the status format to show Measures:Beats.Quarter notes.

SMPTE NON-DROP
Use this option to set the status format to SMPTE Non-Drop (30 or 29.97 fps).
The standard rate for SMPTE Non-Drop when synchronizing to video is 29.97.
However, in music applications, a rate of 30.00 is often used.

When using a frame rate of 29.97, the time displayed will be different
than real world time because 30 frames are still 1 second.

SMPTE DROP
Use this option to set the status format to SMPTE Drop (29.97 fps). Frames will
be dropped at specific points in time to ensure that the hours and minutes
displayed stay synchronized to real world time.

SMPTE EBU
Use this option to set the status format to SMPTE EBU (25 fps). This is the
standard rate used by European television.

SMPTE F ILM SYNC
Use this option to set the status format to SMPTE Film Sync (24 fps), which is a
common slower film rate.

N O T E



ANNOTATIONS
The names of markers and regions can be shown on the waveform display,
along with dotted lines that run the entire height of the window.

MARKER NAMES
Displays marker names on the waveform display.

MARKER LINES
Displays dotted lines on the waveform display showing where markers exist.

REGION NAMES
Displays region names on the waveform display.

REGION LINES
Displays dotted lines on the waveform display showing where regions exist.

VIDEO
These options affect the Video Preview window and the video strip above the
ruler.

COPY CURRENT FRAME
Enabling this option will copy the frame corresponding to the current cursor
location to the clipboard.

WHITE,  BLACK OR DEFAULT BACKGROUND
This option selects the color used surrounding frames in the Video Preview and
video strips.The default color can be chosen from the Preferences folder (Options
menu).
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ANIMATE VIDEO STR IP
When this option is turned on, the video strip above the waveform display will
come to life at the current cursor or play position. This feature is frame
accurate, meaning that when you move the cursor, the correct frame
corresponding to the cursor position will be displayed instead of the static
overview frame.

When off, the video strip always shows the frame that corresponds to the left
edge of each image in the video strip.

NUMBER FRAMES 
Turn this on to show the frame number at the bottom left-hand corner of the
video windows.

STRETCH TO WINDOW
Turn this option on to cause each Video Preview frame to fit exactly into the Video
Preview window.This mode is generally the slowest because resizing a frame by
non-integral fractions requires many calculations.

INTEGRAL STRETCH
When this resize mode is enabled, the Video Preview frame will only be stretched
by integral amounts.This is usually the fastest mode.

PRESERVE ASPECT
Check this resize option when you want the original aspect ratio (horizontal
vs. vertical size) of the video to be preserved.

PASSIVE UPDATE
Checking this option will reduce the overhead needed to update the Video
Display window. When on, the Video Display will only be updated when the
processor is idle, which in slower computers is much less frequent. This will
help to keep the audio from skipping when a computer can’t update video
frames fast enough.



SCROLL PLAYBACK
Checking this option makes the data window scroll automatically during
playback. When the cursor moves off of the current window it will quickly
scroll to show another full window of data.

Shor tcut :
F6

DRAG AND DROP SNAPPING
This command toggles on and off the ability to snap to objects when dragging
and dropping from window to window. With this on you can snap to major
time ticks on the Time Ruler and cursor positions.

LOCK REGION LENGTH
Use this to have the length of a region remain constant when changing the
start or end time of a region.

Shor tcut :
Holding the Shift key down while dragging Ruler Tabs also locks the length of
a region.

PASTE EVENTS
Enabling this operation will transfer any events such as regions and markers
from the source to the destination sound files when pasting, mixing, or
crossfading.This occurs when using drag and drop or the clipboard.

If you are pasting data from Sound Forge XP to another application, these
events may cause problems.Although a well-written application should ignore
these events, if you are experiencing clicks at the beginning or end of the data
you should disable this option.

PREFERENCES
Many user-configurable options are available in the Preferences folder. To select
an item, click on the page tab or use the Tab key to activate the page title and
use the right or left arrow key to navigate through the pages.
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GENERAL
Use to select general user options.

SHOW A TIP OF THE DAY ON STARTUP DEFAULT:  CHECKED
When this option is enabled, a handy Tip of the Day will appear every time you
run Sound Forge XP.

ALWAYS ASK FOR REGION AND MARKER NAMES DEFAULT:  CHECKED
When creating regions, markers, or loop points and this option is turned off,
the Edit Region or Loop dialog will not automatically appear.A default name based
on location will be used.

OPEN DRAG AND DROP SOUND F ILES DEFAULT:  UNCHECKED
IN DIRECT MODE
Any files opened by dragging them onto the Sound Forge XP desktop (from
outside of the program) will be opened in direct mode when this option is
enabled.

OPEN COMMAND LINE SOUND F ILES DEFAULT:  UNCHECKED
IN DIRECT MODE
When launching Sound Forge XP from the command line (DOS prompt), if
this option is turned on any files in the command will be opened in direct
mode. For example, if Sound Forge XP is being launched by another
application (such as a multi-track editor), when this option is turned on
Sound Forge XP will edit directly on the original file.

DEFAULT TO SLOW SCROLL DEFAULT:  UNCHECKED
WHEN DRAG SELECTING
In some very fast computers, automatic scrolling while selecting is too fast to
use accurately.When this options is turned on, drag-selecting will cause a slow
scroll.

If you click the right mouse button while selecting, you can toggle slow
scroll on or off.

N O T E



WARN WHEN MIX OR CROSSFADE RATES MISMATCH DEFAULT:  CHECKED
Enabling this option tells Sound Forge XP to warn you with a dialog prior to
mixing or crossfading data having different sample rates. Mixing or Crossfading
data of different sample rates may produce unintended results.

ALWAYS OPEN FULL-SCREEN DEFAULT:  UNCHECKED
Enabling this option forces Sound Forge XP to always open in full-screen
mode. If this option is disabled Sound Forge XP opens in the size and position
it was in when it was last closed.

CONFIRM ON CLOSE DEFAULT:  UNCHECKED
Enabling this option forces Sound Forge XP to prompt you with a
confirmation message box prior to exiting Sound Forge XP.

If you are a system administrator you may want to enable this option for users
who are new to Windows, and who may double-click on the close box by
accident.

COMPATIBLE DRAW MODE DEFAULT:  UNCHECKED
(FOR BROKEN VIDEO DR IVERS)
Because Sound Forge XP’s drawing routines are highly optimized, they increase
the chance of causing little-known video card problems to arise. Some video
cards have bugs in their drivers that can make your system lock up when
Sound Forge XP tries to draw a waveform. If you experience a system lockup
frequently in Sound Forge XP, it is likely that your video card is causing this
problem.

Compatible draw mode uses a different method of drawing the waveform that,
although not as smooth, puts less stress on the video card. With some video
cards, this mode actually increases the draw speed. However, more flashing can
occur.

This problem is known to happen with ATI’s Mach64 card when using High
Color (16-bit) in Windows 95.

IGNORE FACT CHUNK WHEN OPENING DEFAULT:  UNCHECKED
COMPRESSED WAV F ILES
Check this option if you want to ignore the fact chunk when opening
compressed WAV files.This option may be useful for compressed WAV files that
were created improperly.
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SHOW ALL ACM CONVERT FORMATS IN SAVE AS DEFAULT:  CHECKED
When enabled, Sound Forge XP will enumerate all compression formats
available for each ACM compressor. However, this enumeration process can
take long on slow machines. For simple ACM codecs (Microsoft ADPCM, IMA
ADPCM, etc.), this option is unnecessary (they have only one compression type
per input) and could be disabled to speed up the selection of ACM formats.

SHOW FREE STORAGE SPACE ON STATUS BAR DEFAULT:  CHECKED
When this option is turned on, the total amount of free disk space available on
your specified temporary drive is displayed on the status bar.

SHOW SHUTTLE CONTROLS ON DEFAULT:  UNCHECKED
DATA WINDOW TRANSPORT
When enabled, Rewind and Forward buttons will appear on each Data
Window’s Transport.

SHOW OLE DRAG SOURCE ON DEFAULT:  CHECKED
DATA WINDOW TRANSPORT
When checked, the OLE Drag Source control is displayed on the right side of the
status bar in all data windows. This provides a convenient method of creating
Sound Forge XP audio objects that can be embedded into other documents. If
you do not use this feature and want to reclaim the space for the status bar,
simply clear this option.

RECENTLY USED F ILE LIST DEFAULT:  ENABLED (2 TO 9)
This option allows you to set the number of recently used files that will appear
in the File menu. If you do not wish to have any files listed in the File menu,
clear the check box for this option.

DISPLAY
Use to set your display preferences.

NORMAL ZOOM RATIO DEFAULT:  1 :1 TO 1:  524,288
Specifies the default zoom magnification when loading a new sound file or
using the Zoom Normal command.This allows you to control the maximum data
that will be shown in a data window when a file is opened. Higher values show
more data on initial file loading.



DEFAULT SOUND F ILE WINDOW HEIGHT DEFAULT:  12
Specifies the default data window height for a sound file on open.

DEFAULT VIDEO STR IP HEIGHT DEFAULT:  4
Specifies the height of the video strip, from small (1 line) to big (25 lines).

COLOR PREFERENCE FOR
The color preferences section allows you set a custom color for a variety of
graphics within Sound Forge XP. Each graphic has a default color or you can
set a custom color by checking the Custom box and setting the component Red,
Green, and Blue of each color.

For each mode of opening sound files, Normal, Direct, and Read Only, you can
assign a different color for data window graphics.

Normal :  Data Left
Specifies the color used to draw the left channel or mono wave data in each
data window.

Normal :  Data Left  Selected
Specifies the color used to draw the left channel or mono selected wave data
in each data window.

Normal :  Data Right
Specifies the color used to draw the right channel wave data in each data
window.

Normal :  Data Right  Selected
Specifies the color used to draw the right channel selected wave data in each
data window.

Normal :  Window Background
Specifies the color used to draw the background of each data window.

Normal :  Selected Background
Specifies the color used to draw the background of selected data in each data
window.

Normal :  Center  L ine
Specifies the color used to draw the center line of the wave axis.
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Normal :  -6 .0  DB L ine
Specifies the color used to draw the line at half volume for the wave axis.

Normal :  P lay Cursor
Specifies the color of the cursor that is drawn while playing a file.

Direct :  Data Left
Specifies the color used to draw the left channel or mono wave data in each
data window.

Direct :  Data Left  Selected
Specifies the color used to draw the left channel or mono selected wave data
in each data window.

Direct :  Data Right
Specifies the color used to draw the right channel wave data in each data
window.

Direct :  Data Right  Selected
Specifies the color used to draw the right channel selected wave data in each
data window.

Direct :  Window Background
Specifies the color used to draw the background of each data window.

Direct :  Selected Background
Specifies the color used to draw the background of selected data in each data
window.

Direct :  Center  L ine
Specifies the color used to draw the center line of the wave axis.

Direct :  -6 .0  DB L ine
Specifies the color used to draw the line at half volume for the wave axis.

Direct :  P lay Cursor
Specifies the color of the cursor that is drawn while playing a file.



Read Only :  Data Left
Specifies the color used to draw the left-channel or mono wave data in each
data window.

Read Only :  Data Left  Selected
Specifies the color used to draw the left channel or mono selected wave data
in each data window.

Read Only :  Data Right
Specifies the color used to draw the right channel wave data in each data
window.

Read Only :  Data Right  Selected
Specifies the color used to draw the right channel selected wave data in each
data window.

Read Only :  Window Background
Specifies the color used to draw the background of each data window.

Read Only :  Selected Background
Specifies the color used to draw the background of selected data in each data
window.

Read Only :  Center  L ine
Specifies the color used to draw the center line of the wave axis.

Read Only :  -6 .0  DB L ine
Specifies the color used to draw the line at half volume for the wave axis.

Read Only :  P lay Cursor
Specifies the color of the cursor that is drawn while playing a file.

Reg ions:  Marker
Specifies the color used to display marker tabs on the data window Time Ruler.

Reg ions:  Sect ion
Specifies the color used to display region tabs on the data window Time Ruler.

R E F E R E N C E
2 2 0



R E F E R E N C E
2 2 1

Sample Loop:  Sustaining
Specifies the color used to display sustaining loop tabs on the data window
Time Ruler.

Sample Loop:  Release
Specifies the color used to display release loop tabs on the data window Time
Ruler.

Record Prepared
Specifies the color used in the Record dialog to indicate record prepared status.

Record Pre-rol l
Specifies the color used in the Record dialog to indicate record pre-roll status.

Record Recording
Specifies the color used in the Record dialog to indicate recording status.

Graph Axis
Specifies the color used when displaying an axis in a graph.

Graph F i l l
Specifies the color used when displaying a filled graph.

Graph F i l l  Al ternate
Specifies the color used when displaying multiple filled graphs such as in Multi-
Band Dynamics.

Envelope Axis
Specifies the color used when displaying the axis of envelope controls.

Envelope Highl ight
Specifies the color used when displaying a highlight in envelope controls.



EDITING
Use this to set preferences related to editing and undo operations.

LIMIT NUMBER OF UNDO BUFFERS TO (0 TO 999) DEFAULT:  100
If this is checked, it determines the maximum number of Undo operations that
will be saved before they start to get deleted. Having many Undo operations
available will use a lot of hard-disk space.

LIMIT NUMBER OF REDO BUFFERS TO (0 TO 999) DEFAULT:  100
If this is checked, it determines the maximum number of Redo operations that
will be saved before they start to get deleted. Having many Redo operations
available will use a lot of hard-disk space.

DEFAULT ALL NEW WINDOWS TO UNDO DISABLED DEFAULT:  UNCHECKED
Enabling this option will keep Sound Forge XP from creating undo buffers for
any operation that modifies a sound file. You are still able to turn the undo
creation on by using the Disable Undo command (Edit menu) for any window,
but by default no undo buffers will be created.

DRAG & DROP AUTO R ISE DELAY (0 .1  TO 2 .0 SECONDS) DEFAULT:  0 .7
Determines the time necessary before a window underneath the cursor
becomes active during drag and drop operations.

DISABLE TR IPLE-CLICKING TO SELECT ALL SOUND F ILE DATA DEFAULT:  OFF
Turn this option on if you don’t want Sound Forge XP to select all sound data
when you triple-click. You might want to turn this off if triple-clicks are
constantly being falsely detected when you make a selection and then try to do
a drag operation. Otherwise, lowering Windows’ double-click threshold time
might help.

F ILE
Use this to set preferences related to opening and saving files.

WARN IF  SAVE CHANGES THE SOUND DATA DEFAULT:  CHECKED
When you save a sound file to a different format, such as doing 16- to 8-bit
conversions or compressing audio, you will not hear the conversion’s effect on
the sound until you re-open the file. If this option is enabled, you will get a
message warning of this.
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AUTOMATICALLY RE-OPEN I F  SAVE DEFAULT:  UNCHECKED
CHANGES THE SOUND DATA
If this option is on, when you save a file to a different format Sound Forge XP
will save the file and then re-open it. This will happen when you change bit
size, channels, or compression format and it will allow you to listen to any
changes in sound quality.

SECTOR ALIGN DATA FOR DIGIDESIGN’S DEFAULT:  UNCHECKED
SESSION 8 WAV F ILES
This option is only necessary if you are using Sound Forge XP to modify files
for use with Digidesign’s Session 8. Enabling this option forces Sound Forge XP
to align the data portion of WAV files on a sector boundary, which is needed
when using WAV files with the Session 8.

SAVE VOC F ILES USING NEWEST FORMAT DEFAULT:  UNCHECKED
(16-B IT  CAPABLE)
Prior to Creative Labs’ sound boards supporting the playback of 16-bit data,
VOC files had no way of storing 16-bit audio data.With the addition of 16-bit
playback sound boards to the Sound Blaster line of products, a newer version
of the VOC file was created.With this option disabled Sound Forge XP will save
all 8-bit files in the old format and all 16-bit files in the new format.With this
option enabled it will save all files in the new format. Only enable this option
if you have software that requires the new format for 8-bit data.

OPEN AND SAVE WITH SOUND FORGE XP 3 .0  DEFAULT:  OFF
COMPATIBLE REGIONS
Sound Forge XP 3.0 had a minor bug when opening and saving regions in
which the total length was off by one sample. Because files were both opened
and saved inconsistently with the published standard, this didn’t affect
anything. Sound Forge XP 4.5 fixes this problem, but in doing so this means
that files created with Sound Forge XP 3.0 will have their region length display
1 sample smaller than before.

If this bothers you, turn this option on when opening a file saved in Sound
Forge XP 3.0, turn it off, and then save the file. From there on after, the region
lengths will not be off by one sample in Sound Forge XP 4.5 (but will be in
3.0!)



DEFAULT SDS CHANNEL WHEN SAVING (1 TO 16) DEFAULT:  1
Specifies the channel used in SDS packets when saving audio as an SDS file.

DEFAULT SDS PATCH WHEN SAVING (0 TO 127) DEFAULT:  0
Specifies the patch used in SDS packets when saving audio as an SDS file.

DEFAULT DIALOGIC VOX SAMPLE RATE FOR OPEN (HZ) DEFAULT:  8 ,000 HZ
Specifies the default sample rate used when opening Dialogic VOX sound files
in Sound Forge XP. This option is necessary because Dialogic VOX sound files
do not contain this information. Typical settings for this option are 6,000 Hz
and 8,000 Hz.

ASSOCIATE SOUND F ILE EXTENSIONS
This button opens the Sound File Associations dialog.This dialog provides a method
of associating audio files with Sound Forge XP. When a file is associated with
Sound Forge XP, you can double-click on a sound file in the File Manager or the
Windows 9x Explorer and it will open for editing.

Fi le  types to associate
The list displayed contains all sound file formats that Sound Forge XP supports.
If a sound file extension is associated with an application, then the name of the
application is displayed on the right. If a sound file is associated with Sound
Forge XP, then a check mark is placed in the box to the left of the item. To
associate an item with Sound Forge XP, check the item and select OK.

Fi le  associat ion detai ls  
When a sound file extension is associated with Sound Forge XP, Windows will
open Sound Forge XP to edit any files with the extension when selected. For
example, if you double-click on a file with an extension that is associated with
Sound Forge XP in the File Manager or the Windows 9x Explorer, Sound Forge XP
will automatically run and the sound file will be opened for editing.

Select  Al l
Pushing this button will select all sound files to be associated with Sound Forge
XP.

Select  None
Pushing this button will de-select all sound files so no files are associated with
Sound Forge XP.
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PERFORMANCE
Use this to set preferences related to opening and saving files.

TEMPORARY STORAGE FOLDER DEFAULT: C:\PROGRAM FILES\SOUND FORGE XP
The specified directory is used to store temporary files used by Sound Forge
XP.

Sound Forge XP stores its temporary data in a temporary directory on your
hard drive. Using temporary file space allows you to edit very large files and
keeps Sound Forge XP from eating up large portions of RAM on your
computer. Your temporary directory must have enough space to handle the
total size of all files you plan to edit at one time along with space for any
clipboard data and undo buffers.

If you change the Temporary storage folder, you will have to close Sound Forge XP
for the change to take effect.

FREE STORAGE SPACE IN SELECTED FOLDER
Shows the amount of available disk space in the selected folder.

VIDEO DECOMPRESSION MODE DEFAULT:  8  B ITS ALWAYS
Determines the bits per pixel (color resolution) which will be used by Sound
Forge XP when it decompresses video frames before displaying. Note that when
a high number of bits is used, the performance demands on your system are
higher.The available modes are:

8 bi ts  a lways
Sound Forge XP will always decompress the video to 8 bits per pixel (256
color).

Best  for  display
Sound Forge XP will decompress the video to the best format that matches
your system’s color capabilities.

Ful l  decompress a lways
Sound Forge XP will always decompress the video to its original bits per pixel
when displaying.This is useful if you want to ensure that the video frames you
see contain all the color information stored in the file. Also, if you wanted to
paste frames to the clipboard, this ensures maximum resolution.



PEAK RATIO DEFAULT FOR NEW SOUND F ILES DEFAULT:  1 :256
When drawing the waveform display, Sound Forge XP will use a peak file
instead of scanning all of the data when the zoom ratio is above this level.
Lower values allow for faster scrolling at those ratios, but increases the peak
file’s size. For example, setting this value to 1:128 instead of 1:256 will make
the peak file two times larger but will make scrolling at 1:128 faster and
scrolling at 1:65536 or higher ratios slower.

To calculate the size of the resulting peak files, you divide the size of the file
by the Peak ratio. For example, a 100 MB sound file will need a 0.39 MB
(100/256) peak file when using 1:256.

WAIT CURSOR ZOOM RATIO THRESHOLD DEFAULT:  1 :512
Specifies the amount of zoom above which an hourglass cursor will be
displayed between data window repaints. If the mouse cursor seems to flicker
on and off a lot when redrawing wave data, you may want to increase this
value.This value is ignored during playback.

SHOW THE POSITION OF THE PLAYBACK CURSOR DEFAULT:  CHECKED
When this option is enabled, the Position field in the status bar will show the
cursor position during playback. Disable this option if you have a very slow
computer or video card.

SHOW THE RECORD COUNTER WHILE RECORDING DEFAULT:  CHECKED
When this option is enabled, the record time will show in the Record dialog
while recording. Disable this option if you have a very slow computer or video
card.

STATUS
Use to select display status options.

DEFAULT SMPTE FORMAT DEFAULT:  NON-DROP (30 FPS)
Specifies the SMPTE type used when selecting a SMPTE format option from the
Status Bar shortcut menu.

Non-Drop 30 FPS
Calculates status values using a 30 frames per second SMPTE code.
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Drop 29.97 FPS
Calculates status values using a 29.97 frames per second SMPTE code. This is
accomplished by dropping two frames every minute except for minutes 00, 10,
20, 30, 40, and 50.

EBU 25 FPS
Calculates status values using a 25 frames per second SMPTE code.This format
is the European Broadcast Union time code.

Fi lm Sync 24 FPS
Calculates status values using a 24 frames per second SMPTE code.This format
is for standard 24 frames per second film media.

DEFAULT TIME FORMAT DEFAULT:  T IME
Specifies the time format (time or seconds) used when selecting the Time
option from the Status Bar shortcut menu.

DEFAULT FRAMES PER SECOND (1 TO 1 ,000) DEFAULT:  15.000
Specifies the default frame rate used to calculate frame values.

Frame values are useful when trying to synchronize sound with animation.
Most animation players specify a playback frame rate at which video frames are
shown to the user. If you are using an animation that has a frame rate of 15.0
frames per second, you would set the frame rate to 15.0. When status values
are shown by Sound Forge XP they will be shown in values of frames. This
allows you to find the frame to which a given point in the sound file
corresponds.

Frame rates can be any value between 1.0 and 1,000.0 frames per second.

DEFAULT BEATS PER MEASURE (1 TO 32) DEFAULT:  4
Specifies the number of beats in each measure for displaying in measures and
beats. For example 2/4 time would have two beats per measure.

DEFAULT BEATS PER MINUTE (1 TO 1 ,000) DEFAULT:  120.000
Specifies the number of beats per minute, i.e., the tempo of a song for
displaying lengths. For example, a tempo of 120 is 120 beats per minute.



DISPLAY FORMAT FOR SMPTE CODE DEFAULT:  00:00:00.00
Specifies how SMPTE values will be formatted for display by Sound Forge XP.
Select one of the available preferences from the drop-down list.

TOOLBARS
Use to select which toolbars are displayed on the main screen. A check in the
box before the toolbar means that the toolbar is turned on. The following
toolbars are available:

STANDARD DEFAULT:  CHECKED

Contains standard file and edit operations.

TRANSPORT DEFAULT:  CHECKED

Contains record and play operations.

STATUS DEFAULT:  UNCHECKED

Contains operations to set the display Status Format.

ACID DEFAULT:  UNCHECKED

Contains the ACID editing tools.
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SHOW TOOLTIPS DEFAULT:  CHECKED
The Show ToolTips check box turns on or off the help information box
displayed next to the mouse when it is held over certain items.

WAVE
Use this page to specify what wave devices Sound Forge XP should use for
recording and playback.

The capabilities of these devices may limit you from playing some files.

PLAYBACK
Specifies the device to be used when playing sound data.

Selecting a mapper device such as the Wave Mapper or Microsoft Sound Mapper allows
Windows to select an appropriate device to use for the current sound data.

RECORD
Specifies the device to be used when recording sound data.

Selecting a mapper device such as the Wave Mapper or Sound Mapper allows
Windows to select an appropriate device to use for the current sound data.

INTERPOLATE POSITION FOR INACCURATE DEVICES DEFAULT:  CHECKED
Specifies whether Sound Forge XP should interpolate the position of the play
or record position pointer during playback. If this option is not checked,
Sound Forge XP relies on the device driver for the sound card to provide the
correct position of the pointer during playback or record.

Many sound card drivers do not report their position accurately. If the
play/record position pointer does not move smoothly you should enable this
option. You may also want to contact your sound card manufacturer for
updated drivers.

If your sound card driver does not have accurate position reporting, your Mark
In/Out positions will also be off when dropping markers while playing.

POSITION B IAS ( -64 TO 64) DEFAULT:  0
Specifies an offset value that Sound Forge XP should add to the position values
returned by the sound card wave driver during recording or playback.

N O T E



Many sound card drivers do not report their position accurately. When you
play sounds back, the position of the play pointer may seem to lag or precede
the actual sound you are hearing. If this is the case, you may want to adjust this
value. Most sound card drivers that report incorrect position give a value ahead
of the actual sound.

To remove this bias, start with smaller values and work toward larger ones in
increments of 4 (a value of 1 is equal to 512 bytes) until the play position
pointer is accurate. Recommended settings are 4, 8, 16, and 32. These settings
correspond to the typical bias values for these drivers of -2048, -4096, -8192
and -16384 (negative multiples of 2048) bytes.

If your sound card driver does not have accurate position reporting, your Mark
In/Out positions will also be off when dropping markers while playing.

TOTAL BUFFER SIZE (KI LOBYTES) DEFAULT:  512
Select the amount of RAM you would like to use for buffering sounds during
play and record. Using a large value can optimize performance at high sample
rates but may also cause a slight delay starting playback.

PRELOAD SIZE (KI LOBYTES) DEFAULT:  0
Determines the total amount of wave data that will be queued to the sound
driver before playback starts.
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WINDOW MENU

NEW WINDOW
Use this command to create a new data window that will be given a generic
name. This command uses the sound parameters that were set when the New
dialog in the File menu was last used.

Shor tcut :
Control+Shift+N

CASCADE
Use this command to arrange the data windows so they overlap with the title
bar of each window remaining visible.

Shor tcut :
Shift+F5

TILE HORIZONTALLY
Use this command to arrange the data windows side by side without them
overlapping.



TILE VERTICALLY
Use this command to arrange the data windows top to bottom without them
overlapping.

Shor tcut :
Shift+F4

ARRANGE ICONS
Use this command to arrange the minimized data icons in the Sound Forge XP
workspace.

MINIMIZE ALL
Use this command to minimize all open data windows in the Sound Forge XP
workspace.

RESTORE ALL
Use this command to restore all minimized windows to their previous
window size and position.

CLOSE ALL
Use this command to close all open data windows in the Sound Forge XP
workspace.

All open files are listed at the bottom of the Window menu.The active
file is indicated by a check mark.

R E F E R E N C E
2 3 2

N O T E



R E F E R E N C E
2 3 3

HELP MENU

CONTENTS
Takes you to the online help table of contents.

Shor tcut :
F1

SEARCH FOR HELP ON
Search the online help index using key words. Related topics are linked.

KEYBOARD SHORTCUTS
Displays a list of shortcuts – and Sound Forge XP is loaded with them.

TROUBLESHOOTING
Use this before calling the Tech Support line.

TIP OF THE DAY
This command will bring up the Tip of the Day pages in the help file. These are
helpful and handy tips to increase your productivity with Sound Forge XP.



THE SONIC FOUNDRY HOME PAGE
This is a direct link to our home page on the World Wide Web. Invoking this
command automatically launches your default web browser and takes you to
the Sonic Foundry Home Page (www.sonicfoundry.com). Here you will find
downloadable demos and updates, technical information, and news of what’s
new with the folks at Sonic Foundry.

You can also send us comments, suggestions, questions, sound files, gossip,
whatever…via email from our web page. We’d love to hear how Sound Forge
XP is being used and your thoughts on how it can be improved.

ABOUT SOUND FORGE XP
Use this to display pleasantly puzzling information about Sound Forge XP, such
as the software license owner, copyright and system information, program
version and serial number, and the cool Sound Forge XP logo.
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APPENDIX A:
OPTIMIZING SOUND FORGE XP

This appendix contains information on configuring your system to maximize
Sound Forge XP’s performance. Sections include:

• Hard Drive Use

• Editing in Direct Mode

• Fast File Saving

• Setting up Wave Devices

• Playback Cursor and Record Counter

• Meters

• Background Processing

• Synchronizing Audio and Video

• Crash Recovery

HARD DRIVE USE
Sound Forge XP is a disk-based sound editor, which means that all editing
operations are performed on your hard drive rather than in your computer’s
memory. This allows Sound Forge XP to edit sound files of almost unlimited
size. Sound Forge XP also stores undo/redo information and clipboard data on
the hard drive.

The drive you specify for Temporary storage (on the Performance page of the Preference
folder, Options menu) must have enough free space to store the data for each
opened sound file, as well as undo/redo information, and the clipboard.
Although this can use a lot of disk space, it allows you to edit long sound files
that could never fit into your computer’s memory (RAM). Hard drives are also
typically much cheaper to add than memory.



Because Sound Forge XP is hard-drive intensive, the faster your disk access, the
faster Sound Forge XP will be. The easiest thing to do to improve your
performance without buying new hardware is to defragment your hard drive.
Over time, and especially with heavy use, a hard drive can become fragmented.
This means the data stored on the hard drive gets scattered across the surface
of the disk making your files noncontinuous. When files are noncontinuous,
the hard drive must jump around to retrieve the data.This jumping around can
slow down access to your files and can be very noticeable on older hard drives.
Windows 9x comes with a Disk Defragmenter utility that can be found in the
System Tools file in your Windows Program/Accessories folder.

WINDOWS 9X 
Choosing system configuration settings other than the default Windows 9x
settings can result in reduced performance from Sound Forge XP, as well as
Windows 9x. To check these settings, select the System icon from Windows
Control Panel and click the Performance page. File System and Virtual Memory should
both be set to 32-bit. In the advanced settings area of the window, click on File
System. In the File System Properties dialog, the Hard Disk tab setting for Read-ahead
optimization should be set to Full and the Troubleshooting tab should have all of the
settings unchecked.

Select Graphics for the Advanced Graphics Settings dialog. In most cases this setting
should be set to Full. If you are experiencing unexplained glitching in your
audio playback, try different settings. However, if changing these settings
doesn’t clear up the problem, change them back.

Finally, select Virtual Memory under Advanced settings of the Performance page. In
most cases, you should choose to let Windows 9x handle your virtual memory.

WINDOWS NT 
There are no special considerations for Windows NT.
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EDITING IN DIRECT MODE
Whenever you open a file in Sound Forge XP, a backup copy is created so that
the original file is not affected until you select to save your work. When you
open a file as read-only or direct, Sound Forge XP will not create a backup
copy of the file, which makes opening files quicker and uses less disk space. In
fact, editing in direct mode can make opening a file almost instantaneous.
Direct mode can only be used on files that are 16-bit and stored in the
Microsoft Wave format.

The first time you open a file in direct mode Sound Forge XP will scan the file
to create a peak file.This also allows Sound Forge XP to display the data in the
file extremely quickly.This peak file is stored in the same location as the wave
file with the same name as the wave file but with the extension .sfk. After a
peak file is created Sound Forge XP automatically keeps it updated when you
edit the file. The only time the peak file may need to be regenerated is if you
modify the file with an application other than Sound Forge XP. This allows
Sound Forge XP to instantaneously load the file next time you open it.

The only drawback to editing a file in direct mode is that you no longer have
the security of a backup file. In most cases this is not a problem, since all
changes can be undone (with ample disk space). But if, for some reason,
Sound Forge XP terminates improperly, the file would remain in its edited
state.

FAST F I LE SAVING
When creating a new file Sound Forge XP creates a temporary file that
contains all of your new sound data. When you are ready to save the file,
Sound Forge XP must copy this data into the file you specify in the Save As
dialog (File menu). If you are saving the sound data as a 16-bit Microsoft Wave
file, Sound Forge XP can make this process almost instantaneous by quickly
moving the file rather than copying the data to a new file. In order for this to
work, the new file into which you are saving your data must be on the same
drive as your temporary storage folder.Therefore, it is recommended that you
keep your temporary storage folder on the same drive where you keep most
of your sound files. You can set your Temporary storage folder on the Performance
page in the Preferences folder (Options menu).
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SETTING UP WAVE DEVICES

THE SOUND MAPPER/WAVE MAPPER
Sound Forge XP allows you to choose any installed Windows compatible sound
card for playback and recording. It also provides one more option for playback
and record called the Sound Mapper (depending on your configuration, this may
be called the Wave Mapper). The Sound Mapper is a special device that attempts to
select the most appropriate sound card (map) on which to play a sound. If this
card is not available, it will translate the sound into a format that can be played
on your sound card.

If you are having problems with breakups this may be caused by the overhead
introduced when the Sound Mapper does format conversions.To check this, make
sure that your sound card supports the data format you are playing or
recording.The easiest way to do this is to choose a playback and record device
that is not the Sound Mapper. If Sound Forge XP is able to play and record the
sound using the actual sound card’s Wave driver, then the Sound Mapper is not
causing the breakups.

However, if the Sound Mapper must be selected to play or record the format that
you are having trouble with, then you should convert your sound data to a
format that is directly supported by your sound card. This will remove all
overhead required to translate the sound data for your sound card.

There is nothing wrong with using the Sound Mapper when your sound card
directly supports the sound data format. The Sound Mapper will pass the data
through to your sound card, which requires negligible overhead. For more
information on the Sound Mapper, refer to Appendix E, Sound Forge XP and The
Microsoft Audio Compression Manager. The Sound Mapper is a component of the Audio
Compression Manager (ACM).

TOTAL BUFFER SIZE
The Total buffer size option, found in the Wave page of the Preferences folder
(Options menu), specifies the total amount of RAM that should be used for
buffering when recording to or playing from the hard drive. For most systems,
512 kb is the recommended size. If you are still experiencing gaps during
playback you may want to use more buffering or record at a lower sample rate.

A P P E N D I X  A
2 3 8



There are some drawbacks to increasing the Total buffer size. It requires more of
your computer’s memory and, if you have set a large Preload size, there can be
small delays when starting and stopping playback.

PRELOAD SIZE
The Preload size option in the Wave page (Preferences folder, Options menu), tells
Sound Forge XP how much sound data it should prepare and load into your
sound card driver before starting playback. This preloading is performed
between the time you press the Play button and the time you hear the sound play.

Turning this option on may help skipping (audible gaps) on initial playback
of a sound.These gaps usually occur with slow or fragmented hard drives.The
trade-off for enabling this option is a slight delay before play begins; the delay
time is greater for larger preload sizes. This option does not affect operations
other than playing.

Some Windows sound drivers do not support this option correctly. If you are
experiencing noise or dropouts at the very start of playback, try disabling
this option.

PLAYBACK CURSOR AND RECORD COUNTER
The playback cursor and record counter options in the Performance page
(Preferences folder, Options menu) allow you to configure whether or not the
numeric counters (position information displayed in status fields) will be
updated during playing and recording. If you are recording or playing at high
sample rates (44,100 or 48,000 Hz) and are experiencing gapping or skipping
problems in the data, try disabling the playback cursor and/or record counters
to decrease overhead.

METERS
The Record Meters in Sound Forge XP take a small amount of processing
overhead during recording. If you hear gaps in the sound while recording
and you have the Monitor option enabled in the Record dialog (Transport
command, Special menu), try turning off the Record Meters by clearing the
Monitor check box.

A P P E N D I X  A
2 3 9



BACKGROUND PROCESSING
When Sound Forge XP is performing operations that take a long time, such as
opening a file or performing audio processing, a Progress Meter is displayed on
the status bar. While this Progress Meter is visible, Sound Forge XP is doing its
work.You can cancel the operation at any time by pressing the Cancel button to
the left of the Progress Meter, or you can press the Escape key.

All processing performed by Sound Forge XP is done in the background. This
means you do not have to wait for Sound Forge XP to finish its work before
you can use other applications. If Sound Forge XP is taking a long time to
complete an operation you can switch to another application and work on
something else. Sound Forge XP will continue its processing task.

If you minimize Sound Forge XP while it is processing, the percentage
processed will update in the title of the Sound Forge XP icon.This allows you
to keep an eye on Sound Forge XP’s progress while using other applications.

Sound Forge XP displays the amount of time required to finish processing an
operation in the status bar.This processing time is only an estimate – this value
is not intended for accurate profiling. The accuracy of this processing time
value is heavily dependent on what other activity is being performed by your
computer while Sound Forge XP is working. Using other applications while
Sound Forge XP is working can cause the processing time to increase
substantially.

SYNCHRONIZING AUDIO AND VIDEO
If you are having trouble synchronizing the audio with your video, there are a
few points to keep in mind. If your video has been opened from a slow device,
such as a CD-ROM or network drive, then Sound Forge XP may have trouble
accurately playing back the audio and video in sync. This happens because
video information is streamed at all times from the original AVI file. You
should always copy the videos you are working with to a fast hard drive.
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After you open an AVI file you may be notified that your video has very few
key frames. This is generally representative of tutorial videos captured with a
program that saves the video as a Run Length Encoded (RLE) stream with a
single key frame. Due to non-linear access requirements of Sound Forge XP,
this may result in difficulty with audio synchronization. It is recommended
that you save your file with more key frames and re-open it for better
performance during digital editing.

Here are a couple of other tips that can help when trying to synchronize the
audio and video:

• After assembling or editing the audio you wish to use with your video,
place markers during video playback to correspond to any major
synchronization points. You can locate a particular frame by dragging the
cursor along the audio provided the Video Preview window is open or the
Animate Video Strip option is enabled. After primary locations have been
located, double-click and drag your audio to these markers bringing up
corresponding dialogs for mixes, pastes, and crossfades.

• Features like Insert Silence, Clear/Delete, and Time Compress/Expand are
commonly used to tighten synchronization.Another useful trick is to create
a region representing the delta between a video frame and audio event.
Then you can enable the Lock Region Length option and drag the delta region
to a preceding silent section. Use the region as a template for adjusting the
audio stream length by either copying and pasting to insert time, or
deleting to remove time.

CRASH RECOVERY
If for some reason Sound Forge XP terminates improperly, all the opened and
unsaved sound files can be recovered excluding those opened in direct and
read-only modes. Unless a file is opened in direct or read-only modes, a
temporary file is created and any edits made are stored in this file. When an
improper termination of the program occurs, these temporary files remain on
your hard drive and can be reopened to recover any work done to the sound
files before crashing.Also, the original sound files will remain unchanged until
you save your work.



CRASH RECOVERY
When restarting Sound Forge XP, any temporary files in your temporary file
directory will indicate to the program that something went wrong. Sound
Forge XP prompts you with the Crash Recovery dialog to either recover, delete or
ignore these files.

RECOVER
Use this to change the ending of all file names from FORGExxx.TMP to
FORGExxx.WAV.You can then open these WAV files using the Open dialog (File
menu).The files will be placed in the directory specified on the Storage page of
the Preferences folder (Options menu).

DELETE
This command deletes all the temporary files regardless of selection in the
drop-down list. Use this only when you are sure that no important work is in
the file.

IGNORE
If you don’t want to deal immediately with the temporary files left over from
an improper termination, use this command. However, it is best to either
rename the files and check their contents, or delete them, since they take up
valuable disk space.
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APPENDIX B:
TROUBLESHOOTING

This appendix provides answers to a number of frequently asked questions
about Sound Forge XP functionality. Subjects covered in this appendix are:

• Playing and Recording

• File Support

• Effects

• AVI Files

PLAYING AND RECORDING
WHEN PLAYING F ILES FROM MY SCSI  DR IVE,  WHY DOES THE SOUND HAVE A
WARBLING EFFECT? 

When playing files from a SCSI drive connected to a SCSI controller that
utilizes a DMA channel (such as most Adaptec controllers), you may
experience a warbling effect in the sound playback. This can occur if your
sound card uses DMA and the DMA channel is set to a higher number than
your SCSI controller.

To fix this problem, set the DMA channel used by your sound card to a lower
number than that used by your SCSI controller. For example, if your SCSI
controller is set to DMA channel 5 and your sound card is set to DMA channel
7, try reconfiguring them so the sound card uses DMA channel 5 and your SCSI
controller uses DMA channel 7.

WHEN I  START SOUND FORGE XP MY PLAY AND/OR RECORD BUTTONS/OPTIONS ARE
GRAYED OUT.  WHY CAN’T I  PLAY OR RECORD?

When Sound Forge XP starts, it checks to see if you have a wave playback and
record device installed in your system. If you don’t, it disables the operations
corresponding to these functions. If you are sure that you have a sound card
installed in your system, yet Sound Forge XP does not recognize this, first
check the Wave page in the Preferences folder (Options menu). The two relevant
settings are the Playback and Record drop-down list boxes. These options



determine the wave playback and record devices Sound Forge XP will use. By
default, Sound Forge XP uses the Microsoft Sound Mapper (it may also be
called the Wave Mapper) device.The Sound Mapper should automatically pick
an appropriate wave device for use by Sound Forge XP. If either the Playback
or Record device is set to (None) then Sound Forge XP can not execute the
corresponding operation.To learn more about configuring your wave devices,
refer to the Wave/Preference folder (Options menu) in chapter 6, Sound Forge XP
Reference.

I  HAVE SOUND F ILES THAT WON’T PLAY ON MY SYSTEM. SOUND FORGE XP LOADS
THEM − WHY WON’T IT  PLAY THEM?

Sound Forge XP allows you to load many different types of sound files,
including ones that your system may not be capable of playing. There are a
variety of reasons that your sound card may not be capable of playing a file.

• Some sound cards only allow playback and recording at specific sample
rates. Typically these rates are limited to 11,025, 22,050, and 44,100 Hz. If
you try to play a file with a sample rate of 32,000 Hz the sound card will
not allow you to play it.

• If you have an older sound card it may only support mono playback. If this
is the case, convert any stereo files to mono and you will be able to play
them. For more information on mono to stereo conversions, see chapter 4,
File Formats and Attributes.

• If you have an older sound card it may only support 8-bit playback. If this
is the case, simply change the sample size of the file from 16 to 8 bits
(Convert to 8-bit command, Process menu).

DURING PLAYBACK,  THE PLAY POINTER THAT SOUND FORGE XP DISPLAYS DOESN’T
SEEM TO CORRESPOND TO WHAT I ’M HEARING.  WHY?

For Sound Forge XP to display the current position of the pointer relative to
playback, it must rely on your sound card’s driver to provide the correct
position. Many sound card drivers don’t do a very good job of this. Typically
the position these cards provide is both off by a fixed amount as well as
reported only in large discrete steps. Sound Forge XP provides a way to
compensate for this by setting various options in the Wave/Preferences folder
(Options menu). Refer to this section in chapter 6, Sound Forge XP Reference, for
more information.
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WHY CAN’T I  GET SOUND FORGE XP TO RESPOND TO LEVELS FROM MY
MICROPHONE OR MY CD PLAYER?

Most sound cards come with multiple inputs from which you can record
sound. These may include microphone, CD, auxiliary, MIDI, and line inputs.
Although some cards record from all of these inputs at the same time, many
cards make you choose which device is currently your record device (also
known as the input source). These cards come with software that allows you
to pick which device is the input source.You will need to refer to your sound
card manual to determine how to set the input source.

Most sound cards also come with some kind of application that controls the
input level of the recording device.You may need to increase the level of your
input sources in order to record from them. Again, you will need to refer to
your sound card manual to learn how to adjust these levels.

WHEN I  RECORD OR PLAY F ILES I  HEAR WHAT SOUNDS LIKE SMALL CLICKS 
IN THE SOUND.

When Sound Forge XP is recording or playing audio data it moves large
amounts of data between your hard drive and your sound card. This can be a
tremendous amount of work for your computer depending on the kind of
system you have. If Sound Forge XP can’t move the data fast enough, you will
hear small gaps between blocks of data which typically sound like clicks or
puttering. For more information on ways to reduce the overhead during the
time Sound Forge XP is moving sound data, refer to Appendix A, Optimizing
Sound Forge XP.

WHEN I  RECORD (OR PLAY)  DATA AT H IGH SAMPLE RATES,  I  CAN’T  GET SOUND
FORGE XP TO STOP BY PRESSING THE STOP BUTTON.

Sound Forge XP tries very hard to keep recording and playback of audio
smooth (no gaps in your sound). As a result, there may be delays between the
time that you press the Stop button and the time that Sound Forge XP actually
stops recording or playing. Note that you can always press and hold the Escape
key to stop record or playback. Just be a little patient and wait a few seconds.
These delays are usually only observed when one or more components of your
system can not keep up with the data rate. Problems typically stem from:

• Very slow (older) hard drives.

• Poorly written sound card drivers.
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• Setting your Storage directory to a slow device like a network drive or a
Compressed hard drive.

If at all possible, use the fastest uncompressed storage device available with
Sound Forge XP. For more information on configuring your system, see
Appendix A, Optimizing Sound Forge XP.

WHEN PLAYING SOUND F ILES WITH RATES ABOVE 44,100 HZ ON MY TURTLE BEACH
MULTISOUND OR TAHITI ,  MY SYSTEM CRASHES.

This is caused by a severe bug in the Turtle Beach Multisound and Tahiti sound
card drivers.You will experience the same crash no matter what software you
use to play sample rates above 44,100 Hz–including Media Player and even
Turtle Beach’s own Wave application. Contact Turtle Beach for updated drivers.

WHEN PLAYING SOUND F ILES AT 8 ,000 HZ ON MY TURTLE BEACH MULTISOUND,  THE
PLAY POINTER MOVES BUT I  DON’T HEAR ANY OUTPUT.

A bug in the Turtle Beach Multisound driver causes this. Contact Turtle Beach
for an updated driver.

WHEN PLAYING SOUND F ILES AT RATES OTHER THAN 11,025 HZ,  22 ,050 HZ,  OR
44,100 HZ THE F ILES SOUND WRONG (THE P ITCH IS  WRONG).

Some sound drivers incorrectly play sounds with sample rates that are not
supported by the sound card hardware. For example, a sound that is supposed
to play at 13,000 Hz might get played at 11,025 Hz instead.This will cause the
pitch to be lower and the playback time to be slower than it should be. The
Microsoft Windows Sound System Version 2.0 and many “compatible” sound
cards contain this unfortunate bug. Contact your sound card manufacturer for
updated drivers.

WHEN PLAYING AUDIO F ILES,  SOMETIMES WHEN THE SOUND STARTS I  HEAR A BLIP,
DROPOUT,  OR CLICK.

Some sound drivers do not deal correctly with the pre-load buffer option of
Sound Forge XP. If you have set your pre-load size in the Wave/Preferences folder
(Options menu) to a value greater than 0, try setting it back to 0. If this solves
the problem, then you have a driver that does not deal with this situation
correctly. Contact your sound card manufacturer for updated drivers.
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F ILE SUPPORT
WHEN SAVING F ILES AS MACINTOSH AIFF AND TRANSFERRING THEM TO MY
MACINTOSH,  WHY DOESN’T THE MACINTOSH RECOGNIZE THEM AS SOUND F ILES?

The Macintosh uses special information within its operating system to keep
track of the types of files it can access. Sound Forge XP for Windows can save
the audio data in the correct file format, but it can’t tell the Macintosh what
type it is. To do this you must use a program on the Macintosh, like ResEdit,
which allows you to change the file’s Type. Set the Type field to AIFF for the
Macintosh to recognize the file as a sound file.

WHY WON’T SOUND FORGE XP OPEN MY COMPRESSED F ILES LIKE 
MICROSOFT ADPCM?

Sound Forge XP has built-in support for the Microsoft Audio Compression
Manager (ACM). This allows you to open files that are compressed with a
variety of algorithms including Microsoft ADPCM, IMA ADPCM, and other
third party compression schemes like The DSP Group’s TrueSpeech.

If you can’t open a Microsoft ADPCM file, you may not have the Microsoft
ADPCM driver installed and enabled for the ACM. Refer to Appendix E, Sound
Forge XP and The Microsoft Audio Compression Manager for more information on how
to use the ACM with Sound Forge XP.

AFTER CONVERTING WAV F ILES TO RED BOOK AUDIO USING THE SOFTWARE THAT
CAME WITH MY COMPACT DISC RECORDER,  THERE ARE AUDIBLE CLICKS AT THE END
OF THE TRACK.

Not all software for converting WAV files to Red Book audio handles the WAV
file structure correctly. Some software skips the first 44 bytes of data in the
WAV file and then considers everything else in the file to be audio data. This
means that if you have saved Summary Information in the WAV file it will be
interpreted as audio data.

If you are experiencing this problem, use the Save As command (File menu) in
Sound Forge XP to save a new WAV file with the Save Summary Information box
unchecked. This tells Sound Forge XP to save only the minimum amount of
information needed for a WAV file.
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MY COMPACT DISC RECORDER USES A F I LE TYPE WITH AN RBK EXTENSION.  WHAT IS
AN RBK F ILE AND CAN I  OPEN IT  WITH SOUND FORGE XP?

RBK files are raw PCM sound data files. These files are used by some compact
disc recorders to store Red Book audio onto a compact disc. RBK files are data-
only and contain no other information. They are stored as 16-bit, stereo data
with a sample rate of 44,100 Hz.There are a number of things that make them
different than a normal 16-bit raw file:

• The channels are stored in reverse order

• The data is stored in Big Endian format (Motorola)

• The data length of the file has to be a multiple of 2,352 bytes (1 CD sector).
The size of a CD sector is calculated as follows:

1 second of 44.1k, 16 bit, stereo audio = 176,400 bytes

CD audio has 75 sectors of data for each 1 second of audio

Sector size = 176,400/75 = 2,352 bytes

To open an existing RBK file, use the Raw File type in Sound Forge XP’s Open
dialog (File menu) and select the RBK preset. Remember that you will have to
swap the channels if you want to maintain the correct left/right channel
settings.

EFFECTS
WHY DO SOME EFFECTS TAKE SO LONG TO PROCESS?

Some processing functions used by Sound Forge XP are very math intensive.
Examples include EQ and the reverb effect.This means that millions of integer
and floating-point arithmetic operations must be performed for each second
of sampled data. Even with a powerful, co-processing  machine, high
resolution sound editing can tax a system resources.

Of course, running effects on stereo, 44,100 Hz, hour-long files will slow any
system. If you are going to be deleting or inserting space into these huge files,
it is more effective to break the files into smaller ones and then mix the
smaller files together once you are done processing them.This can be especially
necessary when you insert or delete from the beginning of a large file, since
Sound Forge XP must shift the entire file over during processing.
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AVI  F I LES
WHEN OPENING AN AVI  F I LE ,  I F  THE AUDIO STREAM FORMAT IS  44.1  KHZ STEREO
F ILE MICROSOFT OR IMA ADPCM, THE AUDIO TRACK DOES NOT OPEN CORRECTLY.

This is due to a known bug in Video for Windows. It only happens if the file is
both 44.1 kHz, stereo, and compressed using Microsoft ADPCM.To get around
this problem, resample the audio to 22 kHz before saving (Resample dialog,
Process menu).
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APPENDIX C:
SHORTCUTS

This appendix contains a list of available shortcuts including:

• Keyboard Shortcuts

• Shortcut Menus

• Drag and Drop Shortcuts

• Other Mouse Shortcuts

KEYBOARD SHORTCUTS
The following is a comprehensive list of keyboard shortcuts available in Sound
Forge XP.

GENERAL KEYBOARD SHORTCUTS

F ILE COMMANDS

PRESS TO

Alt+Enter Show the Properties folder for the active data
window

Control+N Create a new data window

Control+O Open a sound file into a new data window

Control+S Save modified sound data back to the file

Control+W Close the active data window

Alt+F4 Exit Sound Forge XP



DATA WINDOW MANAGEMENT COMMANDS

PRESS TO

Alt+F10 Maximize the Sound Forge XP application window

Control+F5 Restore the active data window

Control+F6 Go to the next data window

Control+F10 Maximize the active data window

Control+Shift+F6 Go to the previous data window

Shift+F4 Tile the data windows vertically

Shift+F5 Cascade the data windows

EDIT COMMANDS

PRESS TO

Control+A Select all data in the active window

Control+C Copy the selected data onto the clipboard

Control+E Paste the clipboard contents into a new data
window

Control+F Crossfade data from the clipboard with the
active window

Control+M Mix data from the clipboard with the active
window

Control+T Trim (crop) to the current selection

Control+U Toggle Undo buffer creation for the active window

Control+V Paste data from the clipboard into the active
window

Control+X Move (cut) the selected data onto the clipboard

Control+Y Repeat last process, effect or tool

Control+Z Undo the last action

Control+Shift+Z Redo the last undone action

Delete Clear (delete) the selected data; nothing placed
on the clipboard
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ACID LOOPING TOOLS

PRESS TO

Semi-Colon Halve the currently selected area.

Apostrophe Double the current selection.

Less Than Symbol Shift the highlighted portion of a track left the
exact distance of the highlighted selection.

Greater Than Symbol Shift the highlighted portion of a track right the
exact distance of the highlighted selection.

Colon Move the selected audio at the beginning or end
of the file to the other end of the file.

MISC.  VIEW,  OPTION AND SPECIAL COMMANDS

PRESS TO

S Toggle current selection on and off

Control+Enter Maximize the width of the active data window

Control+D Show the Set Selection dialog

Control+G Show the Go To dialog

Control+R Record new data into a data window

Escape Stop or cancel the current action (including
playback)

F1 Open the Sound Forge XP Help file to the
Contents page

F10 Make the menu bar active

Shift+F10 Display a shortcut menu

F6 Toggle playback scrolling on and off

F8 Toggle drag and drop snapping on and off
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WAVEFORM DISPLAY KEYBOARD SHORTCUTS

CURSOR MOVEMENT

PRESS TO MOVE TO

Right Arrow The next screen pixel

Left Arrow The previous screen pixel

End The last sample visible in the waveform display

Home The first sample visible in the waveform display

Control+End The last sample in the data window

Control+Home The first sample in the data window

Page Up 10% of the current view previous to the cursor
position

Page Down 10% of the current view past the cursor position

Control+Right Arrow 2% of the current view past the cursor position

Control+Left Arrow 2% of the current view previous to the cursor
position

Numpad + The next sample

Numpad - The previous sample

Control+Numpad + 10 samples past the current cursor

Control+Numpad - 10 samples previous to the current cursor

Due to a limitation in Windows 95, the last two commands work only
in Windows NT.

Control+ Left Arrow The previous region or marker boundary

Control+ Right Arrow The next region or marker boundary 
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SELECTING DATA

PRESS TO SELECT FROM THE CURSOR TO

Shift+Right Arrow The next screen pixel

Shift+Left Arrow The previous screen pixel

Shift+End The last sample visible in the waveform display

Shift+Home The first sample visible in the waveform display

Control+Shift+End The last sample in the data window

Control+Shift+Home The first sample in the data window

Shift+Page Up 10% of the current view previous to the cursor
position

Shift+Page Down 10% of the current view past the cursor position

Control+Shift+Right Arrow 2% of the current view past the cursor position

Control+Shift+Left Arrow 2% of the current view previous to the cursor
position

Shift+Numpad + The next sample

Shift+Numpad - The previous sample

Control+Shift+Numpad + 10 samples past the current cursor

Control+Shift+Numpad - 10 samples previous to the current cursor

Due to a limitation in Windows 95, the last four commands work only
in Windows NT.

Control+Shift+Left Arrow The previous region or marker boundary

Control+Shift+Right Arrow The next region or marker boundary
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NAVIGATION AND PLAYBACK

PRESS TO

Up Arrow Increase time magnification (zoom in closer to
data)

Down Arrow Decrease time magnification (zoom out farther
from data)

Shift+Up Arrow Increase level magnification

Shift+Down Arrow Decrease level magnification

Control+Up Arrow Zoom Selection if a selection exists, Zoom In
Full if no selection

Control+Down Arrow Zoom Normal (zooms to default zoom ratio set
in Preferences/Options menu)

Control+Shift+Up Arrow Pan data window up if zoomed in vertically

Control+Shift+Down Arrow Pan data window down if zoomed in vertically

Numpad 5 or * Switch cursor to opposite end of selection

Due to a limitation in Windows 95, the last command works only in
Windows NT.

Tab Cycle stereo selection from left channel to right
channel to both channels

Shift+Tab Cycle stereo selection from both channels to
right channel to left channel

[ (open bracket) Set Mark In at the current cursor position

] (open bracket) Set Mark Out at the current cursor position

C or . (period) Center the cursor in the waveform display

Spacebar Play or Stop the current data window in default
mode

Shift+Spacebar Play All or Pause the current data window

Control+Spacebar Switch play mode between Normal and Looped 
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Enter Pause playback; keep the cursor at the current
position

Escape Stop playback of the current data window

REGIONS LIST SHORTCUTS

PRESS TO

Spacebar Play or Stop the active marker or region

Enter Edit the active marker or region

Delete Delete the active marker or region

` (grave accent) Cycle through the Regions List display formats

R Create region from the current selection

Shift+R Create region without bringing up dialog

SHORTCUT MENUS
Shortcut menus are menus that appear when you click on certain areas of the
screen.They allow you to quickly access important functions.

SOUND FORGE XP DESKTOP SHORTCUT MENU
This shortcut menu is reached by right-clicking on the desktop workspace of
Sound Forge XP. This menu has options for sound file management on your
workspace. You can open recently used files from the Recent Files option. The
Preferences folder can quickly be reached from this menu as well.

WAVEFORM DISPLAY SHORTCUT MENU
This shortcut menu is reached by right-clicking on the waveform display of a
sound file. It is a way of quickly reaching the following commands and dialogs:
Zoom In Full/Normal/Out Full, Paste, Crossfade, Mix, Go To, Selection, Scroll Playback,
Properties.



PLAYBAR SELECTION STATUS SHORTCUT MENU
This shortcut menu is reached by right-clicking on any of the playbar’s
selection status fields. It allows you to set the current status format (Samples,
Time, Seconds, Time & Frames, Absolute Frames, Measures & Beats, SMPTE Non-Drop/Drop,
SMPTE EBU, SMPTE Film Synch).

TIME RULER SHORTCUT MENU
This shortcut menu is reached by right-clicking on the Time Ruler. It allows
you to change the status format (Samples, Time, Seconds, Time & Frames,
Absolute Frames, Measures & Beats, SMPTE Non-Drop/Drop, SMPTE EBU,
SMPTE Film Synch) and display the Add Marker/Region dialog.

REGIONS LIST SHORTCUT MENU
This shortcut menu is reached by right-clicking on the Regions List. It allows you
to perform the following Regions List operations: Add, Delete, Edit, Replicate, Update,
Copy onto Clipboard.

MARKER TAG SHORTCUT MENU
This shortcut menu is reached by right-clicking on a marker tag in the ruler.

GO TO
Moves the cursor to a marker position.

DELETE
Removes a marker from the Regions List.

EDIT
Takes you to the Edit Region/Marker dialog.

UPDATE
Changes a marker to the current cursor position.

REGION TAG SHORTCUT MENU
This shortcut menu is reached by right-clicking on a region tag in the ruler.
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SELECT
Makes the selection equal to the region end points.

DELETE
Removes the region from the Regions List.

EDIT
Takes you to the Edit Region/Marker dialog.

UPDATE
Makes region end points equal to the current selection.

DISPLAY PROPERTIES SHORTCUT MENU
This shortcut menu is reached by right-clicking on the Edit Tool selector at the
upper left-hand corner of the data window. It allows you to set options
described under Properties/Display in the File Menu.

LEVEL RULER SHORTCUT MENU
This shortcut menu is reached by right-clicking on the Level Ruler. It allows you
to change the labeling used, as well as various level zooming operations.

ZOOM OUT FULL
Zooms out vertically to view the maximum amplitude range.

ZOOM WINDOW
Zooms vertically to optimally fit the entire waveform display.

ZOOM SELECTION
Zooms vertically to optimally fit the current selection.

LABEL IN PERCENT
When checked, the Level Ruler will be labeled in percent.



LABEL IN DB
When checked, the Level Ruler will be labeled in decibels.

STATUS BAR SHORTCUT MENUS
These shortcut menus allow you to change the playback rate, sample size,
channels (Stereo/Mono), and status format (Samples, Time, Seconds, Time &
Frames, Absolute Frames, Measures & Beats, SMPTE Non-Drop/Drop, SMPTE
EBU, SMPTE Film Synch) by right-clicking on the status bar fields.

RECORD DIALOG SHORTCUT MENU
This shortcut menu is reached by right-clicking anywhere in the Record dialog.
A similar shortcut menu is available in the Remote Record dialog. Some options
on these menus are not available in the dialog.

RECORD METERS
Allows you to set the record meter range and other options (Reset Clip, Show
Labels,Hold Peaks/Valleys,Aggressive Update). Refer to the Transport command (Special
menu) in chapter 6, Sound Forge XP Reference, for more information.

BLINKING STATUS
Enables the blinking record status underneath the record meters.

VIDEO STR IP SHORTCUT MENU
This shortcut menu is reached by right-clicking on the video strip above the
waveform display.

COPY
Copies the selected frame as a bitmap to the clipboard.You could, for example,
then paste it into the Summary page (Properties from the File menu) by right-
clicking over the shot you want to copy.

GO TO
Moves the cursor to the beginning of the frame.
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ANIMATE
Displays the frame closest to the cursor position.

NUMBER FRAMES
Displays frame number on each frame.

VIDEO PREVIEW SHORTCUT MENU
This shortcut menu is reached by right-clicking on the Video Preview window. It
allows you to set various options of the video display. For a complete list and
explanation of these options, refer to the Video command (Options menu) in
chapter 6, Sound Forge XP Reference.

DRAG AND DROP SHORTCUTS
Using drag and drop allows you to quickly perform operations crossing
between open data windows.

DRAG TO NEW
To create a new file from the current selection, drag the selection to an open
area of the Sound Forge XP desktop.

DRAG MIX
To mix a selection into another data window, drag the selection from the
source to the destination window. Processing begins at the point where you
drop the region in the destination file. When mixing a mono selection into a
stereo file, you can mix the selection to both channels by dropping the
selection on the destination centerline. Otherwise, the selection will be mixed
into either the left or right channel only.

DRAG CROSSFADE
To crossfade a selection into another data window, drag the selection from the
source to the destination window. Press the Control key while holding the
cursor in the destination window. Processing begins at the point where you
drop the region in the destination file.When crossfading a mono selection into
a stereo file, you can crossfade the selection to both channels by dropping the



selection on the destination centerline. Otherwise, the selection will be
crossfaded into either the left or right channel only.

DRAG PASTE
To paste a selection into another data window, drag the selection from the
source to the destination window. Press the Alt key while holding the cursor in
the destination window. Processing begins at the point where you drop the
region in the destination file.When pasting a mono selection into a stereo file,
you can paste the selection to both channels by dropping the selection on the
destination centerline. Otherwise, the sound data will be placed in either the
left or right channel only, with silence in the other.

DRAG TO REGIONS LIST
To add the current selection to the Regions List, drag it to the Regions List.

OTHER MOUSE SHORTCUTS

SELECT ALL
Double-click on the waveform display to select the entire sound file. Triple-
click if Regions and Markers exist in the file.

ZOOM BOTH TIME AND LEVEL
Double-click on the Level Ruler to zoom the current selection both vertically
and horizontally. If no selection exists, the entire waveform display data is
zoomed. Double-click again to Zoom Out Full vertically and Zoom Normal
horizontally.

MAGNIFY MODE
To zoom in to a section, select an area while holding the Control key. This will
switch Sound Forge XP to Magnify mode, which zooms to fit the selected area.

RETURN CONTROL VALUE TO DEFAULT
Double-click on a trackbar, fader, or spinner to set it to its default value.
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F INE TUNE CONTROL VALUE
To fine tune a trackbar, fader, or spinner, hold down both right and left mouse
buttons when dragging.This can also be done if you hold down the Control key
while dragging.

MAIN STATUS BAR
Double-click on the Sample Rate, Sample Size, or Channels (Stereo/Mono)
field to reach the Properties folder.

SELECTION STATUS BAR
Double-click on the Selection Left field to reach the Go To dialog. Double-click on
the Selection Right and Selection Length fields to reach the Set Selection dialog.

GO TO MARKER
Double-click on a marker tag in the ruler to move the cursor to the marker’s
position.

SET SELECTION TO REGION
Double-click on a region tag in the ruler to change the current selection to the
region end points.

EDIT REGION OR MARKER
Double-click on a region or marker in the Regions List to reach the Edit
Marker/Region dialog.

SLOW AND FAST SELECTION SCROLL TOGGLE
When making a selecting past the end or beginning of the waveform display,
while holding down the left mouse button, click on the right mouse button to
toggle between fast scrolling and slow scrolling.
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APPENDIX D:
SOUND FORMATS

The file formats recognized by Sound Forge XP are listed below along with the
extension used to identify them to the user. An arbitrary extension has been
assigned for each of the formats used by computers other than the PC. Many
of these formats when found on another type of computer will tend to use the
extension SND. Thus, even if a file has the SND extension it may not be a
Sounder/SoundTool file.

Indicates this file format supports the saving of sample looping
information.

Act ive Streaming Format  ( .ASF)

This Microsoft format lets you send multimedia content over the Internet in
real time.The ASF format is for use with the Microsoft NetShow Player.

Ad Lib Sample ( .SMP)

This format is used by the Ad Lib Gold card, for its sampled instruments. It
supports 8-/16-bit, stereo/mono, and 4-bit Yamaha ADPCM compression.

Amiga SVX ( .SVX/ . I FF)

This file type is found on the Commodore Amiga and is similar in substance
to the Microsoft RIFF Wave format.

Covox V8 ( .V8)

This format is used with Covox software. It is an 8-bit mono uncompressed
file format.



Creat ive Labs VOC ( .VOC)

This is one of the more common sound formats on PC-compatible computers.
The VOC format supports packed data that Sound Forge XP will unpack prior
to importing the file. The VOC format also supports information for silence,
looping, and varying sample rates.When Sound Forge XP imports a VOC file it
uses the first sample rate found and ignores such information as looping and
silence. Sound Forge XP will save VOC files as unpacked data with none of the
additional information such as looping or silence. Sound Forge XP gives you
the ability to save VOC files in either the old or new VOC standard. The new
VOC standard supports 16-bit data. Refer to the Preferences section (Options
menu) in chapter 6, Sound Forge XP Reference, for information on configuring
Sound Forge XP to always use the new VOC standard.

Dialog ic  VOX ( .VOX)

This format is used with specialized voice data boards. It is a 4-bit mono
ADPCM file format that expands to 16-bit data.

Gravis  Patch ( .PAT)

This format is used by the Gravis UltraSound Card. Sound Forge XP can only
read and write Gravis Patch files which have single samples stored in them.
Patch files with multiple samples are not recognized. Sound Forge XP
recognizes Gravis Patch version 1.10 files. Older versions, such as 1.00, are not
supported.

InterVoice ( . IVC)

This file format is for use with Intervoice telephony systems. It is a mono
format with a variety of compression schemes available.

Macintosh AIFF ( .AIF/ .SND)

This format is used on the Apple Macintosh to save sound data files. An AIFF
file is best when transferring files between the PC and the Mac using a
network, since most network software will delete any resource information in
a Macintosh file. Sound Forge XP can also read an AIFF with a Mac binary
header attached but will identify the file as a Macintosh Resource instead.
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Macintosh Resource ( .SND)

This format is used on the Apple Macintosh to save sound resources. When
reading a file of this type it must have a Mac-Binary header. This header is
attached to binary files transferred with common Macintosh file transfer
programs. Sound Forge XP does not save to this file format.

MIDI  SDS ( .SDS)

This format is a file that contains the exact data that would be transferred to
a sampler when using the MIDI Sample Dump Standard (SDS) protocol. It is
a series of MIDI SysEx messages. MIDI SDS supports mono files only.

NeXT/Sun ( Java) ( .AU/.SND)

This is the standard format of sound files found on the NeXT and Sun Sparc
station computers. This format has a large number of sub-types of file data.
Sound Forge XP reads and writes the most common data formats for these
files, 8-bit linear, 16-bit linear, and µ-Law.

RealMedia ( .RM/.RA)

These are compressed formats designed for real-time audio and video
streaming over the Internet.

SampleVis ion ( .SMP)

This format is used with Turtle Beach’s SampleVision software. It is a 16-bit
mono file format.The SMP format is for use with sampling keyboards.

Sonic  Foundry Sample Resource ( .SFR)

This format is an old format defined by Sonic Foundry and is supplied for
compatibility. It is not recommended for use in saving files.

Sound Designer  1 ( .DIG/ .SD)

This format is used by Sound Designer 1.

Sounder/SoundTool ( .SND)

This format is used with the shareware applications Sounder and Sound Tool.
It is very popular on bulletin boards and various online services.
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Video for  Windows ( .AVI)

This is a Microsoft digital video file format. It supports multiple channel
audio, but Sound Forge XP will only allow you to open one audio and one
video stream at a time.When saving as an AVI file, many compression schemes
are available for both the video and audio streams.

Wave (Microsoft )  ( .WAV)

This is the format for sampled sounds defined by Microsoft for use with
Windows. It is an expandable format that supports multiple data formats and
compression schemes.

Raw Fi les ( .RAW/.*)

Raw files can be composed of any sound data. If the data is any form of 8- or
16-bit PCM (uncompressed) or G.711 A-Law or µ-Law (a form of companded
compression), then Sound Forge XP can open and save the file.
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APPENDIX E:
SOUND FORGE XP AND 
THE MICROSOFT AUDIO
COMPRESSION MANAGER

THE AUDIO COMPRESSION MANAGER (ACM)
The Microsoft Audio Compression Manager (more commonly referred to as the ACM)
is a standard interface for audio compression and filtering tool in Windows.
This interface allows applications like Sound Forge XP to use compression and
filtering algorithms provided by other companies.

Sound Forge XP fully supports audio compression and filtering through the
ACM. This enables you to use any ACM-compatible compression and filter
driver.The best part of this support is you don’t have to learn anything new to
use it! Sound Forge XP transparently opens compressed WAV files and provides
all available compression formats for WAV files in the Save As dialog (File
menu). No Import or Export commands are necessary.

There are roughly three pieces to the ACM (though these pieces are tightly
coupled). It is not necessary for you to know any details about these pieces to
use the ACM from Sound Forge XP, so this information is supplied for those
who want to know more.The three pieces of the ACM are:

• Audio data compression and decompression

• Audio data filtering (Digital Signal Processing)

• Transparent playback and recording of non-hardware supported audio files

AUDIO DATA COMPRESSION AND DECOMPRESSION
The first piece of the ACM allows you to compress and decompress audio data.
Audio compression is used to decrease the amount of data required to
represent a sound; this ultimately results in smaller sound files. However, there
are drawbacks to using audio compression on your sound files:



• Most audio compression algorithms will degrade the quality of the sound.
This is referred to as lossy compression since information contained in the
sound is lost when it is compressed. The amount of sound degradation is
dependent on the algorithm.

• Audio compression requires more processing time than uncompressed data.
The amount of processing time is dependent on the algorithm as well as
your hardware setup. As a result, opening and saving compressed files
usually takes longer than uncompressed files.

• Compressed files are not as portable as uncompressed files. If you are
distributing WAV files in a compressed format, you must make sure the
person receiving the files can use them. Also, not all audio software can use
compressed WAV files, which could make using other programs with Sound
Forge XP inconvenient.

In Sound Forge XP, any compressed WAV file can be opened as long as a
compatible ACM driver is installed and enabled. If there is no compatible ACM
driver available for a compressed WAV file, Sound Forge XP will inform you of
the problem when you try to open it.

Saving compressed WAV files is as simple as choosing the compression
algorithm in the Format drop-down list of the Save As dialog. Once a file has
been saved as compressed, Sound Forge XP will always save changes to the file
using the selected compression algorithm; you do not need to re-select the
compression format each time you save. Of course you can change the
compression format at any time with the Save As dialog.You can also revert to
an uncompressed format.

Experimentation is probably the most important step in deciding whether or
not to use audio compression for your projects.

AUDIO DATA F ILTERING (DIGITAL SIGNAL PROCESSING)
The second piece of the ACM provides access to Digital Signal Processing (DSP)
algorithms. The ACM refers to these DSP algorithms as Filter drivers, though the
term Filter in this context is more generic than just frequency filtering (like
Graphic EQ). An ACM Filter can implement almost any type of audio DSP
algorithm. Reverb, distortion, and time change are just a few of several
possibilities.
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Sound Forge XP does not come with any ACM Filters; you must obtain them
from other sources. However, since the ACM Filter architecture is fully
documented by Microsoft, it is possible that many types of filters will become
available on BBSs and other places for use with Sound Forge XP. If any ACM
Filters are installed in your computer, you will see the ACM Filter option under
the Tools menu.

Sound Forge XP allows you to use any ACM Filter installed and enabled on your
computer to process sound files. Select the ACM Filter option under the Tools
menu to choose the filter and its attributes that you wish to apply to your
sound data.The ACM Filter tool works exactly like all other Sound Forge XP DSP
functions, including the option to save presets and set custom selections.

TRANSPARENT PLAYBACK AND RECORDING OF 
NON-HARDWARE SUPPORTED AUDIO F ILES
The third part of the ACM is probably the most significant. It is called the Sound
Mapper and allows audio data formats that are not directly supported by your
sound card to be played and recorded. Sound Forge XP lets you use the Sound
Mapper by selecting it for Playback and Record in the Wave page of the Preferences
folder (Options menu). Additional configuration of the Sound Mapper for your
system can be done using the Windows Control Panel.

If the ACM is not installed on your computer, the Sound Mapper option will be
called the Wave Mapper instead.The Wave Mapper and Sound Mapper can be thought
of as the same device (to a computer program, they are one and the same).
However, the Sound Mapper, which requires the ACM to be installed, is much
more powerful than the Wave Mapper. Keep this in mind when you hear people
talk about the Wave Mapper and Sound Mapper.

So, what, for example, can Sound Mapper do? If you have a sound file that is
recorded at an unusual sample rate like 22,257 Hz (perhaps a file that came
from an external sampler), and the closest sample rate that your sound card
supports is 22,050 Hz, then the sound file normally could not be played.You
would have to change the sample rate of the file to 22,050 Hz before you
could play it. However, changing the sample rate (without resampling) would
cause the sound to play at a lower pitch. The Sound Mapper can play this sound
file correctly without forcing you to resample the file first. The Sound Mapper
will map the sound to the best format possible and perform the resampling in
real time.
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Other examples include the ability to play 16-bit sounds on an 8-bit-only
sound card, or playing stereo sounds on a mono-only sound card.You can also
record stereo files on a mono-only sound card. However, this last example is
essentially useless because the Sound Mapper will duplicate the mono input of
your sound card in both channels. So keep in mind that the Sound Mapper cannot
create something that is better than what the sound card can supply.

The usefulness of the Sound Mapper for non-compressed sound files can be
summarized as convenience. You don’t have to convert the sound to a
supported format before you listen to it. Some of the tasks that the Sound Mapper
can perform (like format conversions while recording) are available not
because they are useful in real world situations, but because the developers of
the ACM knew it could be done. Much like climbing a mountain for no better
reason than it’s there.

So what about compressed sound files? The Sound Mapper allows you to play (and
sometimes record) compressed sound files. Even on sound cards that do not
support compression directly. So you can play a sound file that is compressed
with Microsoft ADPCM or The DSP Group’s TrueSpeech on any sound card
without decompressing the sound file first. Many multimedia and
entertainment software titles use compressed sound files to save disk space.The
software then plays the files through the Sound Mapper.

Above we mentioned that Sound Mapper can sometimes record compressed
sound files.The reason for this (even when the compressed file can be played)
is simple. Compressing sound data can be very computationally expensive (it
takes a long time); the amount of time required is completely dependent on
the compression algorithm and how it is implemented. Decompressing sound
data is almost always faster than compressing the same sound data, which
makes it possible to play it back in real time.

It should be noted that Sound Forge XP does not play and record compressed
sound files directly. Rather, all compression and decompression is performed
while opening and saving the sound files. This limitation is actually
insignificant; Sound Forge XP is the perfect tool for authoring compressed
sound files for the ACM and many software authors are using Sound Forge XP
for exactly this. Sound Forge XP saves compressed sound files using the best
quality possible – something that cannot always be done in real time. So saving
compressed sound files with Sound Forge XP will usually sound better than
those recorded with audio compression.

A P P E N D I X  E
2 7 2



A P P E N D I X  E
2 7 3

Notes on Sound Forge XP’s sound file compression support:

• The Open dialog (File menu) allows you to preview compressed WAV files if
you have an appropriate ACM driver installed. However, you must have your
Playback device set to the Sound Mapper for this to work (Preferences/Wave in the
Options menu).

• When saving uncompressed audio data to a compressed format with the
Save As dialog (File menu), it is a good idea to close the file and re-open it
after saving. Since Sound Forge XP does the compression and
decompression during saving and loading you will not be able to hear what
the file sounds like with compression until after you’ve saved and reloaded
the file.

SETTING UP THE AUDIO COMPRESSION MANAGER 
The Microsoft Audio Compression Manager is part of Windows 9x and NT. If
you are running Windows 3.x, Sound Forge XP will install Video for Windows in
your computer, which also installs the ACM.

In Windows 9x, to view the installed audio compression and decompression
drivers, go to Control Panel/Multimedia/Advanced/Audio Compression Codecs. Double-
clicking on any of the codecs allows you to enable or disable each one.
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APPENDIX F :
OBJECT LINKING AND 
EMBEDDING (OLE)

Sound Forge XP supports Microsoft’s Object Linking and Embedding (OLE) technology
for improved integration with other applications. This appendix discusses the
implementation details and different uses for the OLE technology supported
by Sound Forge XP.The following topics are covered:

• Introduction to Object Linking and Embedding (OLE)

• Using OLE with Sound Forge XP

• Tips and Limitations

INTRODUCTION TO OLE
Object Linking and Embedding (OLE) is a technology developed by Microsoft to allow
independent applications to behave as though they are tightly integrated. Note
that this is not an all-encompassing definition, but it will work for the
implementation provided by Sound Forge XP. If you would like a more in
depth look at OLE, there are many references available at most bookstores that
discuss the technology.

By using the OLE support in Sound Forge XP, you can embed digital audio files
used by Sound Forge XP into documents used by other applications (such as
Write, Microsoft Word and Excel). Once a digital audio file is embedded into a
document, you can then edit the audio with Sound Forge XP at any time by
activating the embedded object (usually by double-clicking on it with the
mouse).



USING OLE WITH SOUND FORGE XP
Sound Forge XP is an OLE server. What this means is Sound Forge XP can create
OLE objects (serve them up, if you will) that can be embedded (inserted) into
applications that are OLE containers (the consumers of objects supplied by
servers).

The OLE objects that are created by Sound Forge XP are called Sound Forge XP
Audio objects.These objects are really just links to a sound file on your hard disk
or network server.Therefore, when you embed a Sound Forge XP Audio object
into Write, you are really only inserting a link (a directory and file name) to
the actual sound file.Why this is important to know is explained below in Tips,
Limitations, etc.

There are three methods that can be used to create Sound Forge XP Audio
objects. Any references to an OLE container means an application that can
contain OLE objects (like Microsoft Word and Excel). The three methods are as
follows:

1. Dragging and dropping a link from the OLE Drag Source control in Sound
Forge XP to an OLE container.

2. Using the Copy Object Link command in the Edit menu of Sound Forge XP to
place an object link onto the clipboard.This object link can then be pasted
into an OLE container, usually through the Paste Special command (Edit
menu).

3. Invoking the Insert Object command from an OLE container and selecting the
Sound Forge XP Audio object from the list.

DRAG AND DROP
The most convenient method of embedding a Sound Forge XP Audio object
into a document is to drag a link from the OLE Drag Source control in Sound
Forge XP and receive from the link on the document that you desire.

Note that the application that you drop the OLE object on must be OLE 2.0
compatible. Because of this, you cannot drop Sound Forge XP Audio objects on
Write.The example below uses Microsoft Word for Windows 95 when running on
Windows NT.
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Follow these steps to embed a Sound Forge XP Audio object into WordPad
(Windows 9x) or Microsoft Word 7.0 (Windows NT) using drag and drop:

1. Run WordPad (Windows 9x) or Word 7.0 (Windows NT).

2. Now run Sound Forge XP and open a sound file (TUTOR1.WAV in your
Sound Forge XP directory will suffice).

3. Ensure that at least a portion of WordPad or Word is visible while Sound Forge
XP is open (if either application is maximized, you will need to restore
them and resize them accordingly).

4. Locate the OLE Drag Source control in the lower right corner of the data
window. It’s on the right end of the selection length box and contains the
letters OLE.

5. Click and hold the left mouse button on the OLE Drag Source control and then
drag the mouse cursor while holding the mouse button down.

6. Now drag the mouse over the top of WordPad or Word and drop it (release
the mouse button). If you did everything correctly, a Sound Forge XP Audio
object will now be embedded in your document.

A newly created sound file must first be saved before you can drag and drop
the object into an OLE container. If the sound file in question needs to be
saved, you will be prompted to do so when you click on the OLE Drag Source
control.

There is an option in the General page of the Preferences folder (Options menu)
to turn off the OLE Drag Source control (hide it). It may be desirable to turn this
control off if you do not plan to use the OLE drag and drop support of Sound
Forge XP.

COPY OBJECT LINK
Another method for creating a Sound Forge XP Audio object is to invoke the
Copy Object Link command under the Edit menu in Sound Forge XP.This method
is sometimes preferable to the drag and drop method because you don’t need
a mouse.

Follow these steps to embed a Sound Forge XP Audio object into WordPad
(Windows 9x) or Write (Windows NT) using the Copy Object Link command:

1. Run Sound Forge XP and open a sound file (TUTOR1.WAV in your Sound
Forge XP directory will suffice).
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2. Select the Copy Object Link command under the Edit menu of Sound Forge XP.
If the sound file needs to be saved, you will be prompted to do so.

3. At this point, a Sound Forge XP Audio object is on the clipboard and ready
to be pasted into a document.

4. Run WordPad (Windows 9x) or Write (Windows NT) and select the Paste
command from the Edit menu. If you did everything correctly, a Sound
Forge XP Audio object will now be embedded in your document.

INSERT OBJECT
The last method for creating a Sound Forge XP Audio object is to use the Insert
Object command from another application.This method provides a convenient
way to get a new Sound Forge XP Audio object embedded into a document
without having to first create it in Sound Forge XP and copy it into the
document.

Follow these steps to embed a Sound Forge XP Audio object into WordPad
(Windows 9x) or Write (Windows NT) using the Insert Object command:

1. Run WordPad (Windows 9x) or Write (Windows NT).

2. Select the Insert Object command. For WordPad, use the Object option under the
Insert menu. For Write, use the Insert Object command under the Edit menu.

3. From the Object Type list, select the Sound Forge XP Audio item and click OK.
Note that WordPad has two options: Create New and Create From File. You will
need to select the Create New option.

4. At this time, Sound Forge XP will run automatically to create the new
object. A new window is automatically opened allowing you to copy or
create any new sound data you wish. Note that you must create the sound
data in the window supplied.

5. After creating sound data, save the modifications and close Sound Forge XP.
If you did everything correctly, a Sound Forge XP Audio object will now be
embedded in your document.

After the Sound Forge XP Audio object has been created and embedded into
the document, you can edit it at any time using Sound Forge XP by double-
clicking on the object in your document.
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T IPS AND LIMITATIONS
As mentioned above, Sound Forge XP Audio objects are implemented as links
to existing sound files on your hard disk or network server. Because of this,
there are some limitations you should be aware of before using the OLE
support in Sound Forge XP.

LINKS CAN BE BROKEN,  BUT NOT MENDED
The most important rule to bear in mind when using OLE with Sound Forge
XP is that links can be broken, but not mended.When you create a Sound Forge
XP Audio object, it stores only a link (which is a directory path) to the sound
file. Sound Forge XP uses links because sound files tend to be very large and
would usually not be acceptable to store along with your documents.

Because Sound Forge XP uses object links, moving, renaming or deleting the
sound file associated with a Sound Forge XP Audio object will break the link.
Attempting to edit the object in your document will fail because Sound Forge
XP will not be able to locate the correct sound file.

To replace a broken link, delete the Sound Forge XP Audio object from the
document and create a new one using the correct sound file.

If you need to move a sound file that is linked to a document, you can use
Sound Forge XP to save the file to a different location and the object link will
automatically be updated. However, you must open the sound file that you
want to move as an object for this feature to work. To open a sound file as an
object, double-click on the Sound Forge XP Audio object in your document;
do not open the sound file directly.You can then use Save As to move the sound
file. Sound Forge XP will prompt you about updating the object link after
saving the new file.

SOUND F ILES DO NOT TRAVEL WITH YOUR DOCUMENTS
When you copy a document that contains one or more Sound Forge XP Audio
objects to another computer, the sound files that are linked to the objects are
not copied with the document. If you need to copy a document to another
computer, you will need to copy all sound files associated with it as well.
However, you must also ensure that the sound files have the exact same path
on the new computer as on the old computer.



USING A NETWORK SERVER
To ease the problems associated with moving or sharing documents between
computers, it is suggested that you use a network server to store all sound files
that are embedded in the documents. If you do this, all computers that have
access to the network server will be able to open and edit the Sound Forge XP
Audio objects.

There are two methods of ensuring a common network server will work with
shared documents.The first is to make sure you use the same drive letter when
connecting to the network server on all machines. Remember that the full path
must remain constant between computers.

The second and more preferable method is to use Universal Naming Convention
(UNC) paths when embedding Sound Forge XP Audio objects into your
documents. A UNC name looks like this:

\\server\share\<directory and file name>

Therefore, if your sound files are stored on \\myserver\sounds, open them in
Sound Forge XP using UNC path names rather than a drive letter. You can
create the Sound Forge XP Audio object using either the Copy Object Link
command or the OLE Drag Source control and embed the sound files into your
documents. By using UNC names, you eliminate the need to use a common
drive letter on all computers that share the document.

If you are running Windows 9x, UNC path names are extremely simple to use.
Instead of using a drive letter when browsing in the File Open dialog, select
Network Neighborhood in the Look In field and browse to the appropriate network
server and share containing your sound files. This method of browsing uses
UNC names exclusively.

SOUND FORGE XP IS  NOT AN OLE CONTAINER
Although Sound Forge XP can create OLE objects to embed in other
applications, the inverse is not true. Therefore, OLE objects created by
applications such as Microsoft Word or Excel cannot be embedded into sound files
open in Sound Forge XP.
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